Macintosh, Mac OS X and PowerBook are trademarks of Apple Inc. registered in the U.S. and other countries.

Microsoft, Windows, Windows Vista, Internet Explorer, .NET Framework and PowerPoint are either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries.

MicroSaver is a registered trademark of Kensington Computer Products Group, a division of ACCO Brands.

Adobe, Adobe PDF, Adobe Reader, and Acrobat are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Virtual Remote Tool uses WinI2C/DDC library, © Nicomsoft Ltd.

HDMI, the HDMI Logo and High-Definition Multimedia Interface are trademarks or registered trademarks of HDMI Licensing LLC.

DisplayPort, DisplayPort Certified Logo, VESA, and VESA logo are trademarks of the Video Electronics Standards Association, registered in the U.S. and other countries.

Trademark PJLink is a trademark applied for trademark rights in Japan, the United States of America and other countries and areas.

Wi-Fi®, Wi-Fi Alliance®, and Wi-Fi Protected Access (WPA, WPA2)® are registered trademarks of the Wi-Fi Alliance.

Blu-ray is a trademark of Blu-ray Disc Association

CRESTRON and ROOMVIEW are registered trademarks of Crestron Electronics, Inc. in the United States and other countries.

Other product and company names mentioned in this user's manual may be the trademarks or registered trademarks of their respective holders.

NOTES

(1) The contents of this user's manual may not be reprinted in part or whole without permission.

(2) The contents of this user's manual are subject to change without notice.

(3) Great care has been taken in the preparation of this user's manual; however, should you notice any questionable points, errors or omissions, please contact us.

(4) Notwithstanding article (3), NEC will not be responsible for any claims on loss of profit or other matters deemed to result from using the Projector.
Important Information

Safety Cautions

Precautions

Please read this manual carefully before using your NEC projector and keep the manual handy for future reference.

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>To turn off main power, be sure to remove the plug from power outlet.</td>
</tr>
<tr>
<td>The power outlet socket should be installed as near to the equipment as possible, and should be easily accessible.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>TO PREVENT SHOCK, DO NOT OPEN THE CABINET.</td>
</tr>
<tr>
<td>THERE ARE HIGH-VOLTAGE COMPONENTS INSIDE.</td>
</tr>
<tr>
<td>REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.</td>
</tr>
</tbody>
</table>

This symbol warns the user that uninsulated voltage within the unit may be sufficient to cause electrical shock. Therefore, it is dangerous to make any kind of contact with any part inside of the unit.

This symbol alerts the user that important information concerning the operation and maintenance of this unit has been provided.

The information should be read carefully to avoid problems.

<table>
<thead>
<tr>
<th>WARNING:</th>
</tr>
</thead>
<tbody>
<tr>
<td>TO PREVENT FIRE OR SHOCK, DO NOT EXPOSE THIS UNIT TO RAIN OR MOISTURE.</td>
</tr>
<tr>
<td>DO NOT USE THIS UNIT’S PLUG WITH AN EXTENSION CORD OR IN AN OUTLET UNLESS ALL THE PRONGS CAN BE FULLY INSERTED.</td>
</tr>
</tbody>
</table>

DOC Compliance Notice (for Canada only)

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Machine Noise Information Regulation - 3. GPSGV,

The highest sound pressure level is less than 70 dB (A) in accordance with EN ISO 7779.

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avoid displaying stationary images for a prolonged period of time.</td>
</tr>
<tr>
<td>Doing so can result in these images being temporarily sustained on the surface of the LCD panel.</td>
</tr>
<tr>
<td>If this should happen, continue to use your projector. The static background from previous images will disappear.</td>
</tr>
</tbody>
</table>

Disposing of your used product

EU-wide legislation as implemented in each Member State requires that used electrical and electronic products carrying the mark (left) must be disposed of separately from normal household waste. This includes projectors and their electrical accessories or lamps. When you dispose of such products, please follow the guidance of your local authority and/or ask the shop where you purchased the product.

After collecting the used products, they are reused and recycled in a proper way. This effort will help us reduce the wastes as well as the negative impact such as mercury contained in a lamp to the human health and the environment at the minimum level.

The mark on the electrical and electronic products only applies to the current European Union Member States.
Important Information

WARNING TO CALIFORNIA RESIDENTS:
Handling the cables supplied with this product will expose you to lead, a chemical known to the State of California to cause birth defects or other reproductive harm. WASH HANDS AFTER HANDLING.

RF Interference (for USA only)

WARNING
The Federal Communications Commission does not allow any modifications or changes to the unit EXCEPT those specified by NEC Display Solutions of America, Inc. in this manual. Failure to comply with this government regulation could void your right to operate this equipment. This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation.

If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio / TV technician for help.

For UK only: In UK, a BS approved power cord with moulded plug has a Black (five Amps) fuse installed for use with this equipment. If a power cord is not supplied with this equipment please contact your supplier.

Important Safeguards
These safety instructions are to ensure the long life of your projector and to prevent fire and shock. Please read them carefully and heed all warnings.

⚠️ Installation
• Do not place the projector in the following conditions:
  - on an unstable cart, stand, or table.
  - near water, baths, or damp rooms.
  - in direct sunlight, near heaters, or heat radiating appliances.
  - in a dusty, smoky or steamy environment.
  - on a sheet of paper or cloth, rugs or carpets.
• If you wish to have the projector installed on the ceiling:
  - Do not attempt to install the projector yourself.
  - The projector must be installed by qualified technicians in order to ensure proper operation and reduce the risk of bodily injury.
  - In addition, the ceiling must be strong enough to support the projector and the installation must be in accordance with any local building codes.
  - Please consult your dealer for more information.
**Important Information**

**Fire and Shock Precautions**

- Ensure that there is sufficient ventilation and that vents are unobstructed to prevent the build-up of heat inside your projector. Allow at least 4 inches (10cm) of space between your projector and a wall.
- Do not try to touch the ventilation outlet on the left front (when seen from the front) as it can become heated while the projector is turned on and immediately after the projector is turned off. Parts of the projector may become temporarily heated if the projector is turned off with the POWER button or if the AC power supply is disconnected during normal projector operation.
- Use caution when picking up the projector.

- Prevent foreign objects such as paper clips and bits of paper from falling into your projector. Do not attempt to retrieve any objects that might fall into your projector. Do not insert any metal objects such as a wire or screwdriver into your projector. If something should fall into your projector, disconnect it immediately and have the object removed by a qualified service personnel.
- Do not place any objects on top of the projector.
- Do not touch the power plug during a thunderstorm. Doing so can cause electrical shock or fire.
- The projector is designed to operate on a power supply of 100-240V AC 50/60 Hz. Ensure that your power supply fits this requirement before attempting to use your projector.
- Do not look into the lens while the projector is on. Serious damage to your eyes could result.
- Keep any items (magnifying glass etc.) out of the light path of the projector. The light path being projected from the lens is extensive, therefore any kind of abnormal objects that can redirect light coming out of the lens, can cause an unpredictable outcome such as a fire or injury to the eyes.
- Do not place any objects, which are easily affected by heat, in front of a projector exhaust vent. Doing so could lead to the object melting or getting your hands burned from the heat that is emitted from the exhaust.
Important Information

• Handle the power cord carefully. A damaged or frayed power cord can cause electric shock or fire.
  - Do not use any power cord other than the one supplied with the projector.
  - Do not bend or tug the power cord excessively.
  - Do not place the power cord under the projector, or any heavy object.
  - Do not cover the power cord with other soft materials such as rugs.
  - Do not heat the power cord.
  - Do not handle the power plug with wet hands.
• Turn off the projector, unplug the power cord and have the projector serviced by a qualified service personnel under the following conditions:
  - When the power cord or plug is damaged or frayed.
  - If liquid has been spilled into the projector, or if it has been exposed to rain or water.
  - If the projector does not operate normally when you follow the instructions described in this user’s manual.
  - If the projector has been dropped or the cabinet has been damaged.
  - If the projector exhibits a distinct change in performance, indicating a need for service.
• Disconnect the power cord and any other cables before carrying the projector.
• Turn off the projector and unplug the power cord before cleaning the cabinet or replacing the lamp.
• Turn off the projector and unplug the power cord if the projector is not to be used for an extended period of time.
• When using a LAN cable:
  For safety, do not connect to the connector for peripheral device wiring that might have excessive voltage.

![CAUTION]

• Do not use the tilt-foot for purposes other than originally intended. Misuses such as gripping the tilt-foot or hanging on the wall can cause damage to the projector.
• Do not send the projector in the soft case by parcel delivery service or cargo shipment. The projector inside the soft case could be damaged.
• Select [HIGH] in Fan mode if you continue to use the projector for consecutive days. (From the menu, select [SETUP] → [OPTIONS(1)] → [FAN MODE] → [MODE] → [HIGH].)
• Do not move the projector by holding the cable cover. Doing so may result in the projector falling or causing injury.
• Before using Direct Power Off, be sure to allow at least 20 minutes immediately after turning on the projector and starting to display an image.
• Do not unplug the power cable from the wall outlet or projector when the projector is powered on. Doing so can cause damage to the AC IN connector of the projector and (or) the prong plug of the power cable. To turn off the AC power supply when the projector is powered on, use a power strip equipped with a switch and a breaker.
• Do not turn off the AC power for 60 seconds after the lamp is turned on and while the POWER indicator is blinking blue. Doing so could cause premature lamp failure.

Caution on Handling the Optional Lens
When shipping the projector with the lens, remove the lens before shipping the projector. Always attach the dust cap to the lens whenever it is not mounted on the projector. The lens and the lens shift mechanism may encounter damage caused by improper handling during transportation. Do not hold the lens part when carrying the projector. Doing so could cause the focus ring to rotate, resulting in accidental dropping of the projector.

Remote Control Precautions
• Handle the remote control carefully.
• If the remote control gets wet, wipe it dry immediately.
• Avoid excessive heat and humidity.
• Do not short, heat, or take apart batteries.
Important Information

- Do not throw batteries into fire.
- If you will not be using the remote control for a long time, remove the batteries.
- Ensure that you have the batteries’ polarity (+/-) aligned correctly.
- Do not use new and old batteries together, or use different types of batteries together.
- Dispose of used batteries according to your local regulations.

Note for US Residents
The lamp in this product contains mercury. Please dispose according to Local, State or Federal Laws.

Lamp Replacement
- Use the specified lamp for safety and performance.
- To replace the lamp, follow all instructions provided on page 159.
- Be sure to replace the lamp and filter when the message [THE LAMP HAS REACHED THE END OF ITS USABLE LIFE. PLEASE REPLACE THE LAMP AND FILTER. USE THE SPECIFIED LAMP FOR SAFETY AND PERFORMANCE.] appears. If you continue to use the lamp after the lamp has reached the end of its usable life, the lamp bulb may shatter, and pieces of glass may be scattered in the lamp case. Do not touch them as the pieces of glass may cause injury.
  If this happens, contact your dealer for lamp replacement.

A Lamp Characteristic
The projector has a high-pressure mercury lamp as a light source.
A lamp has a characteristic that its brightness gradually decreases with age. Also repeatedly turning the lamp on and off will increase the possibility of its lower brightness.

⚠️ CAUTION:
- DO NOT TOUCH THE LAMP immediately after it has been used. It will be extremely hot. Turn the projector off and then disconnect the power cord. Allow at least one hour for the lamp to cool before handling.
- When removing the lamp from a ceiling-mounted projector, make sure that no one is under the projector. Glass fragments could fall if the lamp has been burned out.

About High Altitude mode
- Set [FAN MODE] to [HIGH ALTITUDE] when using the projector at altitudes approximately 5500 feet/1600 meters or higher.
  Using the projector at altitudes approximately 5500 feet/1600 meters or higher without setting to [HIGH ALTITUDE] can cause the projector to overheat and the protector could shut down. If this happens, wait a couple minutes and turn on the projector.
  Using the projector at altitudes less than approximately 5500 feet/1600 meters and setting to [HIGH ALTITUDE] can cause the lamp to overcool, causing the image to flicker. Switch [FAN MODE] to [AUTO].
- Using the projector at altitudes approximately 5500 feet/1600 meters or higher can shorten the life of optical components such as the lamp.

About Copyright of original projected pictures:
Please note that using this projector for the purpose of commercial gain or the attraction of public attention in a venue such as a coffee shop or hotel and employing compression or expansion of the screen image with the following functions may raise concern about the infringement of copyrights which are protected by copyright law. [ASPECT RATIO], [KEYSTONE], Magnifying feature and other similar features.

Turkish RoHS information relevant for Turkish market
EEE Yönetmeliğine Uygundur.

This device is not intended for use in the direct field of view at visual display workplaces. To avoid incommoding reflections at visual display workplaces this device must not be placed in the direct field of view.
## Table of Contents

### Important Information

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Introduction</td>
<td>1</td>
</tr>
<tr>
<td>1. What's in the Box?</td>
<td>1</td>
</tr>
<tr>
<td>2. Introduction to the Projector</td>
<td>2</td>
</tr>
<tr>
<td>3. Part Names of the Projector</td>
<td>4</td>
</tr>
<tr>
<td>4. Part Names of the Remote Control</td>
<td>8</td>
</tr>
<tr>
<td>5. Operating Environment for Software Included on CD-ROM</td>
<td>10</td>
</tr>
<tr>
<td>6. Operating Environment</td>
<td>11</td>
</tr>
</tbody>
</table>

### 2. Projecting an Image (Basic Operation)

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Flow of Projecting an Image</td>
<td>12</td>
</tr>
<tr>
<td>2. Connecting Your Computer/Connecting the Power Cord</td>
<td>13</td>
</tr>
<tr>
<td>3. Turning on the Projector</td>
<td>14</td>
</tr>
<tr>
<td>4. Selecting a Source</td>
<td>16</td>
</tr>
<tr>
<td>5. Adjusting the Picture Size and Position</td>
<td>17</td>
</tr>
<tr>
<td>6. Correcting Keystone Distortion</td>
<td>22</td>
</tr>
<tr>
<td>7. Optimizing Computer Signal Automatically</td>
<td>24</td>
</tr>
<tr>
<td>8. Turning Up or Down Volume</td>
<td>24</td>
</tr>
<tr>
<td>9. Turning off the Projector</td>
<td>25</td>
</tr>
<tr>
<td>10. After Use</td>
<td>26</td>
</tr>
</tbody>
</table>

### 3. Convenient Features

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Turning off the Image and Sound</td>
<td>27</td>
</tr>
<tr>
<td>2. Freezing a Picture</td>
<td>27</td>
</tr>
<tr>
<td>3. Enlarging a Picture</td>
<td>27</td>
</tr>
<tr>
<td>5. Checking Energy-Saving Effect [CARBON METER]</td>
<td>29</td>
</tr>
</tbody>
</table>
### Table of Contents

5 Using the Optional Remote Mouse Receiver (NP01MR) ........................................... 30
6 Correcting Horizontal and Vertical Keystone Distortion [CORNERSTONE] ............ 32
   Cornerstone ........................................................................................................... 32
7 Displaying Two Pictures at the Same Time ............................................................ 35
   Selecting the PIP or PICTURE BY PICTURE Mode [MODE] ................................. 35
   [POSITION] ........................................................................................................... 36
8 Preventing the Unauthorized Use of the Projector [SECURITY] .............................. 37
9 Controlling the Projector by Using an HTTP Browser ............................................ 40
10 Projecting Your Computer’s Screen Image from the Projector via a Network [NETWORK PROJECTOR] ................................................................. 47
11 Using the Projector to Operate Your Computer via a Network [REMOTE DESKTOP] ................................................................. 51

### 4. Using the Viewer

1 What you can do with the Viewer ............................................................................ 56
2 Preparing presentation materials ............................................................................ 59
3 Projecting images stored in a USB memory device .............................................. 60
   Starting the Viewer ................................................................................................. 60
   Exiting the Viewer .................................................................................................. 63
   Names and functions of Viewer screen .................................................................. 64
   Viewer option settings ........................................................................................... 69
4 Projecting data from shared folder ........................................................................ 72
   Connecting the projector to the shared folder ...................................................... 72
   Disconnecting the shared folder from the projector .............................................. 75
5 Projecting data from media server ......................................................................... 76
   Setting up “Media Sharing” in Windows Media Player 11 .................................... 76
   Setting up “Media Sharing” in Windows Media Player 12 .................................... 78
   Connecting the projector to the media server ...................................................... 79
   Disconnecting the projector from the media server .............................................. 80
6 Restrictions on displaying files ............................................................................... 81
   Some restrictions on PowerPoint files ................................................................. 81
   Some restrictions on PDF files .............................................................................. 81

### 5. Using On-Screen Menu

1 Using the Menus ....................................................................................................... 82
2 Menu Elements ....................................................................................................... 83
3 List of Menu Items ................................................................................................... 84
4 Menu Descriptions & Functions [SOURCE] ............................................................ 87
   COMPUTER 1, 2, and 3 ......................................................................................... 87
   HDMI ..................................................................................................................... 87
   DisplayPort ............................................................................................................ 87
   VIDEO .................................................................................................................. 87
   S-VIDEO .............................................................................................................. 87
   VIEWER ............................................................................................................... 87
   NETWORK .......................................................................................................... 87
   ENTRY LIST ......................................................................................................... 87
   TEST PATTERN ..................................................................................................... 87
5 Menu Descriptions & Functions [ADJUST] ............................................................. 91
Table of Contents

[PICTURE] ...................................................................................................................... 91
[IMAGE OPTIONS] ........................................................................................................ 94
[VIDEO] .......................................................................................................................... 98

6 Menu Descriptions & Functions [SETUP] ................................................................. 100
   [BASIC] ....................................................................................................................... 100
   [MENU] ........................................................................................................................ 102
   [INSTALLATION(1)] ...................................................................................................... 103
   [INSTALLATION(2)] ...................................................................................................... 106
   [OPTIONS(1)] .............................................................................................................. 108
   [OPTIONS(2)] .............................................................................................................. 110

7 Menu Descriptions & Functions [INFO.] ............................................................... 112
   [USAGE TIME] .............................................................................................................. 112
   [SOURCE(1)] .............................................................................................................. 113
   [SOURCE(2)] .............................................................................................................. 113
   [WIRED LAN] .............................................................................................................. 113
   [WIRELESS LAN(1)] .................................................................................................... 114
   [WIRELESS LAN(2)] .................................................................................................... 114
   [VERSION(1)] .............................................................................................................. 114
   [VERSION(2)] .............................................................................................................. 115
   [OTHERS] .................................................................................................................... 115

8 Menu Descriptions & Functions [RESET] ............................................................... 116
   Returning to Factory Default [RESET] ........................................................................ 116

9 Application Menu ..................................................................................................... 118
   IMAGE EXPRESS UTILITY .......................................................................................... 118
   DESKTOP CONTROL UTILITY .................................................................................. 118
   NETWORK PROJECTOR ............................................................................................... 119
   REMOTE DESKTOP CONNECTION ............................................................................ 119
   NETWORK SETTINGS .................................................................................................. 120
   TOOLS ......................................................................................................................... 136

6. Connecting to Other Equipment ............................................................................. 141

1 Mounting a lens (sold separately) ............................................................................ 141
   Mounting the lens ........................................................................................................ 141
   Removing the lens ........................................................................................................ 142

2 Making Connections ................................................................................................... 143
   Analog RGB signal connection ................................................................................... 143
   Digital RGB signal connection ................................................................................... 144
   Connecting an External Monitor ................................................................................ 146
   Connecting Your DVD Player or Other AV Equipment ............................................ 147
   Connecting Component Input ..................................................................................... 148
   Connecting HDMI Input .............................................................................................. 149
   Connecting to a Wired LAN ......................................................................................... 150
   Connecting to a Wireless LAN (sold separately) ..................................................... 151
   Mounting a wireless LAN unit .................................................................................... 151
   To remove the wireless LAN unit ................................................................................ 153

7. Maintenance ............................................................................................................. 155

1 Cleaning the Filters ................................................................................................... 155

2 Cleaning the Lens ...................................................................................................... 158
### 8. User Supportware

1. **Installing Software Program**
   - Installation for Windows software ............................................................. 164
   - Installation for Macintosh software ........................................................... 166
2. **Operating the Projector Via the LAN (Virtual Remote Tool)** .................... 167
3. **Projecting Your Computer’s Screen Image from the Projector over a LAN (Image Express Utility Lite)** ................................................................. 170
4. **Projecting an Image from an Angle (Geometric Correction Tool in Image Express Utility Lite)** ................................................................. 172
   - What you can do with GCT ......................................................................... 172
5. **Projecting Images or Videos from the Projector over a LAN (Image Express Utility 2.0)** ................................................................. 174
   - What you can do with Image Express Utility 2.0 ........................................ 174
   - Connecting the projector to a LAN .............................................................. 175
   - Basic Operation of Image Express Utility 2.0 ............................................ 176
6. **Using the Projector to Operate Your Computer over a LAN (Desktop Control Utility 1.0)** ................................................................. 185
   - What you can do with Desktop Control Utility 1.0 .................................... 185
   - Connecting the projector to a LAN .............................................................. 185
   - Using the projector to operate your computer’s desktop screen .................. 186
7. **Controlling the Projector over a LAN (PC Control Utility Pro 4)** .............. 194
8. **Converting PowerPoint files to Slides (Viewer PPT Converter 3.0)** ........... 195
9. **Projecting Your Mac’s Screen Image from the Projector over a LAN (Image Express Utility 2 for Mac)** ................................................................. 197
   - What you can do with Image Express Utility 2 ........................................ 197
   - Operating environment ............................................................................ 197
   - Connecting the projector to a LAN .............................................................. 197
   - Using Image Express Utility 2 .................................................................... 198

### 9. Appendix

1. **Throw distance and screen size** ................................................................. 201
   - Lens types and throw distance .................................................................. 201
   - Tables of screen sizes and dimensions ....................................................... 204
   - Lens shifting range .................................................................................. 205
2. **Compatible Input Signal List** ................................................................. 207
3. **Specifications** ......................................................................................... 209
4. **Cabinet Dimensions** ............................................................................. 211
5. **Mounting the cable cover (sold separately)** ........................................... 212
6. **Pin Assignments of D-Sub COMPUTER Input Connector** ....................... 213
7. **Troubleshooting** .................................................................................... 214
   - Indicator Messages .................................................................................. 214
   - Common Problems & Solutions ................................................................. 216
   - If there is no picture, or the picture is not displayed correctly ................. 218
8. **PC Control Codes and Cable Connection** ............................................... 219
Table of Contents

7 Troubleshooting Check List ................................................................. 220
8 TravelCare Guide .............................................................................. 222
1. Introduction

What’s in the Box?

Make sure your box contains everything listed. If any pieces are missing, contact your dealer. Please save the original box and packing materials if you ever need to ship your projector.

Projector

Dust cap for lens
* The projector is shipped without a lens. For the types of lens and throw distances, see page 201.

Power cord
(US: 7N080241)
(EU: 7N080022)

Remote control
(7N900961)

AA alkaline batteries
(x2)

Computer cable (VGA)
(7N520073)

NEC Projector CD-ROM
User’s manual (PDF) and the utility software
(7N951595)

• Important Information (For North America: 7N8N1551) (For Other countries than North America: 7N8N1551 and 7N8N1562)
• Quick Setup Guide (For North America: 7N8N1571) (For Other countries than North America: 7N8N1571 and 7N8N1581)

Lens theft prevention screw (24V00841)
This screw makes it difficult to remove the lens mounted on the projector. (→ page 142)

Straps (24J23901) (for preventing lamp and filter covers from falling) (x2)
Attaching the straps to the lamp and filter covers prevents them from falling when the projector is suspended from the ceiling.

For North America only
Registration card
Limited warranty

For customers in Europe:
You will find our current valid Guarantee Policy on our Web Site:
www.nec-display-solutions.com
Introduction to the Projector

This section introduces you to your new projector and describes the features and controls.

Congratulations on Your Purchase of the Projector

This projector is one of the very best projectors available today. The projector enables you to project precise images up to 500 inches across (measured diagonally) from your PC or Macintosh computer (desktop or notebook), VCR, DVD player, or document camera. You can use the projector on a tabletop or cart; you can use the projector to project images from behind the screen, and the projector can be permanently mounted on a ceiling*. The remote control can be used wirelessly.

* Do not attempt to mount the projector on a ceiling yourself.

The projector must be installed by qualified technicians in order to ensure proper operation and reduce the risk of bodily injury.

In addition, the ceiling must be strong enough to support the projector and the installation must be in accordance with any local building codes. Please consult your dealer for more information.

Features you'll enjoy:

• Liquid crystal type high brightness/high resolution projector

<table>
<thead>
<tr>
<th>Model</th>
<th>LCD panel</th>
<th>Resolution</th>
<th>Aspect Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>PA600X</td>
<td>0.79” (with MLA)</td>
<td>1024 × 768 dots</td>
<td>4:3</td>
</tr>
<tr>
<td>PA500X</td>
<td>0.79” (with MLA)</td>
<td>1024 × 768 dots</td>
<td>4:3</td>
</tr>
<tr>
<td>PA550W</td>
<td>0.75” (with MLA)</td>
<td>1280 × 800 dots</td>
<td>16:10</td>
</tr>
<tr>
<td>PA500U</td>
<td>0.76” (with MLA)</td>
<td>1920 × 1200 dots</td>
<td>16:10</td>
</tr>
</tbody>
</table>

The PA600X/PA500X/PA550W projectors cover input signals up to WUXGA (1920 × 1200 dots) thanks to the Advanced AccuBlend function.

• Wide range of optional lenses selectable according to the place of installation

This projector supports 5 types of optional lenses, providing a selection of lenses adapted to a variety of places of installation and projection methods.

In addition, the lenses can be mounted and removed in one touch.

Note that no lens is mounted upon shipment from the factory. Please purchase optional lenses separately.

• Lens shift function for easily adjusting the position of the projected image

The position of the projected image is moved by turning the two dials on the projector’s front, one for the vertical direction, one for the horizontal direction.

• 360° installation angle (tilt-free)

The projector can be installed at any angle (360°).

Note, however, that the “fan mode” setting must be changed according to the angle of installation.

Also, the projector cannot be installed tilted to the left or right.

• Wide range of input/output connectors (HDMI, DisplayPort, BNC, etc.) and built-in monaural speaker

The projector is equipped with a variety of input/output connectors: computer (analog), 5-core BNC, HDMI, DisplayPort, Video, S-Video, etc. (The computer (analog) and BNC connectors also support component inputs.) The projector’s HDMI and DisplayPort input connectors support HDCP.

The projector is also equipped with a built-in 10W monaural speaker.

• High picture quality processing circuit

The Reon-VX video processor is used to project high quality images.

• Energy-saving design with a standby power consumption of 0.2 watts

When the on-screen menu’s standby mode is set to “Power Saving”, the power consumption in the standby mode is 0.2 watts.
1. Introduction

- **“Eco mode” for low power consumption and “Carbon Meter” display**
  The projector is equipped with an “eco mode” for reducing power consumption during use. Furthermore, the power-saving effect when the eco mode is set is converted into the amount of reductions of CO₂ emissions and this is indicated on the confirmation message displayed when the power is turned off and at “Information” on the on-screen menu (CARBON METER).

- **Maximum lamp replacement time of 4000 hours (3000 hours in Normal mode) and no need to clean the filters**
  When used in the eco mode, the lamp replacement time* is extended to a maximum of 4000 hours.
  * This time is not guaranteed.
  Furthermore, this projector uses large 2-layer filters. When these filters are replaced with new ones when changing the lamp, there is no need for regular filter cleaning.

- **Seamless switch function for smoother screen changes when switching the signal (PA500U only)**
  When the input connector is switched, the image displayed before switching is held so that the new image can be switched to without a break due to absence of a signal.

- **Simultaneous display of 2 images (PIP/PICTURE BY PICTURE)**
  Two images can be projected simultaneously with a single projector.
  There are two types of layouts for the two images: “picture-in-picture” in which a sub-picture is displayed on the main picture, and “picture-by-picture” in which the main and sub pictures are displayed next to each other.

- **Security function for preventing unauthorized use**
  This projector is equipped with the following security functions:
  - Password security: When a password is set in the on-screen menu, a screen to input the password appears when the projector’s power is turned on.
  - Theft prevention lock: A security cable compatible with Kensington locks can be connected to the projector.
  - Security bar: The projector has a mechanism allowing a regular security cable (or wire) to be installed.

- **Wired/wireless LAN compatibility (wireless LAN unit sold separately)**
  The projector is equipped with a LAN port (RJ-45) for connection to a wired LAN for transferring images from a computer to the projector, controlling the projector from a computer, etc.
  Furthermore, the projector can be used in a wireless LAN by mounting the separately sold wireless LAN unit (NP02LM).

- **Convenient utility software (User Supportware) provided as standard**
  Seven utility software programs (Virtual Remote Tool, Image Express Utility Lite, Image Express Utility 2.0, Desktop Control Utility 1.0, PC Control Utility Pro 4, Viewer PPT Converter 3.0, Image Express Utility 2 for Mac) are provided on the included NEC Projector CD-ROM.

- **LAN-compatible viewer function**
  Still and moving images in shared folders on a computer connected by wired or wireless LAN can be projected with the projector’s viewer.
  - The viewer supports the Windows Media Player 11’s “media sharing” function.

- **CRESTRON ROOMVIEW compatibility**
  The projector supports CRESTRON ROOMVIEW, allowing multiple devices connected in the network to be managed and controlled from a computer.

About this user's manual
The fastest way to get started is to take your time and do everything right the first time. Take a few minutes now to review the user's manual. This may save you time later on. At the beginning of each section of the manual you’ll find an overview. If the section doesn’t apply, you can skip it.
Part Names of the Projector
Front/Top

The lens is sold separately. The description below is for when the NP13ZL lens is mounted.

1. Introduction

Mounting the straps
1. Mount the straps to the filter cover and lamp cover as shown on the diagram below.

2. Insert the knot in the strap into the hole on the bottom of the projector and pull in the direction of the arrow to fasten.
1. Introduction

**Rear**

- **Terminal Panel (→ page 7)**
- **Remote Sensor (located on the front and the rear) (→ page 9)**
- **Ventilation (inlet) / Filter Cover**
  The wireless LAN unit’s USB (LAN) port is located inside here. (→ page 151, 155)
- **Ventilation (outlet)**
  Heated air is exhausted from here.
- **AC Input**
  Connect the supplied power cord’s three-pin plug here, and plug the other end into an active wall outlet. (→ page 13)
- **Built-in Security Slot ()**
  *This security slot supports the MicroSaver® Security System.*
- **Cable cover connection (right and left)**
  Screw holes and grooves for the optional cable cover (→ page 212)
1. Control Panel/Indicator Section

1. (POWER) Button (→ page 14, 25)
2. POWER Indicator (→ page 13, 14, 25, 214)
3. STATUS Indicator (→ page 214)
4. LAMP Indicator (→ page 159, 215)
5. TEMP. Indicator (→ page 215)
6. SOURCE Button (→ page 16)
7. AUTO ADJ. Button (→ page 24)
8. 3D REFORM Button (→ page 32)
9. MENU Button (→ page 82)
10. ▲▼◄► / Volume Buttons ◄► (→ page 24)
11. ENTER Button (→ page 82)
12. EXIT Button (→ page 82)
1. COMPUTER 1 IN/ Component Input Connector (Mini D-Sub 15 Pin) (→ page 13, 143, 148)
2. COMPUTER 1 AUDIO IN Mini Jack (Stereo Mini) (→ page 143, 148)
3. COMPUTER 2 IN / Component Input Connector (Mini D-Sub 15 Pin) (→ page 143, 148)
4. COMPUTER 2 AUDIO IN Mini Jack (Stereo Mini) (→ page 145)
5. COMPUTER 3 IN/Component (R/Cr, G/Y, B/Cb, H, V) Connectors (BNC x 5) (→ page 143, 148)
6. COMPUTER 3 AUDIO IN Mini Jack (Stereo Mini) (→ page 143, 148)
7. HDMI IN Connector (Type A) (→ page 144, 145, 149)
8. DisplayPort IN Connector (→ page 144)
9. MONITOR OUT (COMP. 1) Connector (Mini D-Sub 15 Pin) (→ page 146)
10. AUDIO OUT Mini Jack (Stereo Mini) (→ page 146)
11. S-VIDEO IN Connector (Mini DIN 4 Pin) (→ page 147)
12. VIDEO IN Connector (RCA) (→ page 147)
13. VIDEO/S-VIDEO AUDIO IN L/MONO, R (RCA) (→ page 147)
14. LAN Port (RJ-45) (→ page 150)
15. USB Port (Type A) (→ page 60)
16. PC CONTROL Port (D-Sub 9 Pin) (→ page 219)
   Use this port to connect a PC or control system. This enables you to control the projector using serial communication protocol. If you are writing your own program, typical PC control codes are on page 219.
17. REMOTE Connector (Stereo Mini)
   Use this connector for wired remote control of the projector using the NEC optional remote control.
   Connect the projector and optional remote control using a commercially available wired remote control cable.

**NOTE:** When a remote control cable is connected to the REMOTE connector, infrared remote control operations cannot be performed.
Part Names of the Remote Control

1. Infrared Transmitter  
(→ page 9)

2. POWER ON Button  
(→ page 14)

3. POWER OFF Button  
(→ page 25)

4, 5, 6. COMPUTER 1/2/3 Button  
(→ page 16)

7. AUTO ADJ. Button  
(→ page 24)

8. VIDEO Button  
(→ page 16)

9. S-VIDEO Button  
(→ page 16)

10. HDMI Button  
(→ page 16)

11. DisplayPort Button  
(→ page 16)

12. VIEWER Button  
(→ page 16, 60)

13. NETWORK Button  
(→ page 16)

14. SOURCE Button  
(→ page 16)

15. PIP Button  
(→ page 16, 35)

16. ID SET Button  
(→ page 107)

17. Numeric Keypad Button/CLEAR Button  
(→ page 107)

18. MENU Button  
(→ page 82)

19. EXIT Button  
(→ page 82)

20. ▲▼◀▶ Button  
(→ page 82)

21. ENTER Button  
(→ page 82)

22. L-CLICK Button*  
(→ page 31)

23. R-CLICK Button*  
(→ page 31)

24. VOLUME (+)(−) Button  
(→ page 24)

25. D-ZOOM (+)(−) Button  
(→ page 27)

26. PAGE ▲▼△ Button*  
(→ page 31)

27. PICTURE Button  
(→ page 91, 93)

28. ECO Button  
(→ page 28)

29. ASPECT Button  
(→ page 96)

30. AV-MUTE Button  
(→ page 27)

31. 3D REFORM Button  
(→ page 32)

32. FREEZE Button  
(→ page 27)

33. SHUTTER Button  
(not available on this series of projectors)

34. LENS SHIFT Button  
(not available on this series of projectors)

35. FOCUS/ZOOM Button  
(not available on this series of projectors)

36. HELP Button  
(→ page 112)

* The PAGE ▲▼△, ▲▼◀▶, L-CLICK and R-CLICK buttons work only when a USB cable is connected with your computer.
1. Introduction

Remote Control Precautions

- Handle the remote control carefully.
- If the remote control gets wet, wipe it dry immediately.
- Avoid excessive heat and humidity.
- Do not short, heat, or take apart batteries.
- Do not throw batteries into fire.
- If you will not be using the remote control for a long time, remove the batteries.
- Ensure that you have the batteries’ polarity (+/−) aligned correctly.
- Do not use new and old batteries together, or use different types of batteries together.
- Dispose of used batteries according to your local regulations.

Operating Range for Wireless Remote Control

- The infrared signal operates by line-of-sight up to a distance of about 22 feet/7 m and within a 60-degree angle of the remote sensor on the projector cabinet.
- The projector will not respond if there are objects between the remote control and the sensor, or if strong light falls on the sensor. Weak batteries will also prevent the remote control from properly operating the projector.

Battery Installation

1. Press the catch and remove the battery cover.
2. Install new ones (AA). Ensure that you have the batteries’ polarity (+/−) aligned correctly.
3. Slip the cover back over the batteries until it snaps into place.

NOTE: Do not mix different types of batteries or new and old batteries.
# Operating Environment for Software Included on CD-ROM

## Names and Features of Bundled Software Programs

<table>
<thead>
<tr>
<th>Name of software program</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual Remote Tool</td>
<td>When the computer and projector are connected using a network (wired/wireless LAN), such operations as turning the projector’s power on and off and switching the signal can be performed. It is also possible to send an image to the projector and register it as the background logo. Once the image is registered, it can be locked to prevent the logo from being overwritten. (→ page 167)</td>
</tr>
</tbody>
</table>
| Image Express Utility Lite | • When the computer and projector are connected using a network (wired/wireless LAN), the computer screen can be sent to the projector and projected. There is no need for a computer cable. (→ page 150, page 170)  
• This software program can be used to control the power ON/OFF and source selection of the projector from your computer.  
• The Geometric Correction Tool (GCT) function allows you to correct distortion of images projected on a curved wall. (→ page 172) |
| Image Express Utility 2.0 | • This is a software program used to send the screens of your personal computers to the projector via wired/wireless LAN (Meeting mode). Projected images can be transferred and saved to personal computers. When “Meeting Mode” is used, projected images can be sent and saved to the personal computers. Images can be sent from a personal computer to not only one projector but also to two or more projectors at the same time. (→ page 174) |
| Desktop Control Utility 1.0 | • This is a software program used to operate the desktop screen of a personal computer at a remote location by using a projector via wired/wireless LAN. (→ page 185) |
| PC Control Utility Pro 4 | This is a software program used to operate the projector from the computer when the computer and the projector are connected with LAN (wired or wireless) or a serial cable. (→ page 194) |
| Viewer PPT Converter 3.0 | This is a software program used to convert files created with PowerPoint into JPEG files that can be displayed with the viewer function of the projector when a USB memory device is inserted into the projector. (→ page 195) |
| Image Express Utility for Mac | • This is a software program used to send the Mac’s screen image to the projector over a network (wired or wireless LAN). (→ page 197) For Mac’s operating environment, see page 197. |

* A separately sold wireless LAN unit is required to use a wireless LAN.

**NOTE:**

• *Image Express Utility Lite and Image Express Utility for Mac do not support “Meeting Mode” which is provided in Image Express Utility 2.0.*

## Download service

For the update information about these software programs, visit our website:

### Operating Environment

The following is the operating environment for Image Express Utility Lite. For the operating environment of other software program, refer to the help function of each software program.

| Supported OS | Windows 7 Home Basic  
| Windows 7 Home Premium  
| Windows 7 Professional  
| Windows 7 Ultimate  
| Windows 7 Enterprise  
| Windows Vista Home Basic  
| Windows Vista Home Premium  
| Windows Vista Business  
| Windows Vista Ultimate  
| Windows Vista Enterprise  
| Windows XP Home Edition Service Pack 3 or later  
| Windows XP Professional Service Pack 3 or later  
• Only 32-bit version  
• Windows power-saving function is not supported. |
| Processor | • Windows 7/Windows Vista  
Pentium M 1.2 GHz equivalent or higher required  
Dual core 1.5 GHz or higher recommended  
• Windows XP  
Pentium M 1.0 GHz equivalent or higher required  
Dual core 1.0 GHz or higher recommended |
| Memory | • Windows 7/Windows Vista  
512 MB or more required  
1 GB or more recommended  
• Windows XP  
256 MB or more required  
512 MB or more recommended  
* More memory may be required to run additional applications simultaneously. |
| Graphic processor | • Windows 7/Windows Vista  
The “Graphics” score 3.0 or more of “Windows Experience Index” recommended. |
| Network environment | TCP/IP-compatible wired LAN or wireless LAN  
(* Use a wireless LAN unit complying with the Wi-Fi standard.) |
| Resolution | • Windows 7/Windows Vista  
SVGA (800 × 600) or higher required  
XGA (1024 × 768) recommended  
• Windows XP  
VGA (640 × 480) or higher required  
XGA (1024 × 768) recommended  
1024 dots × 768 lines - 1280 dots × 800 lines recommended (PA550W/PA500U) |
| Screen Colors | High Color (15 bits, 16 bits)  
True Color (24 bits, 32 bits) (recommended)  
• 256 or fewer colors are not supported. |
2. Projecting an Image (Basic Operation)

This section describes how to turn on the projector and to project a picture onto the screen.

Flow of Projecting an Image

1. **Step 1**
   - Connecting your computer / Connecting the power cord (→ page 13)

2. **Step 2**
   - Turning on the projector (→ page 14)

3. **Step 3**
   - Selecting a source (→ page 16)

4. **Step 4**
   - Adjusting the picture size and position (→ page 17)
   - Correcting keystone distortion [KEYSTONE] (→ page 22)

5. **Step 5**
   - Adjusting a picture and sound
     - Optimizing a computer signal automatically (→ page 24)
     - Turning up or down volume (→ page 24)

6. **Step 6**
   - Making a presentation

7. **Step 7**
   - Turning off the projector (→ page 25)

8. **Step 8**
   - After use (→ page 26)
2. Projecting an Image (Basic Operation)

1. **Connect your computer to the projector.**
   
   This section will show you a basic connection to a computer. For information about other connections, see “(2) Making Connections” on page 143.

   Connect the computer cable (VGA) between the projector’s COMPUTER 1 IN connector and the computer’s port (mini D-Sub 15 Pin). Turn two thumb screws of both connectors to fix the computer cable (VGA).

2. **Connect the supplied power cord to the projector.**

   First connect the supplied power cord’s three-pin plug to the AC IN of the projector, and then connect the other plug of the supplied power cord in the wall outlet.

   The projector’s power indicator will light orange* (standby mode).

   The STATUS indicator will also light green*.

   * This will apply for both indicators when [NORMAL] is selected for [STANDBY MODE]. See the Power Indicator section. (→ page 214)

   **CAUTION:**

   Parts of the projector may become temporarily heated if the projector is turned off with the POWER button or if the AC power supply is disconnected during normal projector operation. Use caution when picking up the projector.
3. Turning on the Projector

1. Remove the lens cap.

2. Press the (POWER) button on the projector cabinet or the POWER ON button on the remote control.

   The POWER indicator will turn to blue and the projector will become ready to use.

   **TIP:**
   - When the message “PROJECTOR IS LOCKED! ENTER YOUR PASSWORD.” is displayed, it means that the [SECURITY] feature is turned on. (→ page 37)
   - When the ECO message is displayed, it means that [ON] is selected for [ECO MESSAGE]. (→ page 102)
   - Pressing buttons such as power button and MENU button will make sound. To turn off the beep sound, select [OFF] for [BEEP] from the menu. (→ page 109)

   After you turn on your projector, ensure that the computer or video source is turned on.

   **NOTE:** A blue screen (blue background) is displayed when no signal is being input (by factory default menu settings). (→ page 214)
2. Projecting an Image (Basic Operation)

Note on Startup screen (Menu Language Select screen)

When you first turn on the projector, you will get the Startup menu. This menu gives you the opportunity to select one of the 27 menu languages.

To select a menu language, follow these steps:

1. Use the ▲, ▼, ◀ or ► button to select one of the 27 languages from the menu.

2. Press the ENTER button to execute the selection.

After this has been done, you can proceed to the menu operation.
If you want, you can select the menu language later.  
(→ [LANGUAGE] on page 85 and 101)

NOTE:
• Turning the power back on directly after it is turned off (by direct power off) while an image is being projected can result in malfunction. Be sure to wait at least 1 second before turning the power back on.
• Keep the lens cap off the lens while the projector’s power is on.  If the lens cap is on, it could be warped due to high temperature.
• If one of the following things happens, the projector will not turn on.
  - If the internal temperature of the projector is too high, the projector detects abnormal high temperature. In this condition the projector will not turn on to protect the internal system. If this happens, wait for the projector’s internal components to cool down.
  - When the lamp reaches its end of usable life, the projector will not turn on. If this happens, replace the lamp.
  - If the STATUS indicator lights orange with the power button pressed, it means that the [CONTROL PANEL LOCK] is turned on. Cancel the lock by turning it off.  (→ page 106)
  - If the lamp fails to light, and if the STATUS indicator flashes on and off in a cycle of six times, wait a full minute and then turn on the power.
• While the POWER indicator is blinking blue in short cycles, the power cannot be turned off by using the power button.
• Immediately after turning on the projector, screen flicker may occur. This is normal. Wait 3 to 5 minutes until the lamp lighting is stabilized.
• When the projector is turned on, it may take some time before the lamp light becomes bright.
• If you turn on the projector immediately after the lamp is turned off or when the temperature is high, the fans run without displaying an image for some time and then the projector will display the image.
4 Selecting a Source

Selecting the computer or video source

NOTE: Turn on the computer or video source equipment connected to the projector.

Detecting the Signal Automatically

Press the SOURCE button once. The projector will search for the available input source and display it. The input source will change as follows:

COMPUTER1 → COMPUTER2 → COMPUTER3 → HDMI → DisplayPort → VIDEO → S-VIDEO → VIEWER → COMPUTER1 → ...

- With the SOURCE screen displayed, you can press the SOURCE button a few times to select the input source.

TIP: If no input signal is present, the input will be skipped.

Using the Remote Control

Press any one of the COMPUTER1, COMPUTER2, COMPUTER3, HDMI, DisplayPort, VIDEO, S-VIDEO, VIEWER, or NETWORK buttons.

Selecting Default Source

You can set a source as the default source so that it will be displayed each time the projector is turned on.

1. Press the MENU button.
   The menu will be displayed.
2. Press the ► button twice to select [SETUP] and press the ▼ button or the ENTER button to select [BASIC].
3. Press the ► button five times to select [OPTIONS(2)].
4. Press the ▼ button five times to select [DEFAULT SOURCE SELECT] and press the ENTER button.
   The [DEFAULT SOURCE SELECT] screen will be displayed.
   (→ page 111)
5. Select a source as the default source, and press the ENTER button.
6. Press the EXIT button a few times to close the menu.
7. Restart the projector.
   The source you selected in step 5 will be projected.

NOTE: Even when [AUTO] is turned on, the [NETWORK] will not be automatically selected. To set your network as the default source, select [NETWORK].

TIP:
- When the projector is in Standby mode, applying a computer signal from a computer connected to the COMPUTER 1 IN input will power on the projector and simultaneously project the computer’s image. ([AUTO POWER ON(COMP1/3)] → page 111)
- On the Windows 7 keyboard, a combination of the Windows and P keys allows you to set up external display easily and quickly.
### Adjusting the Picture Size and Position

Use the lens shift dial, the adjustable tilt foot lever, the zoom lever/zoom ring and the focus ring to adjust the picture size and position.

*In this chapter drawings and cables are omitted for clarity.*

---

#### Adjusting the projected image’s vertical and horizontal position
[Lens shift]

---

#### Adjusting the focus
[Focus ring]

---

#### Finely adjusting the size of an image
[Zoom lever/Zoom ring]

---

#### Adjusting the projected image’s height and horizontal tilt
[Tilt foot] *¹

---

#### Adjusting the keystone correction
[Keystone]

---

**NOTE** *¹: Adjust the projected image’s height using the tilt feet when you want to project the image at a position higher than the lens shift adjustment range.
2. Projecting an Image (Basic Operation)

Adjusting the vertical position of a projected image (Lens shift)

**CAUTION**
Perform the adjustment from behind or from the side of the projector. Adjusting from the front could expose your eyes to strong light which could injure them.

**Turn the lens shift dials clockwise or counterclockwise.**

**Vertical dial**
Turn this clockwise or counterclockwise to adjust the projection position in the vertical direction. Approximate turning range: About 6 turns counterclockwise, about 2 turns clockwise when the lens is at the center position.

**Horizontal dial**
Turn this clockwise or counterclockwise to adjust the projection position in the horizontal direction. Approximate turning range: About 1 turn counterclockwise, about 1 turn clockwise when the lens is at the center position.

**NOTE:**
- The dials can be turned more than one full turn, but the projection position cannot be moved more than the range indicated on the following page.
- If the lens is shifted to the maximum in the diagonal direction, the edges of the screen will be dark or shaded.
- The lens shift function cannot be used when using the separately sold NP11FL lens.
2. Projecting an Image (Basic Operation)

TIP:
- The diagram below shows the lens shift adjustment range for the PA600X and PA500X (projection mode: desktop front). To raise the projection position higher than this, use the tilt feet. (→ page 21)
- For the PA550W/PA500U and the ceiling mount/front projection lens shift adjustment range, see page 205, 206.

**Focus**
Applicable lens: NP12ZL/NP13ZL/NP14ZL/NP15ZL
Use the FOCUS ring to obtain the best focus.
Applicable lens: NP11FL
With the NP11FL lens, adjust the focus and picture distortion.

Preparations:
Turn the lens shift dials (vertical and horizontal) on the projector to return the lens shift to the center.

Approximate lens center position (explained here for the desktop front projection mode)

Horizontal dial: First turn the dial to the left edge, then turn it further so that the knob is horizontal. From this position, turn the dial 1 full turn clockwise.
Vertical dial: First turn the dial to the bottom edge, then turn it further so that the knob is horizontal. From this position, turn the dial 2 full turns counterclockwise.

1. Turn the distortion ring to the left edge.

2. Turn the focus lever clockwise and counterclockwise to adjust the focus at the center of the screen.

3. Use the distortion ring to correct the screen’s distortion.
   (This also brings the edges of the screen into focus.)

4. Use the focus lever to adjust the screen’s overall focus.
   * If the focus at the center of the screen is off, turn the distortion ring a little counterclockwise. The focus at the center of the screen can now be adjusted with the focus lever.
2. Projecting an Image (Basic Operation)

**Zoom**

Turn the zoom lever or zoom ring clockwise and counterclockwise.

- The separately sold NP11FL lens does not have a zoom ring.

**Adjusting the Tilt Feet**

1. **Turn the left and right tilt feet to adjust.**

   The tilt feet lengthen and shorten when turned.
   
   The height of the projected image is adjusted by turning the left and right tilt feet.

   If the projected image is tilted, turn one of the tilt feet to adjust the image so that it is level.

   - If the projected image is distorted, see “2-6 Correcting Keystone Distortion” (→ page 22).
   - The tilt feet can be lengthened by a maximum of 20 mm.
   - The tilt feet can be used to tilt the projector by a maximum of 4°.

**NOTE:**

- Do not lengthen the tilt feet any more than 20 mm/0.8”. Doing so will make the tilt feet’s mount section unstable and could cause the tilt feet to come off the projector.
- Do not use the tilt feet for any purpose other than adjusting the projector’s projection angle.

Handling the tilt feet improperly, such as carrying the projector by grasping the tilt feet or hooking it onto a wall using the tilt feet, could damage the projector.
6 Correcting Keystone Distortion

When the projector is not exactly perpendicular to the screen, keystone distortion occurs. To overcome it, you can use the “Keystone” function, a digital technology that can adjust for keystone-type distortion, resulting in a crisp, square image.

The following procedure explains how to use the [KEYSTONE] screen from the menu to correct trapezoidal distortions.

When the projector is placed diagonally to the screen,
When the projector is set up at an angle in relation to the screen, adjust the Horizontal option of the Keystone menu so that the top and bottom of sides of the projected image are parallel.

1. Press the 3D REFORM button on the remote control or the projector cabinet.

   The Keystone screen will be displayed on the screen.

2. Press the ▼ button to select [VERTICAL] and then use the ◀ or ◀ so that the left and right sides of the projected image are parallel.

   * Adjust the vertical keystone distortion.

3. Align the left (or right) side of the screen with the left (or right) side of the projected image.
   • Use the shorter side of the projected image as the base.
   • In the right example, use the left side as the base.

4. Press the ▲ button to select [HORIZONTAL] and then use the ◀ or ◀ so that the top and bottom sides of the projected image are parallel.

   * Adjust the horizontal keystone distortion.
5. Repeat steps 2 and 4 to correct keystone distortion.

6. After completing Keystone correction, press the EXIT button. The Keystone screen will disappear.

- To perform Keystone correction again, press the 3D REFORM button to display the Keystone screen and repeat above steps 1 to 6.

NOTE:
- If the projection angle is the same as in the last use, the previous correction setting values are retained in the memory.
- When doing Step 2, adjust the position of image so that the screen is smaller than the area of the projected area.
- To reset the 3D Reform correction setting values, press and hold the 3D REFORM button for a minimum of 2 seconds.
- Each time the 3D REFORM button is pressed, the item will change as follows: KEYSTONE → CORNERSTONE → None → KEYSTONE →...

For information on [CORNERSTONE], see “Correcting Horizontal and Vertical Keystone Distortion (Cornerstone)” on page 32.
- The Cornerstone adjustment will not be available during the Keystone adjustment. To perform the Cornerstone adjustment, press and hold the 3D REFORM button for a minimum of 2 seconds to reset the Keystone correction setting values. The Keystone adjustment will not be available during the Cornerstone adjustment. To perform the Keystone adjustment, press and hold the 3D REFORM button for a minimum of 2 seconds to reset the Cornerstone correction setting values.
- The 3D Reform feature can cause an image to be slightly blurred because the correction is made electronically.
7 Optimizing Computer Signal Automatically
Adjusting the Image Using Auto Adjust

Optimizing a computer image automatically. (COMPUTER1/COMPUTER2/COMPUTER3)
Press the AUTO ADJ. button to optimize a computer image automatically.
This adjustment may be necessary when you connect your computer for the first time.

![Poor picture]

![Normal picture]

**NOTE:**
Some signals may take time to display or may not be displayed correctly.
- If the Auto Adjust operation cannot optimize the computer signal, try to adjust [HORIZONTAL], [VERTICAL], [CLOCK], and [PHASE] manually. (→ page 94, 95)

8 Turning Up or Down Volume
Sound level from the speaker can be adjusted.

![Increase volume](image1)
![Decrease volume](image2)

**TIP:** When no menus appear, the ◄ and ► buttons on the projector cabinet work as a volume control.

**NOTE:**
- Volume control is not available with the ◄ or ► button when an image is enlarged by using the D-ZOOM (+) button or when the menu is displayed.
- Volume control is not available with the ◄ or ► button when VIEWER or NETWORK is used.
2. Projecting an Image (Basic Operation)

9 Turning off the Projector

To turn off the projector:

1. **First, press the (POWER) button on the projector cabinet or the POWER OFF button on the remote control.**
   
   The [POWER OFF / ARE YOU SURE ? / CARBON SAVINGS- SESSION 0.000[g-CO2]] message will appear.

2. **Secondly, press the ENTER button or press the (POWER) or the POWER OFF button again.**

   The lamp will turn off and the projector will go into standby mode. When in standby mode, the POWER indicator will light orange and the STATUS indicator will light green when [NORMAL] is selected for [STANDBY MODE].

![Power On and Standby modes](image)

**CAUTION:**

Parts of the projector may become temporarily heated if the projector is turned off with the POWER button or if the AC power supply is disconnected during normal projector operation. Use caution when picking up the projector.

**NOTE:**

- While the POWER indicator is blinking blue in short cycles, the power cannot be turned off.
- You cannot turn off the power for 60 seconds immediately after turning it on and displaying an image.
- Wait at least 20 minutes after the power is turned on (after starting to project) before turning the AC power off while an image is being projected or while the cooling fan is running.
- Do not unplug the power cord from the projector or from the power outlet while an image is being projected. Doing so could deteriorate the projector’s AC input connector or the power plug’s contact. To turn off the AC power while an image is being projected, use the power strip’s switch, the breaker, etc.
- Do not disconnect the AC power supply to the projector within 10 seconds of making adjustment or setting changes and closing the menu. Doing so can cause loss of adjustments and settings.
2. Projecting an Image (Basic Operation)

10 After Use
Preparation: Make sure that the projector is turned off.

1. Unplug the power cord.

2. Disconnect any other cables.
   • Remove the USB memory if it is inserted into the projector.

3. Mount the lens cap on the lens.

4. Before moving the projector, screw in the tilt feet if they have been lengthened.
3. Convenient Features

1 Turning off the Image and Sound
Press the AV-MUTE button to turn off the image, sound, beep sound for a short period of time. Press again to restore the image and sound.

The projector’s power-saving function will work 10 seconds after the image is turned off. As a result, the lamp power will be reduced.

NOTE:
• To restore the image, even if you press the AV-MUTE button immediately after the start of the power-saving function, the lamp brightness may not be restored to its original level.

2 Freezing a Picture
Press the FREEZE button to freeze a picture. Press again to resume motion.

NOTE: The image is frozen but the original video is still playing back.

3 Enlarging a Picture
You can enlarge the picture up to four times.

NOTE: The maximum magnification may be less than four times depending on the signal.

To do so:

1. Press the D-ZOOM (+) button to magnify the picture.
3. Convenient Features

2. Press the ▲▼◀▶ button.
The area of the magnified image will be moved

3. Press the D-ZOOM (→) button.
Each time the D-ZOOM (→) button is pressed, the image is reduced.

NOTE:
- The image will be enlarged or reduced at the center of the screen.
- Displaying the menu will cancel the current magnification.

4 Changing Eco Mode/Checking Energy-Saving Effect Using Eco Mode [ECO MODE]
This feature enables you to select two brightness modes of the lamp: OFF and ON modes. The lamp life can be extended by turning on the [ECO MODE].

<table>
<thead>
<tr>
<th>[ECO MODE]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[OFF]</td>
<td>This is the default setting (100% Brightness).</td>
</tr>
<tr>
<td>[ON]</td>
<td>Low lamp power consumption (approx. 80% Brightness).</td>
</tr>
</tbody>
</table>

To turn on the [ECO MODE], do the following:
1. Press the ECO button on the remote control to display [ECO MODE] screen.
2. Use the ▲ or ▼ button to select [ON].
3. Press the ENTER button.
To change from [ON] to [OFF], Go back to Step 2 and select [OFF]. Repeat Step 3.

NOTE:
- The [ECO MODE] can be changed by using the menu. Select [SETUP] → [BASIC] → [ECO MODE].
- The lamp life remaining and lamp hours used can be checked in [USAGE TIME]. Select [INFO.] → [USAGE TIME].
- [ECO MODE] is always set to [OFF] for 1 minute immediately after the lamp is turned on. The lamp condition will not be affected even when [ECO MODE] is changed.
- After a lapse of 1 minute from when the projector displays a blue, black or logo screen, [ECO MODE] will automatically switch to [ON].
- If the projector is overheated in [OFF] mode, there may be a case where the [ECO MODE] automatically changes to [ON] mode to protect the projector. This is called “Forced Eco Mode”. When the projector is in the Forced Eco Mode, the picture brightness decreases slightly and the TEMP. indicator lights orange. At the same time the Thermometer symbol [🌡️] is displayed at the bottom right of the screen.
When the projector comes back to normal temperature, the Forced Eco Mode is cancelled and the [ECO MODE] returns to [OFF] mode.
3. Convenient Features

Checking Energy-Saving Effect [CARBON METER]

This feature will show energy-saving effect in terms of CO₂ emission reduction (kg) when the projector’s [ECO MODE] is set to [OFF], or [ON]. This feature is called as [CARBON METER].

There are two messages: [TOTAL CARBON SAVINGS] and [CARBON SAVINGS-SESSION]. The [TOTAL CARBON SAVINGS] message shows the total amount of CO₂ emission reduction from the time of shipment up to now. You can check the information on [USAGE TIME] from [INFO.] of the menu. (→ page 112)

The [CARBON SAVINGS-SESSION] message shows the amount of CO₂ emission reduction between the time of changing to ECO MODE immediately after the time of power-on and the time of power-off. The [CARBON SAVINGS-SESSION] message will be displayed in the [POWER OFF/ ARE YOU SURE?] message at the time of power-off.

TIP:

• The formula as shown below is used to calculate the amount of CO₂ emission reduction.
  \[
  \text{Amount of CO}_2 \text{ emission reduction} = (\text{Power consumption in OFF for ECO MODE} - \text{Power consumption in ON for ECO MODE}) \times \text{CO}_2 \text{ conversion factor}.
  \]
  * When the image is turned off with the AV-MUTE button the amount of CO₂ emmission reduction will also increase.
  * Calculation for amount of CO₂ emission reduction is based on an OECD publication “CO₂ Emissions from Fuel Combustion, 2008 Edition”.

• The [TOTAL CARBON SAVINGS] is calculated based on savings recorded in 15 minutes intervals.
• This formula will not apply to the power consumption which is not affected by whether [ECO MODE] is turned on or off.
Using the Optional Remote Mouse Receiver (NP01MR)

The optional remote mouse receiver enables you to operate your computer’s mouse functions from the remote control. It is a great convenience for clicking through your computer-generated presentations.

Connecting the remote mouse receiver to your computer

If you wish to use the remote mouse function, connect the mouse receiver and computer. The mouse receiver can be connected directly to the computer’s USB port (type A).

NOTE: Depending on the type of connection or OS installed on your computer, you may have to restart your computer or change your computer settings.

When operating a computer via the remote mouse receiver

When connecting using the USB terminal

For PC, the mouse receiver can only be used with a Windows XP*, Windows Vista, Windows 7, or Mac OS X 10.0.0 or later operating system.

* NOTE: In SP1 or older version of Windows XP, if the mouse cursor will not move correctly, do the following: Clear the Enhance pointer precision check box underneath the mouse speed slider in the Mouse Properties dialog box [Pointer Options tab].

NOTE: The PAGE ▼ and ▲ buttons do not work with PowerPoint for Macintosh.

NOTE: Wait at least 5 seconds after disconnecting the mouse receiver before reconnecting it and vice versa. The computer may not identify the mouse receiver if it is repeatedly connected and disconnected in rapid intervals.
Operating your computer’s mouse from the remote control

You can operate your computer’s mouse from the remote control.

- **PAGE ▼/▲ Button:** scrolls the viewing area of the window or to move to the previous or next slide in PowerPoint on your computer.
- **▲▼◄► Buttons:** moves the mouse cursor on your computer.
- **L-CLICK Button:** works as the mouse left button.
- **R-CLICK Button:** works as the mouse right button.

**NOTE:**
- When you operate the computer using the ▲▼◄► button with the menu displayed, both the menu and the mouse pointer will be affected. Close the menu and perform the mouse operation.
- The PAGE ▼ and ▲ buttons do not work with PowerPoint for Macintosh.

About Drag Mode:

By pressing the L-CLICK or R-CLICK button for 2 or 3 seconds then releasing, the drag mode is set and the drag operation can be performed simply by pressing the ▲▼◄► button. To drop the item, press the L-CLICK (or R-CLICK) button. To cancel it, press the R-CLICK (or L-CLICK) button.

**TIP:** You can change the Pointer speed on the Mouse Properties dialog box on the Windows. For more information, see the user documentation or online help supplied with your computer.
3. Convenient Features

Correcting Horizontal and Vertical Keystone Distortion [CORNERSTONE]

Use the 3D Reform feature to correct keystone (trapezoidal) distortion to make the top or bottom and the left or right side of the screen longer or shorter so that the projected image is rectangular.

Cornerstone
1. Press and hold the 3D REFORM button for a minimum of 2 seconds to reset current adjustments.
   Current adjustments for [KEYSTONE] or [CORNERSTONE] will be cleared.
2. Project an image so that the screen is smaller than the area of the raster.
3. Pick up any one of the corners and align the corner of the image with a corner of the screen.

4. Press the 3D REFORM button twice.
   The Cornerstone adjustment screen is displayed.

TIP: PA600X/PA500X: When [WIDE SCREEN] is selected from [SCREEN TYPE], lines that show “16:9” or “16:10” will be displayed. Click the outer corners.
PA550W/P-PA500U: When [4:3 SCREEN] is selected from [SCREEN TYPE], lines that show “4:3” will be displayed. Click the outer corners.

TIP: If you are adjusting [KEYSTONE], [CORNERSTONE] will not be available. If this happens, press and hold the 3D REFORM button for a minimum of 2 seconds to reset the [KEYSTONE] adjustments.

5. Use the ▲▼◄► button to select one icon (▲) which points in the direction you wish to move the projected image frame.
6. Press the ENTER button.
3. Convenient Features

7. Use the ▲▼◄► button to move the projected image frame as shown on the example.

8. Press the ENTER button.

9. Use the ▲▼◄► button to select another icon which points in the direction.
   On the Cornerstone adjustment screen, select [EXIT] or press the EXIT button on the remote control.

The confirmation screen is displayed.

10. Press the ◄ or ► button to highlight the [OK] and press the ENTER button.

This completes the Cornerstone correction.
Selecting [CANCEL] will return to the adjustment screen without saving changes (Step 3).
Selecting [RESET] will return to the factory default.
Selecting [UNDO] will exit without saving changes.

NOTE: To reset the 3D Reform correction setting values, press and hold the 3D REFORM button for a minimum of 2 seconds.
The adjustable ranges for 3D Reform are as follows:

**PA600X/PA500X/PA550W**

<table>
<thead>
<tr>
<th>CORNERSTONE</th>
<th>HORIZONTAL</th>
<th>VERTICAL</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Max. +/- 40° approx.</td>
<td>Max. +/- 30° approx.</td>
</tr>
<tr>
<td>KEYSTONE</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**PA500U**

<table>
<thead>
<tr>
<th>CORNERSTONE</th>
<th>HORIZONTAL</th>
<th>VERTICAL</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Max. +/- 35° approx.</td>
<td>Max. +/- 30° approx.</td>
</tr>
<tr>
<td>KEYSTONE</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* The following are conditions under which the maximum angle is achieved:

- When the lens NP13ZL is used
- When the lens shift is set to the center
  - When the lens shift is used and yet the image is not displayed in the center of the screen, the adjustable range will be increased or decreased.
- Image is projected in maximum wide with the zoom ring

**NOTE:**
- Even when the projector is turned on, the last used correction values are applied.
- If the Cornerstone screen is unavailable (grayed), press and hold the 3D REFORM button for a minimum of 2 seconds to reset the current correction data. The Cornerstone function becomes available.
- Turning on the projector will reset the previous correction setting values and correct distortion anew if the projection angle is changed from the last use.
  - If the projection angle is the same as in the last use, the previous correction setting values are retained in the memory.
- The range of keystone correction is not the maximum tilt angle of projector.

**NOTE:** Using 3D Reform correction can cause the image to be slightly blurred because the correction is made electronically.
Displaying Two Pictures at the Same Time

The projector has a feature that allows you to view two different signals simultaneously. You have two modes: PIP mode and PICTURE BY PICTURE mode.

From the menu you can select [SETUP] → [BASIC] → [PIP/PICTURE BY PICTURE].

The [PIP/PICTURE BY PICTURE] menu item has the following three options: MODE, POSITION, and SOURCE. Use the ▲ or ▼ button to select [MODE], [POSITION] or [SOURCE] and press the ENTER button.

Selecting the PIP or PICTURE BY PICTURE Mode [MODE]

This option allows you to select two modes: PIP and SIDE BY SIDE.

Use the ▲ or ▼ button to select [PIP] or [PICTURE BY PICTURE] and press the ENTER button.

PIP: This option allows you to view a sub picture in the main picture.

![Main picture with sub picture]

PICTURE BY PICTURE: This allows you to view two pictures side by side.

![Main picture and sub picture side by side]

NOTE:
- The main picture will be displayed on the left side and the sub picture on the right side.
- The main picture signal supports the COMPUTER 1, COMPUTER 2, and COMPUTER 3 connectors. The sub picture signal supports the VIDEO IN and S-VIDEO IN connectors.
- The main picture supports an RGB signal with a resolution of 1280 × 1024 pixels or less.
Viewing Two Pictures

1. **Press the PIP button on the remote control.**
   The PIP/PICTURE BY PICTURE SOURCE screen will be displayed.

   ![PIP/PBP Source]

2. **Use the ▲ or ▼ button to select the source and press the ENTER button.**
   The PIP screen or PICTURE BY PICTURE screen will be displayed, depending on which was selected in the [MODE] setting screen.

   ![PIP/PBP Mode]

3. **Press the PIP button again to return to the normal screen (single picture).**

**TIP:**
- Selecting another source will return to the normal screen.
- Selecting a source not supported for the main picture or the sub picture will return to the normal screen.

**[POSITION]**
This option allows you to select the position of a sub picture in the main picture.

**NOTE:**
- The default setting is [BOTTOM-RIGHT].

![PIP Position]

Use the ▲ or ▼ button to select the sub picture’s position and press the ENTER button. The options are: TOP-LEFT, TOP-RIGHT, BOTTOM-LEFT, and BOTTOM-RIGHT.

The following adjustments and settings are available for the main picture only.
- Adjusting picture and sound
- Magnifying a picture

The following operations are available for both the main and sub pictures.
- Picture and audio mute
- Freezing a moving picture
3. Convenient Features

8 Preventing the Unauthorized Use of the Projector [SECURITY]

A keyword can be set for your projector using the Menu to avoid operation by an unauthorized user. When a keyword is set, turning on the projector will display the Keyword input screen. Unless the correct keyword is entered, the projector cannot project an image.

• The [SECURITY] setting cannot be cancelled by using the [RESET] of the menu.

To enable the Security function:

1. Press the MENU button.  
The menu will be displayed.

2. Press the ▲ button twice to select [SETUP] and press the ▼ button or the ENTER button to select [BASIC].

3. Press the ▲ button to select [INSTALLATION(2)].

4. Press the ▼ button three times to select [SECURITY] and press the ENTER button.

```
<table>
<thead>
<tr>
<th>SOURCE</th>
<th>ADJUST</th>
<th>SETUP</th>
<th>INFO.</th>
<th>RESET</th>
</tr>
</thead>
<tbody>
<tr>
<td>INSTALLATION(2)</td>
<td>OPTIONS(1)</td>
<td>OPTIONS(2)</td>
<td>(2/2)</td>
<td></td>
</tr>
<tr>
<td>NETWORK SETTING</td>
<td>OFF</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONTROL PANEL LOCK</td>
<td>OFF</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SECURITY</td>
<td>OFF</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>COMMUNICATION SPEED</td>
<td>38400bps</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>REMOTE SENSOR</td>
<td>FRONT/BACK</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONTROL ID</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

The OFF/ON menu will be displayed.

5. Press the ▼ button to select [ON] and press the ENTER button.

```
SECURITY

OFF

ON

ENTER  SELECT  EXIT  ▼:EXIT  ◄:MOVE

COMPUTER1  ADVANCED
```

The [SECURITY KEYWORD] screen will be displayed.

6. Type in a combination of the four ▲▼◄► buttons and press the ENTER button.

**NOTE:** A keyword must be 4 to 10 digits in length.

```
SECURITY KEYWORD

ENTER  SELECT  EXIT  ▼:EXIT  ◄:INPUT  ►:INPUT
```

The [CONFIRM KEYWORD] screen will be displayed.

**NOTE:** Make a note of your password and store it in a safe place.
3. Convenient Features

7. Type in the same combination of ▲▼◄► buttons and press the ENTER button.

The confirmation screen will be displayed.

8. Select [YES] and press the ENTER button.

The SECURITY function has been enabled.

To turn on the projector when [SECURITY] is enabled:

1. Press the POWER button.
   The projector will be turned on and display a message to the effect that the projector is locked.

2. Press the MENU button.

3. Type in the correct keyword and press the ENTER button. The projector will display an image.

NOTE: The security disable mode is maintained until the main power is turned off or unplugging the power cord.
3. Convenient Features

To disable the SECURITY function:

1. **Press the MENU button.**
   
The menu will be displayed.

2. **Select [SETUP] → [INSTALLATION(2)] → [SECURITY] and press the ENTER button.**
   
   ![Menu Settings](image)
   
The OFF/ON menu will be displayed.

3. **Select [OFF] and press the ENTER button.**
   
The SECURITY KEYWORD screen will be displayed.

   ![Security Keyword](image)
   
   4. **Type in your keyword and press the ENTER button.**
      
      When the correct keyword is entered, the SECURITY function will be disabled.

   **NOTE:** If you forget your keyword, contact your dealer. Your dealer will provide you with your keyword in exchange for your request code. Your request code is displayed in the Keyword Confirmation screen. In this example [NB52-YGK6-2VD6-K585-JNE6-EYA8] is a request code.
9 Controlling the Projector by Using an HTTP Browser

Overview
The HTTP Server function provides settings and operations for:

1. **Setting for wired/wireless network (NETWORK SETTINGS)**
   - To use wireless LAN connection, the optional USB Wireless LAN Unit is required. (→ page 151)
   - To use wired/wireless LAN connection, connect the projector to the computer with a commercially available LAN cable. (→ page 150)

2. **Setting Alert Mail (ALERT MAIL)**
   - When the projector is connected to a wired/wireless network, lamp replace time or error messages will be sent via e-mail.

3. **Operating the projector**
   - Power on/off, selecting input, volume control and picture adjustments are possible.

4. **Setting PJLink PASSWORD and AMX BEACON**

Two ways of access to the HTTP server function are available:

- **Start the Web browser on the computer via the network connected to the projector and enter the following URL:**
  - http://<the projector’s IP address>/index.html

- **Use Image Express Utility Lite or Image Express Utility 2.0 contained on the supplied NEC Projector CD-ROM.**

TIP: The factory setting IP address is [DHCP ON].

NOTE:

- To use the projector in a network, consult with your network administrator about network settings.
- The display’s or button’s response can be slowed down or operation may not be accepted depending the settings of your network.
  - Should this happen, consult your network administrator. The projector may not respond if its buttons are repeatedly pressed in rapid intervals. Should this happen, wait a moment and repeat. If you still can’t get any response, turn off and back on the projector.
  - If the PROJECTOR NETWORK SETTINGS screen does not appear in the web browser, press the Ctrl+F5 keys to refresh your web browser (or clear the cache).
- This device uses “JavaScript” and “Cookies” and the browser should be set to accept these functions. The setting method will vary depending on the version of browser. Please refer to the help files and the other information provided in your software.

Preparation before Use
Connect the projector to a commercially available LAN cable before engaging in browser operations. (→ page 150)

Operation with a browser that uses a proxy server may not be possible depending on the type of proxy server and the setting method. Although the type of proxy server will be a factor, it is possible that items that have actually been set will not be displayed depending on the effectiveness of the cache, and the contents set from the browser may not be reflected in operation. It is recommended that a proxy server not be used unless it is unavoidable.
Handling of the Address for Operation via a Browser

Regarding the actual address that is entered for the address or entered to the URL column when operation of the projector is via a browser, the host name can be used as it is when the host name corresponding to the IP address of the projector has been registered to the domain name server by a network administrator, or the host name corresponding to the IP address of the projector has been set in the “HOSTS” file of the computer being used.

Example 1: When the host name of the projector has been set to “pj.nec.co.jp”, access is gained to the network setting by specifying

http://pj.nec.co.jp/index.html

for the address or the entry column of the URL.

Example 2: When the IP address of the projector is “192.168.73.1”, access is gained to the network setting by specifying

http://192.168.73.1/index.html

for the address or the entry column of the URL.

PROJECTOR ADJUSTMENT

POWER: This controls the power of the projector.
- ON ................ Power is switched on.
- OFF ................ Power is switched off.

VOLUME: This controls the volume of the projector.
- ▲ .................. Increases the volume adjustment value.
- ▼ .................. Decreases the volume adjustment value.

AV-MUTE: This controls the mute function of the projector.
- PICTURE ON ........ Mutes the video.
- PICTURE OFF .......... Cancels the video muting.
- SOUND ON .............. Mutes the audio.
- SOUND OFF .............. Cancels the audio muting.
- ALL ON ................. Mutes each of the video, and audio functions.
- ALL OFF ............... Cancels the muting of each of the video, and audio functions.
3. Convenient Features

PICTURE: Controls the video adjustment of the projector.
- BRIGHTNESS ▲ .... Increases the brightness adjustment value.
- BRIGHTNESS ▼ .... Decreases the brightness adjustment value.
- CONTRAST ▲ .... Increases the contrast adjustment value.
- CONTRAST ▼ .... Decreases the contrast adjustment value.
- COLOR ▲ .... Increases the color adjustment value.
- COLOR ▼ .... Decreases the color adjustment value.
- HUE ▲ .... Increases the hue adjustment value.
- HUE ▼ .... Decreases the hue adjustment value.
- SHARPNESS ▲ .... Increases the sharpness adjustment value.
- SHARPNESS ▼ .... Decreases the sharpness adjustment value.

- The functions that can be controlled will vary depending on the signal being input to the projector. (→ page 93)

SOURCE SELECT: This switches the input connector of the projector.
- COMPUTER 1 .... Switches to the COMPUTER 1 IN connector.
- COMPUTER 2 .... Switches to the COMPUTER 2 IN connector.
- COMPUTER 3 .... Switches to the COMPUTER 3 IN connector.
- HDMI .......... Switches to the HDMI IN connector.
- DisplayPort ........ Switches to the DisplayPort.
- VIDEO .......... Switches to the VIDEO IN connector.
- S-VIDEO .......... Switches to the S-VIDEO IN connector.
- VIEWER .......... Switches to the data on the USB memory device.
- NETWORK ........ Switches to a LAN signal.

PROJECTOR STATUS: This displays the condition of the projector.
- LAMP LIFE REMAINING ...... Displays the remaining life of the lamp as a percentage.
- LAMP HOURS USED.......... Displays how many hours the lamp has been used.
- FILTER HOURS USED ......... Displays how many hours the filter has been used.
- ERROR STATUS ............. Displays the status of errors occurring within the projector.

LOG OFF: Logging off your projector and returning to the authentication screen (LOGON screen).
3. Convenient Features

NETWORK SETTINGS

• SETTINGS

WIRED or WIRELESS

<table>
<thead>
<tr>
<th>SETTING</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SETTING</td>
<td>Set for wired LAN or for wireless LAN.</td>
</tr>
<tr>
<td>APPLY</td>
<td>Apply your settings to wired LAN or wireless LAN.</td>
</tr>
<tr>
<td>DHCP ON</td>
<td>Automatically assign IP address, subnet mask, and gateway to the projector from your DHCP server.</td>
</tr>
<tr>
<td>DHCP OFF</td>
<td>Set IP address, subnet mask, and gateway to the projector assigned by your network administrator.</td>
</tr>
<tr>
<td>IP ADDRESS</td>
<td>Set your IP address of the network connected to the projector.</td>
</tr>
<tr>
<td>SUBNET MASK</td>
<td>Set your subnet mask number of the network connected to the projector.</td>
</tr>
<tr>
<td>GATEWAY</td>
<td>Set the default gateway of the network connected to the projector.</td>
</tr>
<tr>
<td>WINS</td>
<td>Set the IP address of your WINS server of the network connected to the projector when [DHCP] is turned on, this option is not available.</td>
</tr>
<tr>
<td>AUTO DNS ON</td>
<td>DHCP server will automatically assign IP address of DNS server connected to the projector.</td>
</tr>
<tr>
<td>AUTO DNS OFF</td>
<td>Set your IP address of DNS server connected to the projector.</td>
</tr>
</tbody>
</table>

Setting for WIRED LAN

| PROFILE 1/PROFILE 2 | Two settings can be set for wired LAN connection. Select PROFILE 1 or PROFILE 2. |
| DISABLE            | Turn off wired LAN connection                                                 |

Setting for WIRELESS LAN (the optional Wireless LAN Unit required for Europe, Australia, and Asian countries)

| EASY CONNECTION   | Execute a wireless LAN using EASY CONNECTION.                                 |
| SIMPLE ACCES POINT| Set the projector for simple access point.                                   |
| WPS               | Use WPS (Wi-Fi Protected Setup™) to set up the wireless LAN for the projector. NOTE: Use the projector's menus to make WPS connections and change the WPS profile settings. |
| CHANNEL           | Select a channel. Available channels vary depending on the country and region. When you select [INFRASTRUCTURE], make sure that the projector and your access point are on the same channel; when you select [AD HOC], make sure that the projector and your computer are on the same channel. |
| PROFILE 1/PROFILE 2 | Two settings can be set for wireless LAN connection. Select PROFILE 1 or PROFILE 2. |
### 3. Convenient Features

<table>
<thead>
<tr>
<th>SSID</th>
<th>Enter an identifier (SSID) for wireless LAN. Communication can be done only with equipment whose SSID matches SSID for your wireless LAN.</th>
</tr>
</thead>
<tbody>
<tr>
<td>SITE SURVEY</td>
<td>Displays a list of available SSIDs for wireless LAN on site. Select an SSID which you can access.</td>
</tr>
<tr>
<td>NETWORK TYPE</td>
<td>Select communication method when using wireless LAN. INFRASTRUCTURE: Select this option when communicating with one or more equipment connected to the wireless LAN network via a wireless access point. AD HOC: Select this option when using the wireless LAN to directly communicate with a computer in peer-to-peer mode.</td>
</tr>
<tr>
<td>SECURITY TYPE</td>
<td>Turn on or off the encryption mode for secure transmission. When turn on the encryption mode, set WEP key or encrypted key.</td>
</tr>
</tbody>
</table>

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>DISABLE</td>
<td>Will not turn on the encryption feature. Your communications may be monitored by someone.</td>
<td></td>
</tr>
<tr>
<td>WEP 64 bit</td>
<td>Uses 64-bit datalength for secure transmission.</td>
<td></td>
</tr>
<tr>
<td>WEP 128 bit</td>
<td>Uses 128-bit datalength for secure transmission. This option will increase privacy and security when compared to use of 64-bit datalength encryption.</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE:**
- The WEP settings must be the same as communication devices such as PC or access point in your wireless network.
- When you use WEP, your image transmission speed will slow down.
- Other encryption keys than WEP 64bit and WEP 128bit are not available when [AD HOC] is selected from [NETWORK TYPE].
- To install a digital certificate, use the projector's menu. (→ page 125)

<table>
<thead>
<tr>
<th>INDEX</th>
<th>Select encryption key when selecting [WEP 64 bit] or [WEP 128 bit] in [SECURITY TYPE].</th>
</tr>
</thead>
<tbody>
<tr>
<td>KEY</td>
<td>When selecting [WEP 64 bit] or [WEP 128 bit] in [SECURITY TYPE]: Enter WEP key.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Select</th>
<th>Characters (ASCII)</th>
<th>Hexadecimal digit (HEX)</th>
</tr>
</thead>
<tbody>
<tr>
<td>WEP 64 bit</td>
<td>Up to 5 characters</td>
<td>Up to 10 characters</td>
</tr>
<tr>
<td>WEP 128 bit</td>
<td>Up to 13 characters</td>
<td>Up to 26 characters</td>
</tr>
</tbody>
</table>

When selecting [WPA PSK-TKIP], [WPA PSK-AES], [WPA2 PSK-TKIP] or [WPA2 PSK-AES]: Enter encryption key. Key length must be 8 or greater and 63 or less.

<table>
<thead>
<tr>
<th>USERNAME</th>
<th>Set a user name for WPA-EAP/WPA2-EAP.</th>
</tr>
</thead>
<tbody>
<tr>
<td>PASSWORD</td>
<td>Set a password for WPA-EAP TKIP PEAP-MSCHAP v2/WPA-EAP AES PEAP-MSCHAP v2/WPA2-EAP TKIP PEAP-MSCHAP v2/WPA2-EAP AES PEAP-MSCHAP v2.</td>
</tr>
</tbody>
</table>
### 3. Convenient Features

<table>
<thead>
<tr>
<th>USE DIGITAL CERTIFICATE</th>
<th>Select this if you use a digital certificate for WPA-EAP TKIP PEAP-MSCHAP v2/WPA-EAP AES PEAP-MSCHAP v2/WPA2-EAP TKIP PEAP-MSCHAP v2/WPA2-EAP AES PEAP-MSCHAP v2.</th>
</tr>
</thead>
</table>

**• NAME**

<table>
<thead>
<tr>
<th>PROJECTOR NAME</th>
<th>Enter a name for your projector so that your computer can identify the projector. A projector name must be 16 characters or less. TIP: Projector name will not be affected even when [RESET] is done from the menu.</th>
</tr>
</thead>
<tbody>
<tr>
<td>HOST NAME</td>
<td>Enter the hostname of the network connected to the projector. A host name must be 15 or less.</td>
</tr>
<tr>
<td>DOMAIN NAME</td>
<td>Enter the domain name of the network connected to the projector. A domain name must be 60 characters or less.</td>
</tr>
</tbody>
</table>

**• ALERT MAIL**

<table>
<thead>
<tr>
<th>ALERT MAIL</th>
<th>This option will notify your computer of lamp replace time or error messages via e-mail when using wireless or wired LAN. Placing a checkmark will turn on the Alert Mail feature. Clearing a checkmark will turn off the Alert Mail feature. Sample of a message to be sent from the projector: The lamp and filters are at the end of its usable life. Please replace the lamp and filters. Projector Name: NEC Projector Lamp Hours Used: 100 [H]</th>
</tr>
</thead>
<tbody>
<tr>
<td>SENDER'S ADDRESS</td>
<td>Enter sender's address.</td>
</tr>
<tr>
<td>SMTP SERVER NAME</td>
<td>Enter the SMTP server name to be connected to the projector.</td>
</tr>
<tr>
<td>RECIPIENT’S ADDRESS 1, 2, 3</td>
<td>Enter your recipient's address. Up to three addresses can be entered.</td>
</tr>
<tr>
<td>TEST MAIL</td>
<td>Send a test mail to check whether your settings are correct or not</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong></td>
</tr>
<tr>
<td></td>
<td>• If you execute a test, you may not receive an Alert mail. Should this happen, check if network settings are correct.</td>
</tr>
<tr>
<td></td>
<td>• If you entered an incorrect address in a test, you may not receive an Alert mail. Should this happen, check if the Recipient’s Address is correct.</td>
</tr>
<tr>
<td>SAVE</td>
<td>Click this button to save your settings to the projector’s memory.</td>
</tr>
</tbody>
</table>
### 3. Convenient Features

#### NETWORK SERVICE

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PJLink PASSWORD</td>
<td>Set a password for PJLink*. A password must be 32 characters or less. Do not forget your password. However, if you forget your password, consult with your dealer.</td>
</tr>
<tr>
<td>HTTP PASSWORD</td>
<td>Set a password for HTTP server. A password must be 10 characters or less.</td>
</tr>
<tr>
<td>AMX BEACON</td>
<td>Turn on or off for detection from AMX Device Discovery when connecting to the network supported by AMX’s NetLinx control system. <strong>TIP:</strong> When using a device that supports AMX Device Discovery, all AMX NetLinx control system will recognize the device and download the appropriate Device Discovery Module from an AMX server. Placing a checkmark will enable detecting the projector from AMX Device Discovery. Clearing a checkmark will disable detecting the projector from AMX Device Discovery.</td>
</tr>
</tbody>
</table>

*What is PJLink?*

PJLink is a standardization of protocol used for controlling projectors of different manufacturers. This standard protocol is established by Japan Business Machine and Information System Industries Association (JBMIA) in 2005. The projector supports all the commands of PJLink Class 1.

Setting of PJLink will not be affected even when [RESET] is done from the menu.

#### CRESTRON

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DISABLE</td>
<td>Disables CRESTRON CONTROL.</td>
</tr>
<tr>
<td>ENABLE</td>
<td>Enables CRESTRON CONTROL.</td>
</tr>
<tr>
<td>IP ADDRESS</td>
<td>Set your IP address of CRESTRON SERVER.</td>
</tr>
<tr>
<td>IP ID</td>
<td>Set your IP ID of CRESTRON SERVER.</td>
</tr>
</tbody>
</table>

#### INFORMATION

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WIRED LAN</td>
<td>Display a list of settings of wired LAN connection.</td>
</tr>
<tr>
<td>WIRELESS LAN</td>
<td>Display a list of settings of wireless LAN connection.</td>
</tr>
<tr>
<td>UPDATE</td>
<td>Reflect settings when they are changed.</td>
</tr>
</tbody>
</table>

**NOTE:** If you forget your password, contact your dealer.
3. Convenient Features

Projecting Your Computer’s Screen Image from the Projector via a Network [NETWORK PROJECTOR]

By selecting the projector connected to the same network as that of your PC, the PC screen image can be projected to the screen via network. There is no need of connection using the computer cable (VGA).

Operation Environment

<table>
<thead>
<tr>
<th>Applicable OS</th>
<th>Windows 7 Professional</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Windows 7 Ultimate</td>
</tr>
<tr>
<td></td>
<td>Windows 7 Enterprise</td>
</tr>
<tr>
<td></td>
<td>Windows Vista Home Premium</td>
</tr>
<tr>
<td></td>
<td>Windows Vista Business</td>
</tr>
<tr>
<td></td>
<td>Windows Vista Ultimate</td>
</tr>
<tr>
<td></td>
<td>Windows Vista Enterprise</td>
</tr>
</tbody>
</table>

| Hardware specifications       | The specifications recommended by Microsoft as the operation environment for Windows 7/Windows Vista should be satisfied. |
| Network Environment           | Wired LAN or wireless LAN environment that supports TCP/IP is required. |
| Screen color                  | High Color (16 bits) |
|                               | True Color (24 bits and 32 bits) |
|                               | * Setting with 256 colors or less is not available. |

Setting the Projector to Network Projector Input Mode

1. With the projector turned on, press the SOURCE button.

The input selection window appears.

Another way to display the input selection window is to press the NETWORK button on the remote control. The APPLICATION MENU screen will be displayed. Go to step 3.
3. Convenient Features

2. Press the ▼ or ▲ button to select [NETWORK] and press the ENTER button.

   In the screen, the [APPLICATION MENU] menu is displayed.

3. From the [APPLICATION MENU] menu, select [NETWORK PROJECTOR].

   The [PROJECTOR NAME/DISPLAY RESOLUTION/PASSWORD/URL] will be displayed.
3. Convenient Features

Projecting the Image with Network Projector

1. Click [Start] from the desktop of Windows 7.
2. Click [All Programs].
3. Click [Accessories].
4. Click [Connect to a Network Projector].

When the [Permission Connect to a Network Projector] window appears, click [Yes].

The “Connect to a Network Projector” window appears.

5. Click [Search for a projector (recommended)].

In the “Available projectors” box, “PA600 Series” is displayed.

6. Click [PA600 Series].

The message “Enter the password for the projector that you selected.” is displayed at the bottom of the window.
3. Convenient Features

7. Input the password to the password input box displayed by the operation at step 3 on page 44.

8. Click [Connect].

The network projector function works and the screen of Windows 7 is projected from the projector.

- If the resolution of your computer's screen is different from the projector's screen resolution, the NETWORK PROJECTOR function may not work. If this happens, change the resolution of the computer's screen to lower resolution than the one displayed at Step 3 on page 48.

NOTE: When the network projector function works, the background color of the desktop changes to solid color. When the network projector function is stopped, the original background color is restored.

Reference: If the projector cannot be found at Step 5, click [→ Enter the projector address]. Then, input the “Network address” (Input example: http://10.32.97.61/lan) and “Projector password” (Input example: 82291627) displayed in the screen projected from the projector.

Exiting the Network Projector Operation


2. Click [Disconnect].

   The Network Projector function is stopped.

3. Press the SOURCE button of the projector to select an input terminal other than [NETWORK].

   When using the remote control, press a button other than the NETWORK button.
3. Convenient Features

Using the Projector to Operate Your Computer via a Network

[REMOTE DESKTOP]

- By selecting the PC connected to the same network as that of the projector, the PC screen image can be projected to the screen via network.

Then, by operating the keyboard, you can operate Windows 7, Windows Vista or Windows XP on the PC connected with the network.

- With the Remote Desktop function, you can remotely operate the PC placed at a distance from the projector.

NOTE:

- The [REMOTE DESKTOP] function will work on the following Windows editions.
  - Windows 7 Professional
  - Windows 7 Ultimate
  - Windows 7 Enterprise
  - Windows Vista Business
  - Windows Vista Ultimate
  - Windows Vista Enterprise
  - Windows XP Professional with Service Pack 3

  (Note)

- In this user’s manual this feature is described using Windows 7 as an example, but Windows Vista and Windows XP Professional Service Pack 2 or later will also work with this feature.

- A keyboard is required to use the Remote Desktop function.

- The Remote Desktop function can be operated with a keyboard. Using a wireless mouse with a wireless keyboard is more useful for operating.

  Use a commercially available wireless keyboard, a wireless mouse, and a USB wireless receiver.

  Use a commercially available USB keyboard and USB mouse.

- A USB keyboard with a built-in USB hub cannot be used with the projector.

- A wireless keyboard or mouse that supports Bluetooth cannot be used with the projector.

- We do not warrant that the USB port of the projector will support all USB devices in the market.

Prepare a commercially available wireless keyboard (US layout version).

Connect the USB wireless receiver to the USB port (Type A) of the projector. Make all necessary settings for your wireless keyboard and mouse.
Setting the password to the user account of Windows 7

**TIP:** If a password has been set for an account, the steps 1 to 9 can be skipped.

1. Click [Start] from the desktop of Windows 7.
2. Click [Control Panel].
3. Click [Add or remove user accounts] displayed under [User Accounts].
4. When the [User Account Control] confirmation window appears, click [Continue].
5. Click [Administrator].
6. Click [Create a password].
7. Input the password to the [New password] box.
8. Input the same password as that at Step 7 to the [Confirm new password] box.
9. Click [Create a password].
The Administrator is changed to [Password Protection].

Setting the Remote Access

1. Click [Start] from the desktop of Windows 7.
2. Click [Control Panel].
3. Click [System and Security].
4. Click [Allow remote access] displayed under [System].
5. When the [User Account Control] confirmation window appears, click [Continue].
The [System Properties] window appears.
6. Click [Allow connections from computers running any version of Remote Desktop (less secure)] in the Remote Desktop box and click [OK].

Checking the IP address on Windows 7

1. Click [Start] from the desktop of Windows 7.
2. Click [Control Panel].
3. Click [View network status and tasks] displayed under [Network and Internet].
4. **Click** [View status] displayed in blue on the right of [Local Area Connection] in the window.

The [Local Area Connection Status] window appears.

![Local Area Connection Status window](image)

5. **Click** [Details...].

Write down the value for “IPv4 IP Address” (xxx.xxx.xxx.xxx) displayed.

![Network Connection Details](image)

6. **Click** [Close].

7. **Click** [X] at the upper right of the window.

The system goes back to the desktop.

**Starting the Remote Desktop**

1. **With the projector turned on, press the SOURCE button.**

   The input selection window appears.

   Another way to display the input selection window is to press the NETWORK button on the remote control. The NETWORK screen will be displayed. Go to step 3.
3. Convenient Features

2. Press the ▼ or ▲ button to select [NETWORK] and press the ENTER button.

The [NETWORK] menu will be displayed.

3. From the [NETWORK] menu, use the wireless keyboard to select [REMOTE DESKTOP CONNECTION].

The [REMOTE DESKTOP CONNECTION] window appears.

4. Operate the wireless keyboard to input the IP address of Windows 7 and click “Connect”.

The log-on screen of Windows 7 is displayed in the screen projected by the projector.

5. Operate the wireless keyboard to input the user’s password and press “Enter”.

The remote desktop function is started.

Windows 7 desktop is displayed in the screen projected by the projector.

Log out the computer.

Use the wireless keyboard connected to the projector to operate Windows 7.

NOTE: When the projection is made with the remote desktop function, the background color of the desktop is changed to solid color.
Exiting the Remote Desktop

1. **Operate the wireless keyboard to click [Start] from the desktop screen projected by the projector.**

2. **Click [X] on the right of the start menu.**
   - The remote desktop function is stopped.

3. **Press the SOURCE button of the projector to select an input terminal other than [NETWORK].**
   - When using the remote control, press a button other than the NETWORK button.

**TIP:**

Setting [OPTIONS] in REMOTE DESKTOP
Making settings to [OPTIONS] will allow you to display the desktop background, or to enable the window animation function during the Remote Desktop operation. However, doing this will cause the display’s or mouse’s response to slow down.
If the display’s or mouse’s response is slowed down, try one or more of the following:

- **DESKTOP BACKGROUND:** Clear the check mark to display the desktop background in solid color.
- **MENU AND WINDOW ANIMATION:** Clear the check mark to disable menu and window animation.
- **THEMES:** Clear the check mark not to use Themes.
- **SHOW CONTENTS OF WINDOW WHILE DRAGGING:** Clear the check mark to show only the window pane while dragging.
4. Using the Viewer

What you can do with the Viewer

The Viewer feature allows you to view slides or movie files stored on a USB memory on the projector, or a shared folder in a computer connected to the network.

The Viewer has the following features.

- When a commercially available USB memory that stores image files is inserted into the USB port (Type A) of the projector, the Viewer allows you to view the image files on the USB memory.
- Even if no computer is available, presentations can be conducted simply with the projector.
- Movie file with audio can be played back.
- A Microsoft PowerPoint file or Adobe PDF file can be simply projected on the screen without connecting a computer.
- Image and movie files stored in a shared folder in a computer connected to a network can be projected.

The computer with “Media Sharing” of Windows Media Player 11 turned on can be used as a media server.

Supported graphic formats

<table>
<thead>
<tr>
<th>Format</th>
<th>File name extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>JPEG</td>
<td>.jpg, .jpe, .jpeg (CMYK is not supported.)</td>
</tr>
<tr>
<td>BMP</td>
<td>.bmp (bit field not supported)</td>
</tr>
<tr>
<td>PNG</td>
<td>.png (Interlaced PNG and α channel PNG are not supported.)</td>
</tr>
<tr>
<td>GIF</td>
<td>.gif (Interlaced GIF, transparation GIF, and animation GIF are not supported.)</td>
</tr>
</tbody>
</table>

* By using PPT Converter 3.0, PowerPoint file is converted into index file (with extension “.idx”)
* If an unsupported image is selected, the icon will be displayed.

NOTE:

Maximum number of pixels of image which can be displayed are:

- Baseline JPEG: 10000 × 10000
- Progressive JPEG: 1280 × 1280
- GIF: 1280 × 1280
- Others: 4000 × 4000
- Some files supported by the above requirements may not be displayed.

Supported movie files

<table>
<thead>
<tr>
<th>File name extension</th>
<th>Video compression/expansion method</th>
<th>Audio compression/expansion method</th>
</tr>
</thead>
<tbody>
<tr>
<td>.mpg, .mpeg.</td>
<td>MPEG2</td>
<td>MPEG Audio Layer2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>MPEG Audio Layer3</td>
</tr>
<tr>
<td>.wmv</td>
<td>VC-1/WMV9</td>
<td>WMA9 Standard</td>
</tr>
<tr>
<td>.mp4</td>
<td>H.264/AVC</td>
<td>AAC-LC</td>
</tr>
</tbody>
</table>

Playback requirements:

Resolution: 320 × 240 to 1280 × 720
Video frame rate: up to 30fps
Bitrate: up to 15Mbps
Audio sampling rate: up to 48kHz
Channel: up to 2ch stereo
Audio bit rate: up to 256 Kbps
Max. file size: up to 2GB
4. Using the Viewer

NOTE:
• Movie files converted by using the video/audio format which is not supported by this projector cannot be played back.
  In this case, there will be no icon to show that playback is not possible.
• Files with Digital Rights Management (DRM) protection cannot be played back.
• Some of the movie files that meet the above requirements may not be played back.
• WMV format video file will be displayed in an aspect ratio of 1 to 1 independently of its original aspect ratio.
• Files that can be played back on the media server are graphics and movie files. In Windows Media Player 11 (Windows XP/Windows Vista) mp4 files cannot be played back.

Supported PDF files

<table>
<thead>
<tr>
<th>File name extension</th>
<th>Supported file format</th>
</tr>
</thead>
<tbody>
<tr>
<td>.pdf</td>
<td>Adobe Acrobat PDF</td>
</tr>
</tbody>
</table>

NOTE:
• Fonts not embedded in PDF may not be displayed.
• Functions added to PDF file after created will not work or display. Functions added are bookmarks, boxes in form tool, and notes will not be displayed.
  Auto flip or Auto transition will not work.
• Some PDF files may not be displayed.

Supported PowerPoint files

<table>
<thead>
<tr>
<th>File name extension</th>
<th>Supported file format</th>
</tr>
</thead>
<tbody>
<tr>
<td>.ppt, .pptx</td>
<td>Microsoft PowerPoint 97 – 2007</td>
</tr>
</tbody>
</table>

NOTE:
• Playable fonts, colors, font ornament, placement, object insertion or animation are restricted.
• Some Microsoft PowerPoint 97 – 2007 files may not be displayed.

Supported USB memory devices

- Be sure to use a USB memory device formatted with the FAT, exFAT, FAT32 or FAT16 file system.
  The projector does not support NTFS formatted USB memory.
  If the projector does not recognize your USB memory, check if the format is supported.
  To format your USB memory in your computer, refer to the document or help file that comes with your Windows.
- We do not warrant that the USB port of the projector will support all USB memories in the market.
- Wait at least 5 seconds after disconnecting a USB memory device before reconnecting it and vice versa.
  The projector may not identify the USB memory device if it is repeatedly connected and disconnected in rapid intervals.
4. Using the Viewer

Notices on shared folder and media server

• Files from a shared folder or media server may not be projected if security or antivirus software is installed on your computer.

• Open the following firewall ports:
  - Media server
    
    | Port number | Protocol |
    |-------------|----------|
    | 1900        | UDP      |
    | 2869        | TCP      |
    | 10243       | TCP      |
    | 10280-10284 | UDP      |
  
  - Shared folder
    
    | Port number | Protocol |
    |-------------|----------|
    | 137         | UDP/TCP  |
    | 138         | UDP/TCP  |
    | 139         | UDP/TCP  |
    | 445         | UDP/TCP  |

• Set your computer for sharing and security to grant access to files in the shared folder and set your security or antivirus software to grant access to files in the shared folder. Consult your network administrator for more information.

• Movie files in the shared folder or the media server may not be played back correctly depending on your network environment or the bit rate of your file.

NOTE:
Do not disconnect between the projector and your computer by removing the LAN cable or turning off the projector when a PowerPoint file or PDF file is displayed from a shared folder. Doing so will make Viewer inoperable.

NOTE
• The following operations by using the buttons on the projector are not possible when the VIEWER screen such as the slide screen and the thumbnail screen is displayed.
  - Auto Adjustment by using the AUTO ADJ. button
  - Volume control with the ◀ or ▶ button
  - Freezing picture by using the FREEZE, ASPECT, or AUTO ADJ. button on the remote control is not possible when the VIEWER screen such as the slide screen and the thumbnail screen is displayed.
  - Executing [RESET] → [ALL DATA] from the menu will return the settings for the Viewer toolbar to the factory default.
Preparing presentation materials

1. Create your presentation materials and save them in a supported file format to your computer.
   - See page 81 for supported file formats.
   - Make sure that PowerPoint file is displayed on the Viewer before giving your real presentation.
   With Viewer PPT Converter 3.0 contained the supplied CD-ROM, you can convert your PowerPoint files to index
   files that can be displayed on the Viewer.
   - When creating a PDF file, embed your fonts in your PDF file. Embedding fonts requires Adobe Acrobat. This
     cannot be done in Adobe Reader.

   **TIP:**
   - Using Print Command
     Example for font embedding using Print Command. See the help of Adobe Acrobat for more information.
     1. Select “Print” from the “File” menu.
     2. Select “Adobe PDF” from “Printer name” and click the “Properties” button.
     3. Click the “Edit” button in the “Adobe PDF Settings” tab.
     4. Click the font tab in the Edit window to select the font embed window.
     5. Place a check mark for “Embed all fonts”.
        Click “OK” to return to the Print window, and click “OK” to start creating a PDF file.

2. Save a file to your drive.
   To save a file to your USB memory:
   Use the Windows Explore to copy the file to your USB memory.
   To place a file in a shared folder you create in your computer, see page 72.
   To use “Media Sharing” in Windows Media Player 11, see page 76.
3. Projecting images stored in a USB memory device

This section explains the basic operation of the Viewer.
The explanation provides the operational procedure when the Viewer toolbar is set to the factory default.

Preparation: Before starting the Viewer, store images to the USB memory using your computer.

Starting the Viewer

1. Turn on the projector. (→ page 14)
2. Insert the USB memory into the USB port of the projector.

NOTE:
• Do not remove the USB memory from the projector while it's LED flashes. Doing so may corrupt the data.

TIP:
You can a USB memory insert the projector when the drive list screen is displayed.

3. Press the SOURCE button to select [VIEWER].
A press of the SOURCE button will display the source select screen.
A few more presses of the SOURCE button will display the drive list screen.
Another way to select [VIEWER] is to press the VIEWER button on the remote control.

TIP:
• For more information about the drive list screen, see page 64.
• To display graphics in a shared folder, see page 72; to display still images or movie files in a media server, see page 76.
4. Press the ▶ button to select “USB1” and press the ENTER button.
The “USB1” thumbnail screen will be displayed.

TIP:
• For more information about thumbnail screen, see page 66.

5. Use the ▲▼◀ or ▶ button to select an icon.
• The → (arrow) symbol on the right indicates there are more pages. Pressing the PAGE ▼ (page down) button will show the next page: pressing the PAGE △ (page up) will show the previous page.

6. Press the ENTER button.
Operation varies depending on the selected file.

• Still image
  The selected slide will be displayed.
  The ◀ or ▶ button can be used to select the next (right) slide or the previous (left) slide in the thumbnail screen.
• Pressing the ENTER button will display the control bar with which is used to select or rotate an slide. (→ page 67)
4. Using the Viewer

- **Movie file**
  The movie file will start playing.
  After finishing the playback, the screen will turn to black. Press the EXIT button to return to the thumbnail screen.
  - Pressing the ENTER button will display the movie’s control bar with which you can pause or fastforward and some other operations.

- **Microsoft PowerPoint file**
  The slide on the first page will be displayed.
  Press ▶ to select the next slide; press ◀ to select the previous slide.
  - You can also use the ▼ or ▲ button to select a page. To return to the thumbnail screen, press the EXIT button.

**NOTE:**
- Files with slideshow or animation effects may not be correctly displayed on the Viewer. See “Supported PowerPoint files” on page 57, 81.

- **Adobe PDF file**
  The first page will be displayed.
  - The PDF file will fill the width of the screen.
  Pressing the ▼ or ▲ button will scroll the screen down or up.
  The PAGE ▼ or PAGE ▲ button will move the screen one page down or up.
  To return to the thumbnail screen, press the EXIT button.
  - When a password input window is displayed, it means that the PDF file is password-protected.
  Pressing the ENTER button will show the software keyboard. Use the software keyboard to enter your password.
  Select [OK] and press the ENTER button. The PDF file will be displayed.
  - For more information on the software keyboard, see page 131.

**NOTE:**
- Bookmarks and notes that were added after PDF conversion will not be displayed.
- If fonts were not embedded at the time of PDF conversion, those fonts will not be displayed.

**TIP:**
- It takes some time (about 30 seconds to two minutes) to display a large size file or to turn pages of a PDF file that has many pages.
4. Using the Viewer

• **Index file (extension:.idx)**
  
  Index files, which is converted by using Viewer PPT Converter 3.0, will appear in the Thumbnail screen. Only folders and JPEG files converted by using Viewer PPT Converter 3.0 will appear in the Thumbnail screen.

  • To select slideshow of index files, open the [PRESENTATION] folder in the DRIVE LIST screen. However, index files will not appear. Only folders and JPEG files will appear.

  • Up to four index folders in your USB and shared folder are displayed. The four folders will be displayed in reverse chronological order.

  • When you insert the USB memory device storing index with the Viewer in operation, the content of the index files will be displayed.

**NOTE:**

  • The play mode (MANUAL/AUTO) for slides of index file works in the following way:
    
    In case of [MANUAL] for [PLAY MODE]
    When you select [OPTIONS] → [SLIDE SETTING] → [PLAY MODE] → [MANUAL], index files will be set for manual playback in regardless of whether [INTERVAL] is set.
    
    In case of [AUTO] selected for [PLAY MODE]
    When you select [OPTIONS] → [SLIDE SETTING] → [PLAY MODE] → [AUTO], index files will be set for auto playback at intervals specified by using [INTERVAL].
    
    When, however, [-1] is selected for [INTERVAL], the play mode will be set for auto playback according to the setting for [OPTIONS] → [SLIDE SETTING] → [INTERVAL].

7. Remove the USB memory from the projector.

    Return to the drive list screen. Make sure that the LED on the USB memory is not flashing before removing the USB memory.

**NOTE:** If you remove the USB memory from the projector with a slide displayed, the projector may not operate correctly. If this happens, turn off the projector and unplug the power cord. Wait 3 minutes, then connect the power cord, and turn on the projector.

**Exiting the Viewer**

1. **Press the SOURCE button to select a source other than [VIEWER].**

    A press of the SOURCE button will display the source select screen.

    A few more presses of the SOURCE button will display another source.

    • To exit the Viewer using the remote control, select a source other than [VIEWER].
Names and functions of Viewer screen

The Viewer has three screens: Drive list screen, Thumbnail screen, and Slide screen.

- **Drive list screen**
  Displays a list of drives connected to the projector.

  **Menu operation**
  - *Use the ▼ or ▲ button to move the cursor up or down. Select the menu item and press the ENTER button to display the submenu.*

  **Operation for Drive list screen**
  1. **Press the ► button to move the cursor to the drive list.** (Use the ◄ or ► button to switch between the menu and the drive list.)
  2. Press the ▼ or ▲ button to select a type of drive; press the ◄ or ► button to select the drive connected to the projector.
  3. **Select the drive and press the ENTER button to switch to the thumbnail screen of the selected drive.**
### Functions

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>REFRESH</td>
<td>Displays additional media servers in the drive list screen.</td>
</tr>
<tr>
<td>OPTIONS</td>
<td>Opens the OPTIONS menu.</td>
</tr>
<tr>
<td>SLIDE SETTING</td>
<td>Sets up slides. (→ page 69)</td>
</tr>
<tr>
<td>MOVIE SETTING</td>
<td>Sets up movie files. (→ page 70)</td>
</tr>
<tr>
<td>AUTO PLAY SETTING</td>
<td>Sets up auto play. (→ page 70)</td>
</tr>
<tr>
<td>SHAREED FOLDER</td>
<td>Sets up a shared folder. (→ page 72)</td>
</tr>
<tr>
<td>MEDIA SERVER</td>
<td>Sets up a media server. (→ page 76)</td>
</tr>
<tr>
<td>RETURN</td>
<td>Closes the OPTIONS menu.</td>
</tr>
<tr>
<td>SYSTEM SETTING</td>
<td>Switches to the system setting menu. See wired LAN, wireless LAN, WPS,</td>
</tr>
<tr>
<td></td>
<td>network information, mouse, and keyboard in “9. Application Menu”.</td>
</tr>
<tr>
<td></td>
<td>(→ page 118)</td>
</tr>
<tr>
<td>USB</td>
<td>Displays the icon for a USB memory inserted into the USB port of the</td>
</tr>
<tr>
<td></td>
<td>projector.</td>
</tr>
<tr>
<td>SHARED FOLDER</td>
<td>Displays up to four drives of a computer connected to a LAN (set for</td>
</tr>
<tr>
<td></td>
<td>connecting a shared folder).</td>
</tr>
<tr>
<td></td>
<td>* See page 72 for setting up for connecting a shared folder of the</td>
</tr>
<tr>
<td></td>
<td>projector.</td>
</tr>
<tr>
<td>MEDIA SERVER</td>
<td>Displays up to four drives of a computer connected to a LAN (set for</td>
</tr>
<tr>
<td></td>
<td>connecting a media server).</td>
</tr>
<tr>
<td></td>
<td>* See page 76 for setting up for connecting a media server of the</td>
</tr>
<tr>
<td></td>
<td>projector.</td>
</tr>
<tr>
<td>PRESENTATION</td>
<td>Displays the icon when a USB memory or shared folder stores index files.</td>
</tr>
</tbody>
</table>

**Path information**

Displays the location of a folder or file.

**Drive information**

[Example]

- **USB1**

  - 314MB FREE/492MB

  Displays the drive.

  Displays free space and capacity of a drive. (USB only)

**Menu guide**

Displays the description of a selected menu.

**Operation button guide**

Displays information about operation buttons.

---

**NOTE:**

When the OPTIONS menu is displayed, the drive list screen or thumbnail screen is not displayed. To display it, select the [RETURN] icon and press the ENTER button.
4. Using the Viewer

• **Thumbnail screen**
Displays a list of folders, thumbnails, and icons in the drive selected on the drive list screen.

**Menu operation**
• *Use the ▼ or ▲ button to move the cursor up or down. Select the menu item and press the ENTER button to display the menu or setting screen.*

**Operation for Thumbnail screen**
1. **Press the ► button to move the cursor to the thumbnail screen when the OPTIONS menu is not displayed.**
2. **Press the ▼, ▲, ◀, or ► button to select a file or folder.**
3. **Press the ENTER button to start slideshow or playback of the selected file. Selecting a folder will display its thumbnail screen.**

**Functions**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>UP</strong></td>
<td>Goes to one upper level menu.</td>
</tr>
<tr>
<td><strong>THUMBNAIL</strong></td>
<td>Switches two displays between thumbnail and icon.</td>
</tr>
<tr>
<td><strong>SORT SETTING</strong></td>
<td>Rearranges folders or files.</td>
</tr>
<tr>
<td><strong>DRIVE LIST</strong></td>
<td>Returns to the drive list screen.</td>
</tr>
<tr>
<td><strong>OPTIONS</strong></td>
<td>Changes to the OPTIONS menu.</td>
</tr>
<tr>
<td><strong>SYSTEM SETTING</strong></td>
<td>Opens the system setting menu.</td>
</tr>
</tbody>
</table>

**Scroll bar**
Thumbnail screen will display 12 files with 4 by 3. If the thumbnail screen has twelve or more files or folders, the scroll bar will be displayed at the right side. Using the PAGE ▼ or PAGE ▲ button will scroll the whole screen down or up.

**Path information**
Displays the location of a folder or file.

**Thumbnail information**

<table>
<thead>
<tr>
<th>Selected folder name or file name</th>
<th>Numbers and order of files in a folder (only when folder selected)</th>
<th>Create/Change date: M/D/Y/H/M/B</th>
<th>Displays file capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>005.jpg</td>
<td>5/200</td>
<td>11/03/2010 13:25:12</td>
<td>502KB</td>
</tr>
</tbody>
</table>

**Menu guide**
Displays the description of a selected menu.

**Operation button guide**
Displays information about operation buttons.

**TIP:**
- If an unsupported image is selected, the icon [?] will be displayed.
- The maximum displayable number of images is 300 in the thumbnail screen including the number of folders.
- If a file name or path of a folder is longer than specified, it will be displayed with center characters or path skipped.
  Example: “123456789.jpg” will be displayed in “123..789.jpg”.

66
• Slide screen (still image/movie)
Play a file selected from a list of thumbnails or icons.
  • For operating a Microsoft PowerPoint file and Adobe PDF file, see page 62.

Control bar operation
  • The control bar will be displayed only when a still image (or index file) and a movie file is selected.
  • The control bar for still images differs from that for movie files.

1. **Pressing the ENTER button in Slide screen will display the control bar at the bottom of the screen.**
2. **Use the ◀ or ▶ button to select a file and press the ENTER button.**
  • The selected function will be executed.

Functions of still image control bar

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>◀ PREV</td>
<td>Goes back to the previous image</td>
</tr>
<tr>
<td>‹ PLAY</td>
<td>Plays the image. This button also is used to stop or start playing an image.</td>
</tr>
<tr>
<td>▶ NEXT</td>
<td>Goes to the next image.</td>
</tr>
</tbody>
</table>
| ● RIGHT | Rotates the image 90° clockwise.  
  • To cancel, select another folder. |
| ▽ LEFT | Rotates the image 90° counter clockwise.  
  • To cancel, select another folder. |
| ‡ SIZE |  
  † BEST FIT | Displays the image with its aspect ratio in the projector’s displayable maximum resolution. |
| ‡ ACTUAL SIZE | Displays the image in its actual size. |
| ✗ CLOSE | Closes the control bar.  
  • You can also press the EXIT button to close the control bar. |
| ☎ END | Stops playing slides or slideshow, and closes the control bar to return to the thumbnail screen. |
## Functions of movie control bar

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| PREV   | Goes back to the beginning of a movie file.  
  • Goes back to the beginning of the previous movie file if executed immediately after being started playing. |
| FR     | Fast-rewinds a movie file for about 7 seconds.                                                                                             |
| PLAY/PAUSE |                                                                                   |
| PLAY   | Plays a movie file.                                                                |
| PAUSE  | Stops playing a movie file.                                                         |
| FF     | Fast-forwards a movie file for about 7 seconds.                                                                                             |
| NEXT   | Goes to the beginning of a next movie file.                                                                                                 |
| TIME   | Displays an elapsed time for playback or pause.                                                                                             |
| SIZE   |                                                                                                                                              |
| BEST FIT | Displays the image with its aspect ratio in the projector's displayable maximum resolution.                                                          |
| ACTUAL SIZE | Displays the image in its actual size.                                                                                                            |
| CLOSE  | Closes the control bar.  
  • You can also press the EXIT button to close the control bar.                                                                 |
| END    | Stops playing a movie, and closes the control bar to return to the thumbnail screen.                                                          |
Viewer option settings

• **SLIDE SETTING**

Sets still images or slides.

<table>
<thead>
<tr>
<th>Name</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCREEN SIZE</td>
<td>BEST FIT</td>
<td>Displays the image with its aspect ratio in the projector’s displayable maximum resolution.</td>
</tr>
<tr>
<td></td>
<td>ACTUAL SIZE</td>
<td>Displays the image in its actual size.</td>
</tr>
<tr>
<td>PLAY MODE</td>
<td>MANUAL</td>
<td>Selects manual play.</td>
</tr>
<tr>
<td></td>
<td>AUTO</td>
<td>Selects auto play.</td>
</tr>
<tr>
<td>INTERVAL</td>
<td>5 - 300 seconds</td>
<td>Specifies interval time when [AUTO] is selected for PLAY MODE.</td>
</tr>
<tr>
<td>REPEAT</td>
<td>Check mark</td>
<td>Turns on or off the repeat function.</td>
</tr>
</tbody>
</table>

**TIP**

• To play one or more slides, place those files into a folder.
4. Using the Viewer

• MOVIE SETTING
Sets the functions for a movie file.

![MOVIE SETTING](image)

<table>
<thead>
<tr>
<th>Name</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCREEN SIZE</td>
<td>BEST FIT</td>
<td>Displays the image with its aspect ratio in the projector's displayable maximum resolution.</td>
</tr>
<tr>
<td>ACTUAL SIZE</td>
<td></td>
<td>Displays the image in its actual size.</td>
</tr>
<tr>
<td>REPEAT</td>
<td>OFF</td>
<td>Turns on or off the repeat function.</td>
</tr>
<tr>
<td></td>
<td>ONE REPEAT</td>
<td>Repeats one file only.</td>
</tr>
<tr>
<td></td>
<td>ALL REPEAT</td>
<td>Repeats all files in the current folder.</td>
</tr>
</tbody>
</table>

**TIP**

• Turning on [REPEAT] will display black screen during intermission between movies.

• AUTO PLAY SETTING
Sets auto play for slideshow when a USB memory device is inserted into the USB port of the projector, or when [VIEWER] is selected for [SOURCE].

![AUTO PLAY SETTING](image)

<table>
<thead>
<tr>
<th>Name</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUTO PLAY</td>
<td>OFF</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>PICTURE</td>
<td>Plays the first still image found in a drive.</td>
</tr>
<tr>
<td></td>
<td>MOVIE</td>
<td>Plays the first movie found in a drive.</td>
</tr>
<tr>
<td></td>
<td>PowerPoint</td>
<td>Plays the first PowerPoint file found in a drive.</td>
</tr>
</tbody>
</table>

**TIP**

• Auto play behavior is different between when a USB memory device is inserted into the USB port of the projector and when [VIEWER] is selected for [SOURCE].
• Auto play starts for the first found file supporting the file type set up for Auto Play. The file will be searched in the drive root or lower level.
• When [VIEWER] is selected for [SOURCE], the last selected file will be automatically played if it is found, or the last selected folder will be searched and the first found file will be automatically played.

To automatically play a movie file in a USB memory, store one movie file or change its file name so that it can be searched first.
• SORT SETTING

Sets the order of displaying thumbnails or slides.

<table>
<thead>
<tr>
<th>Name</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SORT</td>
<td>NAME (ABC..)</td>
<td>Displays the files alphabetically by name in ascending order.</td>
</tr>
<tr>
<td></td>
<td>NAME (ZYX..)</td>
<td>Displays the files alphabetically by name in descending order.</td>
</tr>
<tr>
<td></td>
<td>EXT. (ABC..)</td>
<td>Displays the files alphabetically by extension in ascending order.</td>
</tr>
<tr>
<td></td>
<td>EXT. (ZYX..)</td>
<td>Displays the files alphabetically by extension in descending order.</td>
</tr>
<tr>
<td></td>
<td>DATE (NEW)</td>
<td>Displays the files in reverse chronological order.</td>
</tr>
<tr>
<td></td>
<td>DATE (OLD)</td>
<td>Displays the files in chronological order.</td>
</tr>
<tr>
<td></td>
<td>SIZE (BIG)</td>
<td>Displays the files in descending order of its file size.</td>
</tr>
<tr>
<td></td>
<td>SIZE (SMALL)</td>
<td>Displays the files in ascending order of its file size.</td>
</tr>
</tbody>
</table>


### Projecting data from shared folder

**Preparation**

For projector: Connect the projector to the network.

For computer: Place files to be projected in a shared folder and note the folder’s path. Memorize or write down the path for later use.

- For sharing a folder, refer to your user guide or help file accompanied with your Windows computer.
- Use a keyboard to give a name to the shared folder in alphanumeric characters.
- To connect the shared folder beyond the subnet, set [WINS CONFIGURATION] in [NETWORK SETTINGS] from the menu.
- Digital signature (SMB signature) is not supported.

**Connecting the projector to the shared folder**

1. **Press the VIEWER button on the remote control.**

   The drive list window will be displayed.

   - Another way to start the VIEWER is to press the SOURCE button a few times on the projector cabinet. (→ page 16)
2. Displays the [OPTIONS] menu.

Press the ▼ button to select the (OPTIONS) icon and press the ENTER button.

• When the OPTIONS menu is displayed, the drive list will not be displayed.

3. Display the [SHARED FOLDER SETTING] screen.

Press the ▼ button to select the (SHARED FOLDER SETTING) icon and press the ENTER button.

4. Select a folder number and place to enable it.

Press the ◀ or ▶ button to a shared folder number and press the ▼ button to select [ENABLE], and then press the ENTER button.

5. Enter the path, user name, and password for the shared folder.

Press the ▼ button to select the [SHARED FOLDER] field. The software keyboard will be displayed. For using the software keyboard, see page 131.

• If your computer is not password protected, entering a password is not required.
• Up to four shared folders can be added.
• The maximum length of a path of the shared folder must be 15 alphanumeric characters for computer name and 23 alphanumeric characters for folder name.
6. **Exit the setting.**

   Press the ▼ button to select [OK] and press the ENTER button. This will close the [SHARED FOLDER] screen.

   • If an error message appear, your settings are not correct. Try again.
Dissecting the shared folder from the projector

- **Disable the number of a shared folder you wish to disconnect**
  
  Press the ▼ button to select [ENABLE] and press the ENTER button to clear it.

**NOTE:**
- When a PowerPoint file or PDF file is displayed, do not disconnect your LAN cable. If doing so, the Viewer will not work.

**TIP:**
- Connecting settings for Shared folder
  
  Settings of up to four folders can be saved.
  
  Restarting the projector will display setting-saved shared folders in grey folder icon on the drive list screen.
  
  Selecting the grey icon folder will skip entry for a folder path.
  
  Failing to connect with a shared folder will display the folder icon with “x” mark. If this happen, check your folder setting.
5 Projecting data from media server

Preparation
For projector: Connect the projector to the network.
For computer: Prepare image files or movie files to be projected, and set up “Media Sharing” in Windows Media Player 11 or Windows Media Player 12.

NOTE:
• Both the projector and the media server must be on the same subnet. Connecting to the media server beyond the subnet is not possible.
• Types of images and movies which can be shared may vary depending on Windows version.

Setting up “Media Sharing” in Windows Media Player 11
2. Select “Media Sharing” from “Library”.

The “Media Sharing” dialog box will be displayed.
3. Select “Share my media” check box, and then select OK.

A list of accessible devices will be displayed.

4. Select “PA600 Series” and then “Allow”.

A check mark will be added to the “PA600 Series” icon.

- The “PA600 Series” is a projector name specified in [NETWORK SETTINGS].

5. Select “OK”.

This will make pictures and video in “Library” available from the projector.
Setting up “Media Sharing” in Windows Media Player 12


2. Select “Stream”, and then select “Automatically allow devices to play my media”.

The “Allow All Media Devices” windows will be displayed.

3. Select “Automatically allow all computers and media devices”.

Graphics and movie files in “Library” can be used from the projector.
Connecting the projector to the media server

Press the VIEWER button on the remote control. The VIEWER will start.

Another way to start the VIEWER is to press the SOURCE button a few times on the projector cabinet. (→ page 16)

This will start searching for a computer with “media sharing” enabled in the network and add it to the “Media server” of the thumbnail screen.

Another way to do this is to point the cursor to “Media server” and select [REFRESH] from the thumbnail menu and press the ENTER button.

NOTE:
- Up to four accessible media servers can be automatically searched and displayed. The fifth device or later cannot be displayed.

(→ page 60)
4. Using the Viewer

Disconnecting the projector from the media server

1. Display the OPTIONS menu.

Press the ▼ button to select the [OPTIONS] icon and press the ENTER button.

2. Display the MEDIA SERVER setting screen.

Press the ▼ button to select the MEDIA SERVER icon and press the ENTER button.

3. Disable the connection.

Press the ENTER button to clear the checkmark to disable the connection.

Press the ▼ button to select [OK] and press the ENTER button to close the MEDIA SERVER setting screen.
6 Restrictions on displaying files

The Viewer allows you to give a simplified display of a PowerPoint file or PDF file. Due to simplified display, however, actual display may be different from the one on your computer application program.

Some restrictions on PowerPoint files

- Fonts will be automatically converted to the fonts installed in the projector. Fonts can vary in size or width, causing layout corruption.
  - Some characters or fonts may not be displayed.
- Some functions included in font are not supported.
  - Example: There are some restrictions on animation, selection, or hyperlink.
- It may take longer time to feed pages compared with a computer.
- In some cases Microsoft PowerPoint 97-2007 format files may not be displayed.

Some restrictions on PDF files

- Fonts not embedded at the time of PDF creation may not be displayed.
- Some functions included in font are not supported.
  - Example: There are some restrictions on annotations, selection, form, or color space.
- It may take longer time to feed pages compared with a computer.
- In some cases Adobe Acrobat format files may not be displayed.
5. Using On-Screen Menu

1. **Using the Menus**

   **NOTE:** The on-screen menu may not be displayed correctly while interlaced motion video image is projected.

   1. Press the **MENU** button on the remote control or the projector cabinet to display the menu.

   ![Menu Options](image)

   **NOTE:** The commands such as **ENTER**, **EXIT**, **▼**, **▲**, **◄ ►** in the bottom show available buttons for your operation.

   2. Press the **◄ ►** buttons on the remote control or the projector cabinet to display the submenu.

   3. Press the **ENTER** button on the remote control or the projector cabinet to highlight the top item or the first tab.

   4. Use the **▲▼** buttons on the remote control or the projector cabinet to select the item you want to adjust or set.

   You can use the **◄ ►** buttons on the remote control or the projector cabinet to select the tab you want.

   5. Press the **ENTER** button on the remote control or the projector cabinet to display the submenu window.

   6. Adjust the level or turn the selected item on or off by using the **▲▼◄ ►** buttons on the remote control or the projector cabinet.

   Changes are stored until adjusted again.

   7. Repeat steps 2 - 6 to adjust an additional item, or press the **EXIT** button on the remote control or the projector cabinet to quit the menu display.

   **NOTE:** When a menu or message is displayed, several lines of information may be lost, depending on the signal or settings.

   8. Press the **MENU** button to close the menu.

   To return to the previous menu, press the **EXIT** button.
Menu windows or dialog boxes typically have the following elements:

- **Highlight** ............... Indicates the selected menu or item.
- **Solid triangle** ............. Indicates further choices are available. A highlighted triangle indicates the item is active.
- **Tab** ...................... Indicates a group of features in a dialog box. Selecting on any tab brings its page to the front.
- **Radio button** ............. Use this round button to select an option in a dialog box.
- **Source** .................. Indicates the currently selected source.
- **Menu mode** .............. Indicates the current menu mode: BASIC or ADVANCED.
- **Off Timer remaining time** Indicates the remaining countdown time when the [OFF TIMER] is preset.
- **Slide bar** .................. Indicates settings or the direction of adjustment.
- **ECO mode symbol** ........ Indicates [ECO MODE] is set.
- **Key Lock symbol** ........ Indicates the [CONTROL PANEL LOCK] is enabled.
- **Thermometer symbol** .... Indicates the [ECO MODE] is forcibly set to [ON] mode because the internal temperature is too high.
- **High Altitude symbol** .... Indicates the [FAN MODE] is set to [HIGH ALTITUDE] mode.
- **Wireless symbol** .......... Indicate the wireless LAN connection is enabled.
### 3 List of Menu Items

Some menu items are not available depending on the input source.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Default</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>SOURCE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>COMPUTER1</td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>COMPUTER2</td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>COMPUTER3(BNC)</td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>HDMI</td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>DisplayPort</td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>VIDEO</td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>S-VIDEO</td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>VIEWER</td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>NETWORK</td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>ENTRY LIST</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TEST PATTERN</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| PICTURE          |                  |                                              |
| MODE             | STANDARD         | STANDARD, PROFESSIONAL                       |
| PRESET           |                  |                                              |
| GENERAL          |                  |                                              |
| REFERENCE        | *                | HIGH-BRIGHT, PRESENTATION, VIDEO, MOVIE, GRAPHIC, sRGB, DICOM SIM. |
| GAMMA CORRECTION*1 |                | DYNAMIC, NATURAL, BLACK DETAIL              |
| SCREEN SIZE*2    | *                | LARGE, MEDIUM, SMALL                         |
| COLOR TEMPERATURE*3 |            | 5000, 6500, 7800, 8500, 9300, 10500         |
| DYNAMIC CONTRAST | *                | OFF, ON                                     |

| ADJUST           |                  |                                              |
| CONTRAST         | 50               |                                              |
| BRIGHTNESS       | 50               |                                              |
| SHARPNESS        | 10               |                                              |
| COLOR            | 50               |                                              |
| HUE              | 0                |                                              |

| IMAGE OPTIONS    |                  |                                              |
| OVERSCAN         | *                | AUTO, 0(%), 5(%), 10(%)                      |
| ASPECT RATIO     |                  | (COMPONENT/VIDEO/S-VIDEO) AUTO, 4:3, LETTERBOX, WIDE SCREEN, ZOOM |
| RESOLUTION       |                  | (COMPONENT/VIDEO/S-VIDEO) AUTO, 4:3 WINDOW, LETTERBOX, WIDE SCREEN, 4:3 FILL |

| VIDEO            |                  |                                              |
| NOISE REDUCTION  | RANDOM NR        | OFF, LOW, MEDIUM, HIGH                      |
| MOSQUITO NR      | OFF              | OFF, LOW, MEDIUM, HIGH                      |
| BLOCK NR         | OFF              | OFF, ON                                     |
| DEINTERLACE      | AUTO             | AUTO, VIDEO, FILM                            |
| 3D Y/C SEPARATION| ON               | OFF, ON                                     |
| DETAIL ENHANCEMENT| *               |                                              |
| SIGNAL TYPE      | RGB              | RGB, COMPONENT                              |
| VIDEO LEVEL      | AUTO             | AUTO, NORMAL, ENHANCED                      |

* The asterisk (*) indicates that the default setting varies depending on the signal.
*1 The [GAMMA CORRECTION] item is available when an item other than [DICOM SIM.] is selected for [REFERENCE].
*2 The [SCREEN SIZE] item is available when [DICOM SIM.] is selected for [REFERENCE].
*3 When [PRESENTATION] or [HIGH-BRIGHT] is selected in [REFERENCE], the [COLOR TEMPERATURE] is not available.
### 5. Using On-Screen Menu

| BASIC | | | |
|---|---|---|
| KEYSTONE | | HORIZONTAL | 0 |
| | | VERTICAL | 0 |
| CORNERSTONE | | | |
| PIP/Picture by Picture | | PIP | | PIP PICTURE BY PICTURE |
| | | PIP POSITION | BOTTOM-RIGHT |
| | | BOTTOM-LEFT, BOTTOM-LEFT, BOTTOM-RIGHT, BOTTOM-RIGHT |
| | | PIP/PBP SOURCE | OFF |
| | | OFF, VIDEO, S-VIDEO |
| WALL COLOR | | OFF, WHITEBOARD, BLACKBOARD, BLACKBOARD (GRAY), LIGHT YELLOW, LIGHT GREEN, LIGHT BLUE, SKY BLUE, LIGHT ROSE, PINK |
| ECO MODE | | OFF, ON |
| CLOSED CAPTION | | OFF, CAPTION1, CAPTION2, CAPTION3, CAPTION4, TEXT1, TEXT2, TEXT3, TEXT4 |
| OFF TIMER | | OFF, 0:30, 1:00, 2:00, 4:00, 8:00, 12:00, 16:00 |
| TOOLS | | ADMINISTRATOR MODE, PROGRAM TIMER, TIME, MOUSE |
| LANGUAGE | | ENGLISH, DEUTSCH, FRANÇAIS, ITALIANO, ESPAÑOL, SVENSKA, DANSK, PORTUGUÉS, ČESŤINA, MAGYAR, POLSKI, SUOMI, NORSK, TÜRKÇE, РУССКИЙ, 日本語, 한국어, ROMANA, HRVATSKA, БЪЛГАРСКИ, INDONESIA, हिन्दी, ТАЙ, 中文, 한국어, ROMANA, HRVATSKA, БЪЛГАРСКИ, INDONESIA, हिन्दी, ТАЙ, 中文, 한국어 |
| | | OFF |

| MENU | | | |
|---|---|---|
| COLOR SELECT | | COLOR | COLOR, MONOCHROME |
| SOURCE DISPLAY | | ON | OFF, ON |
| MESSAGE DISPLAY | | ON | OFF, ON |
| ID DISPLAY | | ON | OFF, ON |
| ECO MESSAGE | | OFF, ON |
| DISPLAY TIME | | AUTO 45 SEC | MANUAL, AUTO 5 SEC, AUTO 15 SEC, AUTO 45 SEC |
| BACKGROUND | | BLUE | BLUE, BLACK, LOGO |
| FILTER MESSAGE | | OFF | OFF, 100[H], 500[H], 1000[H], 2000[H] |

| INSTALLATION | | (1) | | |
|---|---|---|---|
| ORIENTATION | | DESKTOP FRONT | DESKTOP FRONT, CEILING REAR, DESKTOP REAR, CEILING FRONT |
| SCREEN | | 4:3 SCREEN | 4:3 SCREEN, 16:9 SCREEN, 16:10 SCREEN |
| POSITION | | OFF | OFF, ON |
| GEOMETRIC CORRECTION | | OFF | OFF, 1, 2, 3 |
| MULTI-SCREEN COMP. | | OFF | OFF, ON |
| CONTRAST | | 0 | 0 |
| BRIGHTNESS | | 0 | 0 |
| REF. WHITE BALANCE | | CONTRAST R | 0 |
| | | CONTRAST G | 0 |
| | | CONTRAST B | 0 |
| | | BRIGHTNESS R | 0 |
| | | BRIGHTNESS G | 0 |
| | | BRIGHTNESS B | 0 |
| | | UNIFORMITY R | 0 |
| | | UNIFORMITY G | 0 |
| | | UNIFORMITY B | 0 |
| | | HORIZONTAL R | 0 |
| | | HORIZONTAL G | 0 |
| | | HORIZONTAL B | 0 |
| | | VERTICAL R | 0 |
| | | VERTICAL G | 0 |
| | | VERTICAL B | 0 |

| INSTALLATION | | (2) | | |
|---|---|---|---|
| NETWORK SETTINGS | | WIRED LAN, WIRELESS LAN, WPS, NETWORK INFORMATION, PROJECTOR NAME, DOMAIN, ALERT MAIL, NETWORK SERVICE |
| CONTROL PANEL LOCK | | OFF | OFF, ON |
| SECURITY | | OFF, ON |
| COMMUNICATION SPEED | | 38400bps | 4800bps, 9600bps, 19200bps, 38400bps, 115200bps |
| REMOTE SENSOR | | FRONT/BACK | FRONT/BACK, FRONT, BACK |
| CONTROL ID | | CONTROL ID NUMBER | 1–254 |

| OPTIONS(1) | | | |
|---|---|---|
| AUTO ADJUST | | NORMAL | OFF, NORMAL, FINE |
| FAN MODE | | AUTO | MODE: AUTO, HIGH, HIGH ALTITUDE |
| | | NORMAL | SETTING: NORMAL, VERTICAL TILT UP |
| SIGNAL SELECT(COMP3) | | RGB/ COMPONENT | RGB/COMPONENT, VIDEO |
| SEAMLESS SWITCHING(PA500U only) | | OFF | OFF, ON |
| COLOR SYSTEM | | VIDEO | AUTO |
| | | S-VIDEO | AUTO |
| | | COMPUTER3 (VIDEO) | AUTO |
| DIGITAL AUDIO SEULECT | | HDMI | HDMI, COMPUTER2 |
| DISPLAY | | DisplayPort | DisplayPort, COMPUTER2 |
| BEEP | | OFF, ON | OFF, ON |

* The asterisk (*) indicates that the default setting varies depending on the signal.
### 5. Using On-Screen Menu

#### SETUP OPTIONS(2)
- **STANDBY MODE**: NORMAL, POWER-SAVING, NETWORK STANDBY
- **DIRECT POWER ON**: OFF, ON
- **AUTO POWER ON(COM1/3)**: OFF, COMPUTER1, COMPUTER3
- **AUTO POWER OFF**: OFF, 0:05, 0:10, 0:20, 0:30
- **DEFAULT SOURCE SELECT**: LAST, AUTO, COMPUTER1, COMPUTER2, COMPUTER3, HDMI, DisplayPort, VIDEO, S-VIDEO, VIEWER, NETWORK

#### USAGE TIME
- **LAMP LIFE REMAINING**
- **LAMP HOURS USED**
- **FILTER HOURS USED**
- **TOTAL CARBON SAVINGS**

#### SOURCE(1)
- **INPUT TERMINAL**
- **RESOLUTION**
- **HORIZONTAL FREQUENCY**
- **VERTICAL FREQUENCY**
- **SYNC TYPE**
- **SYNC POLARITY**
- **SCAN TYPE**
- **SOURCE NAME**
- **ENTRY NO.**

#### SOURCE(2)
- **SIGNAL TYPE**
- **VIDEO TYPE**
- **BIT DEPTH**
- **VIDEO LEVEL**
- **LINK RATE**
- **LINK LANE**

#### INFO.
- **WIRED LAN**
  - **IP ADDRESS**
  - **SUBNET MASK**
  - **GATEWAY**
  - **MAC ADDRESS**

- **WIRELESS LAN(1)**
  - **IP ADDRESS**
  - **SUBNET MASK**
  - **GATEWAY**
  - **MAC ADDRESS**

- **WIRELESS LAN(2)**
  - **SSID**
  - **NETWORK TYPE**
  - **WEP/WPA**
  - **CHANNEL**
  - **SIGNAL LEVEL**
  - **FIRMWARE**
  - **DATA**
  - **FIRMWARE2**
  - **SUB-CPU**

- **VERSION (1)**
- **VERSION (2)**

#### OTHERS
- **PROJECTOR NAME**
- **MODEL NO.**
- **SERIAL NUMBER**
- **LAN UNIT TYPE**
- **CONTROL ID (when [CONTROL ID] is set)**

#### RESET
- **CURRENT SIGNAL**
- **ALL DATA**
- **ALL DATA(INCLUDING ENTRY LIST)**
- **CLEAR LAMP HOURS**
- **CLEAR FILTER HOURS**
**5. Using On-Screen Menu**

### Menu Descriptions & Functions [SOURCE]

<table>
<thead>
<tr>
<th>SOURCE</th>
<th>ADJUST</th>
<th>SETUP</th>
<th>INFO.</th>
<th>RESET</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Computer1]</td>
<td>![Computer2]</td>
<td>![Computer3]</td>
<td>![HDMI]</td>
<td>![DisplayPort]</td>
</tr>
<tr>
<td>![Video]</td>
<td>![S-Video]</td>
<td>![Viewer]</td>
<td>![Network]</td>
<td>![Entry List]</td>
</tr>
</tbody>
</table>

#### COMPUTER 1, 2, and 3
Selects the computer connected to your COMPUTER 1, 2, or COMPUTER 3 input connector signal.

**NOTE:** When the component input signal is connected to the COMPUTER 1 IN, COMPUTER 2 IN, or COMPUTER 3 IN connector, select [COMPUTER1], [COMPUTER2] or [COMPUTER3] respectively. The projector automatically determines whether the COMPUTER1, 2, or 3 input signal is an RGB or component signal.

#### HDMI
Selects the HDMI compatible equipment connected to your HDMI IN connector.

#### DisplayPort
Projects the image of the device connected to the DisplayPort input connector.

#### VIDEO
Selects what is connected to your VIDEO input—VCR, DVD player or document camera.

#### S-VIDEO
Selects what is connected to your S-VIDEO input—VCR or DVD player.

**NOTE:** A frame may freeze for a brief period of time when a video is played back in fast-forward or fast-rewind with a Video or S-Video source.

#### VIEWER
This feature enables you to make presentations using a USB memory that contains slides. (→ page 56 “4. Using the Viewer”)

#### NETWORK
Selects a signal from the LAN port (RJ-45) or the installed USB wireless LAN unit (optional for models for Europe, Australia, Asia and other countries than North America).

#### ENTRY LIST
Displays a list of signals. See the following pages.

#### TEST PATTERN
Closes the menu and switches to the test pattern screen. The previous screen reappears when the EXIT button is pressed.
5. Using On-Screen Menu

Using the Entry List

When any source adjustments are made, the adjustments are automatically registered in the Entry List. The (adjustment values of) registered signals can be loaded from the Entry List whenever necessary. However, only up to 100 patterns can be registered in the Entry List. When 100 patterns have been registered in the Entry List, an error message is then displayed and no additional patterns can be registered. You should thus delete (adjustment values of) signals that are no longer needed.

Displaying the Entry List

1. Press the MENU button.

   The menu will be displayed.

2. Press the ▼ or ► button to select [SOURCE].

   The SOURCE list will be displayed.

3. Use the ◀, ▶, ▲, or ▼ to select [ENTRY LIST] and press the ENTER button.

   The ENTRY LIST windows will be displayed.

   If the ENTRY LIST window is not displayed, switch the menu to [ADVANCED].

   To switch the menu between [ADVANCED] and [BASIC], select [APPLICATION MENU] → [TOOLS] → [ADMINISTRATOR MODE]. (→ page 136)
5. Using On-Screen Menu

Entering the currently projected signal into the Entry List [STORE]

1. Press the ▲ or ▼ button to select any number.

2. Press the ◀ or ▶ button to select [STORE] and press the ENTER button.

![ENTRY LIST]

Calling up a signal from the Entry List [LOAD]
Press the ▲ or ▼ button to select a signal and press the ENTER button.

Editing a signal from the Entry List [EDIT]

1. Press the ▲ or ▼ button to select a signal you wish to edit.

2. Press the ◀, ▶, ▲, or ▼ button to select [EDIT] and press the ENTER button.

   The Edit window will be displayed.

![EDIT]

<table>
<thead>
<tr>
<th>SOURCE NAME</th>
<th>Enter a signal name. Up to 18 alphanumeric characters can be used.</th>
</tr>
</thead>
<tbody>
<tr>
<td>INPUT TERMINAL</td>
<td>Select the input source.</td>
</tr>
<tr>
<td>LOCK</td>
<td>Set so that the selected signal cannot be deleted when [ALL DELETE] is executed. The changes made after LOCK execution cannot be saved.</td>
</tr>
<tr>
<td>SKIP</td>
<td>Set so that the selected signal will be skipped during auto search.</td>
</tr>
</tbody>
</table>

3. Set the above items and select [OK] and press the ENTER button.

**NOTE:** The input terminal cannot be changed to the currently projected signal.
5. Using On-Screen Menu

Cutting a signal from the Entry List [CUT]

1. Press the ▲ or ▼ button to select a signal you wish to delete.
2. Press the ◀, ▶, ▲, or ▼ button to select [CUT] and press the ENTER button.

   The signal will be deleted from the Entry List and the deleted signal will be displayed on the clipboard at the bottom of the Entry List.

NOTE:

• The currently projected signal cannot be deleted.
• When the locked signal is selected, it will be displayed in gray which indicates it is not available.

TIP:

• Data on the clipboard can be passed onto the Entry List.
• Data on the clipboard will not be lost after the Entry List is closed.

Copying and pasting a signal from the Entry List [COPY] / [PASTE]

1. Press the ▲ or ▼ button to select a signal you wish to copy.
2. Press the ◀, ▶, ▲, or ▼ button to select [COPY] and press the ENTER button.

   The copied signal will be displayed on the clipboard at the bottom of the Entry List.
3. Press the ◀ or ▶ button to move to the list.
4. Press the ▲ or ▼ button to select a signal.
5. Press the ◀, ▶, ▲, or ▼ button to select [PASTE] and press the ENTER button.

   Data on the clipboard will be pasted to the signal.

Deleting all the signals from the Entry List [ALL DELTE]

1. Press the ◀, ▶, ▲, or ▼ button to select [ALL DELETE] and press the ENTER button.

   The confirmation message will be displayed.
2. Press the ◀ or ▶ button to select [YES] and press the ENTER button.

NOTE: The locked signal cannot be deleted.
5 Menu Descriptions & Functions [ADJUST]

[PICTURE]

This function allows you to determine how to save settings for [DETAIL SETTINGS] of [PRESET] for each input.

STANDARD .......... Saves settings for each item of [PRESET] (Preset 1 through 7)
PROFESSIONAL..... Saves all the settings of [PICTURE] for each input.

[PRESET]

This function allows you to select optimized settings for your projected image.
You can adjust neutral tint for yellow, cyan or magenta.
There are seven factory presets optimized for various types of images. You can also use [DETAIL SETTINGS] to set user adjustable settings to customize each gamma or color.
Your settings can be stored in [PRESET 1] to [PRESET 7].

HIGH-BRIGHT........ Recommended for use in a brightly lit room.
PRESENTATION ...... Recommended for making a presentation using a PowerPoint file.
VIDEO.................. Recommended for typical TV program viewing.
MOVIE ................. Recommended for movies.
GRAPHIC .............. Recommended for graphics.
 sRGB .................. Standard color values
DICOM SIM............ Recommended for DICOM simulation format.

NOTE:
• The [DICOM SIM.] option is for training/reference only and should not be used for actual diagnosis.
• DICOM stands for Digital Imaging and Communications in Medicine. It is a standard developed by the American College of Radiology (ACR) and the National Electrical Manufacturers Association (NEMA).
  The standard specifies how digital image data can be moved from system to system.

[DETAIL SETTINGS]
[GENERAL]

Storing Your Customized Settings [REFERENCE]
This function allows you to store your customized settings in [PRESET 1] to [PRESET 7].
First, select a base preset mode from [REFERENCE], then set [GAMMA CORRECTION] and [COLOR TEMPERATURE].

- HIGH-BRIGHT ....... Recommended for use in a brightly lit room.
- PRESENTATION ...... Recommended for making a presentation using a PowerPoint file.
- VIDEO .................. Recommended for typical TV program viewing.
- MOVIE ................. Recommended for movies.
- GRAPHIC .............. Recommended for graphics.
- sRGB .................. Standard color values.
- DICOM SIM. .......... Recommended for DICOM simulation format.

Selecting Gamma Correction Mode [GAMMA CORRECTION]
Each mode is recommended for:
- DYNAMIC .............. Creates a high-contrast picture.
- NATURAL .............. Natural reproduction of the picture.
- BLACK DETAIL ....... Emphasizes detail in dark areas of the picture.

NOTE: This function is not available when [DICOM SIM.] is selected for [DETAIL SETTINGS].

Selecting Screen Size for DICOM SIM [SCREEN SIZE]
This function will perform gamma correction appropriate for the screen size.
- LARGE .................. For screen size of 150"
- MEDIUM ............... For screen size of 100"
- SMALL ................ For screen size of 50"

NOTE: This function is available only when [DICOM SIM.] is selected for [DETAIL SETTINGS].

Adjusting Color Temperature [COLOR TEMPERATURE]
This option allows you to select the color temperature of your choice.

NOTE: When [PRESENTATION] or [HIGH-BRIGHT] is selected in [REFERENCE], this function is not available.

Adjusting Brightness and Contrast [DYNAMIC CONTRAST]
This function allows you to adjust the contrast ratio optically using the built-in iris.
To increase the contrast ratio, select [ON].

Adjusting White Balance [WHITE BALANCE]
This allows you to adjust the white balance. Contrast for each color (RGB) to adjust the white level of the screen;
Brightness for each color (RGB) is used to adjust the black level of the screen.
[COLOR CORRECTION]
Corrects the color for all signals.
Adjusts the tone for the colors red, green, blue, yellow, magenta and cyan.

RED .................. Adjusts the color in red areas, centered around the red.
This can be used to adjust to a yellow- or magenta-tinged red.

GREEN .................. Adjusts the color in green areas, centered around the green.
This can be used to adjust to a yellow- or cyan-tinged green.

BLUE .................. Adjusts the color in blue areas, centered around the blue.
This can be used to adjust to a violet- or cyan-tinged blue.

YELLOW .................. Adjusts the color in yellow areas, centered around the yellow.
This can be used to adjust to a red- or green-tinged yellow.

MAGENTA ................. Adjusts the color in magenta areas, centered around the magenta.
This can be used to adjust to a red- or blue-tinged magenta.

CYAN .................. Adjusts the color in cyan areas, centered around the cyan.
This can be used to adjust to a green- or blue-tinged cyan.

[CONTRAST]
Adjusts the intensity of the image according to the incoming signal.

[BRIGHTNESS]
Adjusts the brightness level or the back raster intensity.

[SHARPNESS]
Controls the detail of the image.

(COLOR]
Increases or decreases the color saturation level.

[HUE]
Varies the color level from +/- green to +/- blue. The red level is used as reference.

<table>
<thead>
<tr>
<th>Input signal</th>
<th>CONTRAST</th>
<th>BRIGHTNESS</th>
<th>SHARPNESS</th>
<th>COLOR</th>
<th>HUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMPUTER/DisplayPort/HDMI (RGB)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>COMPUTER/DisplayPort/HDMI (COMPONENT)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>VIDEO/S-VIDEO/COMPONENT</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>VIEWER/NETWORK</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

Yes = Adjustable, No = Not adjustable

[RESET]
The settings and adjustments for [PICTURE] will be returned to the factory settings with the exception of the following;
Preset numbers and [REFERENCE] within the [PRESET] screen.
The settings and adjustments under [DETAIL SETTINGS] within the [PRESET] screen that are not currently selected will not be reset.
Adjusting Clock and Phase [CLOCK/PHASE]

This allows you to manually adjust CLOCK and PHASE.

**CLOCK**
Use this item to fine tune the computer image or to remove any vertical banding that might appear. This function adjusts the clock frequencies that eliminate the horizontal banding in the image. This adjustment may be necessary when you connect your computer for the first time.

**PHASE**
Use this item to adjust the clock phase or to reduce video noise, dot interference or cross talk. (This is evident when part of your image appears to be shimmering.)
Use [PHASE] only after the [CLOCK] is complete.

NOTE: The [CLOCK] and [PHASE] items are available for RGB signals only.
5. Using On-Screen Menu

Adjusting Horizontal/Vertical Position [HORIZONTAL/VERTICAL]
Adjusts the image location horizontally and vertically.

- An image can be distorted during the adjustment of [CLOCK] and [PHASE]. This is not malfunction.
- The adjustments for [CLOCK], [PHASE], [HORIZONTAL], and [VERTICAL] will be stored in memory for the current signal. The next time you project the signal with the same resolution, horizontal and vertical frequency, its adjustments will be called up and applied.

To delete adjustments stored in memory, from the menu, you select [RESET] → [CURRENT SIGNAL] and reset the adjustments.

[BLANKING]
Adjusts the display range (blanking) at the top, bottom, left and right edges of the input signal.

Selecting Overscan Percentage [OVERSCAN]
Select overscan percentage (Auto, 0%, 5% and 10%) for signal.

NOTE:
- The [OVERSCAN] item is not available:
  - when [NATIVE] is selected for [ASPECT RATIO].
  - when [VIEWER] or [NETWORK] is selected for [SOURCE]
Selecting the Aspect Ratio [ASPECT RATIO]

Use this function to select the screen's vertical:horizontal aspect ratio. Select the screen type (4:3 screen, 16:9 screen or 16:10 screen) at the screen setting before setting the aspect ratio. (→ page 104)

The projector automatically identifies the signal being input and sets the optimum aspect ratio.

For Computer signal

For Component/Video/S-Video signals

When the screen type is set to 4:3

When the screen type is set to 16:9 or 16:10

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Aspect Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>VGA</td>
<td>640 x 480</td>
</tr>
<tr>
<td>SVGA</td>
<td>800 x 600</td>
</tr>
<tr>
<td>XGA</td>
<td>1024 x 768</td>
</tr>
<tr>
<td>WXGA</td>
<td>1280 x 768</td>
</tr>
<tr>
<td>WXGA</td>
<td>1280 x 800</td>
</tr>
<tr>
<td>HD(FWXGA)</td>
<td>1366 x 768</td>
</tr>
<tr>
<td>WXGA+</td>
<td>1440 x 900</td>
</tr>
<tr>
<td>SXGA</td>
<td>1280 x 1024</td>
</tr>
<tr>
<td>SXGA+</td>
<td>1400 x 1050</td>
</tr>
<tr>
<td>WXGA+</td>
<td>1600 x 900</td>
</tr>
<tr>
<td>UXGA</td>
<td>1600 x 1200</td>
</tr>
<tr>
<td>WSXGA+</td>
<td>1680 x 1050</td>
</tr>
<tr>
<td>FHD(1080P)</td>
<td>1920 x 1080</td>
</tr>
<tr>
<td>WUXGA</td>
<td>1920 x 1200</td>
</tr>
</tbody>
</table>

Options | Function
---|---
AUTO | The projector will automatically determine the incoming signal and display it in its aspect ratio. The projector may erroneously determine the aspect ratio depending on its signal. If this occurs, select the appropriate aspect ratio from the following.

4:3 | The image is displayed in 4:3 aspect ratio.
5:4 | The image is displayed in 5:4 aspect ratio
16:9 | The image is displayed in 16:9 aspect ratio
15:9 | The image is displayed in 15:9 aspect ratio
16:10 | The image is displayed in 16:10 aspect ratio
NATIVE | The projector displays the current image in its true resolution when the incoming computer signal has a lower or higher resolution than the projector's native resolution. (→ page 2)

When the incoming computer signal has a higher resolution than the projector's native resolution, the center of an image will be displayed.
<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LETTER BOX</td>
<td>The image of a letterbox signal (16:9) is stretched equally in the horizontal and vertical directions to fit the screen.</td>
</tr>
<tr>
<td>WIDE SCREEN</td>
<td>The image of a squeeze signal (16:9) is stretched left and right in 16:9.</td>
</tr>
<tr>
<td>ZOOM</td>
<td>The image of a squeeze signal (16:9) is stretched left and right in 4:3. Parts of the displayed image are cropped at the left and right edges and therefore not visible.</td>
</tr>
<tr>
<td>4:3 FILL</td>
<td>The image of a signal (4:3) is stretched left and right in 16:9.</td>
</tr>
</tbody>
</table>

**TIP:**
- Image position can be adjusted vertically using [POSITION] when the [16:9], [15:9], or [16:10] aspect ratios are selected.
- The term “letterbox” refers to a more landscape-oriented image when compared to a 4:3 image, which is the standard aspect ratio for a video source.
  - The letterbox signal has aspect ratios with the vista size “1.85:1” or cinema scope size “2.35:1” for movie film.
- The term “squeeze” refers to the compressed image of which aspect ratio is converted from 16:9 to 4:3.

**[RESOLUTION]**

This function sets the resolution of a projected image if auto-detect fails to work well.
Using Noise Reduction [NOISE REDUCTION]
This function is used to reduce video noise.

RANDOM NR ........... Reduces flickering random noise in an image.
MOSQUITO NR ........ Reduces mosquito noise that appears around the edges of an image during DVD playback.
BLOCK NR ............ Reduces block noise or mosaic-like patterns by selecting ON.

Selecting Interlaced Progressive Conversion Process Mode [DEINTERLACE]
This function allows you to select an interlaced-to-progressive conversion process for video signals.

AUTO .................. Determines an appropriate interlaced-to-progressive conversion process automatically.
VIDEO .................. Applies a normal interlaced-to-progressive conversion process.
FILM ................... Applies the automatic detection mode for telecine signals. This option is recommended for a movie picture.

NOTE: This function is not available with RGB signals.

Turning On or Off the 3D Dimensional Separation [3D Y/C SEPARATION]
When projecting an image from a VIDEO input, set to ON to project the highest quality image.

OFF .................... Turns off the 3 dimensional separation feature.
ON ...................... Turns on the 3 dimensional separation feature.

NOTE: Only available for NTSC 3.58 video signals.

[DETAIL ENHANCEMENT]
This function enhances the contours of the image when projecting component signals.

[SIGNAL TYPE]
The projector automatically identifies whether the COMPUTER 1, COMPUTER 2 or COMPUTER 3* input signals are RGB or component signals to project the image. If the colors are unnatural, however, try switching the setting.
* For COMPUTER 3, the computer signal and video signal can be selected at SIGNAL SELECT(COMP3).

RGB ..................... Switches to the RGB input.
COMPONENT ........... Switches to the component signal input.
5. Using On-Screen Menu

[VIDEO LEVEL]
This function selects video signal level when the projector's HDMI and DisplayPort input connectors and an external device are connected.

AUTO .................... The video level is switched automatically based on the information from the device outputting the signal. Depending on the connected device, this setting may not be made properly. In this case, switch to “NORMAL” or “ENHANCED” from the menu and view with the optimum setting.

NORMAL ................. This disables the enhanced mode.

ENHANCED ............. This improves the image’s contrast, expressing the dark and light sections more dynamically.
Menu Descriptions & Functions [SETUP]  

[BASIC]

Correcting Vertical Keystone Distortion Manually [KEYSTONE]
You can correct vertical distortion manually. (→ page 22)

TIP: When this option is highlighted, pressing the ENTER button will display its slide bar for adjustment.

Selecting Cornerstone Mode [CORNERSTONE]

This option allows you to correct trapezoidal distortion. Selecting this item will display the Cornerstone adjustment screen. (→ page 32)

NOTE: The [CORNERSTONE] item is not available when [KEYSTONE] or [GEOMETRIC CORRECTION] is selected.

Using the PIP/PICTURE BY PICTURE Function [PIP/PICTURE BY PICTURE]
This function allows you to view two different signals simultaneously. (→ page 35)

MODE:
This option allows you to select two modes: PIP and PICTURE BY PICTURE.
PIP: This option allows you to view a sub picture in the main picture.
PICTURE BY PICTURE: This allows you to view two pictures side by side.

POSITION:
When [PIP] is selected for [MODE], this option allows you to select the position of a sub picture in the main picture.
The options are: TOP-LEFT, TOP-RIGHT, BOTTOM LEFT, and BOTTOM RIGHT.

NOTE: The [POSITION] cannot be selected when [PICTURE BY PICTURE] is selected.
5. Using On-Screen Menu

SOURCE:
This option allows you to select a sub picture signal.
The options are: OFF, VIDEO and S-VIDEO.
Selecting [OFF] will cancel the PIP/PICTURE BY PICTURE mode and return to the normal screen.

Using the Wall Color Correction [WALL COLOR]

This function allows for quick adaptive color correction in applications where the screen material is not white.


Setting Eco Mode [ECO MODE]
The ECO MODE increases lamp life, while lowering power consumption and cutting down on CO₂ emissions.
Two brightness modes of the lamp can be selected: [OFF] and [ON] modes. (→ page 28)

Setting Closed Caption [CLOSED CAPTION]
This option sets several closed caption modes that allow text to be superimposed on the projected image of Video or S-Video.
- OFF .................... This exits the closed caption mode.
- CAPTION 1-4 ........ Text is superimposed.
- TEXT 1-4 ............... Text is displayed.

Using Off Timer [OFF TIMER]
1. Select your desired time between 30 minutes and 16 hours: OFF, 0:30, 1:00, 2:00, 4:00, 8:00, 12:00, 16:00.
2. Press the ENTER button on the remote control.
3. The remaining time starts counting down.
4. The projector will turn off after the countdown is complete.

NOTE:
- To cancel the preset time, set [OFF] for the preset time or turn off the power.
- When the remaining time reaches 3 minutes before the projector is turned off, the [THE PROJECTOR WILL TURN OFF WITHIN 3 MINUTES] message will be displayed on the bottom of the screen.

Selecting Menu Language [LANGUAGE]
You can choose one of 27 languages for on-screen instructions.

NOTE: Your setting will not be affected even when [RESET] is done from the menu.
5. Using On-Screen Menu

[SELECTING MENU COLOR [COLOR SELECT]]
You can choose between two options for menu color: COLOR and MONOCHROME.

[TURNING ON / OFF SOURCE DISPLAY [SOURCE DISPLAY]]
This option turns on or off input name display such as COMPUTER 1, COMPUTER2, COMPUTER3, HDMI, Display-Port, VIDEO, S-VIDEO, VIEWER, NETWORK to be displayed on the top right of the screen.

[TURNING MESSAGES ON AND OFF [MESSAGE DISPLAY]]
This option selects whether or not to display projector messages at the bottom of the projected image. Even when “OFF” is selected, the security lock warning is displayed. The security lock warning turns off when the security lock is canceled.

[TURNING ON/OFF CONTROL ID [ID DISPLAY]]
ID DISPLAY ............ This option turns on or off the ID number which is displayed when the ID SET button on the remote control is pressed. (→ page 106)

[TURNING ON / OFF ECO MESSAGE [ECO MESSAGE]]
This option turns on or off the following messages when the projector is turned on.

The Eco Message prompts the user to save energy. When [OFF] is selected for [ECO MODE], you will get a message to prompt you to select [ON] for [ECO MODE].

When [ON] is selected for [ECO MODE]

<table>
<thead>
<tr>
<th>CARBON METER</th>
</tr>
</thead>
<tbody>
<tr>
<td>ECO MODE</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

To close the message, press any one of the buttons. The message will disappear if no button operation is done for 30 seconds.
When [OFF] is selected for [ECO MODE]

Pressing the ENTER button will display the [ECO MODE] screen. (→ page 28)
To close the message, press the EXIT button.

Selecting Menu Display Time [DISPLAY TIME]
This option allows you to select how long the projector waits after the last touch of a button to turn off the menu. The preset choices are [MANUAL], [AUTO 5 SEC], [AUTO 15 SEC], and [AUTO 45 SEC]. The [AUTO 45 SEC] is the factory preset.

Selecting a Color or Logo for Background [BACKGROUND]
Use this feature to display a blue/black screen or logo when no signal is available. The default background is [BLUE].

**NOTE:**
- Even when the background logo is selected, if two pictures are displayed in [PIP/PICTURE BY PICTURE] mode, the blue background is displayed without the logo when there is no signal.

Selecting Interval Time for Filter Message [FILTER MESSAGE]
This option allows you to select the time preference between displaying the message for cleaning the filters. Clean the filter when you get the message “PLEASE CLEAN FILTER.” (→ page 155)
Five options are available: OFF, 100[H], 500[H], 1000[H], 2000[H]
The default setting is [OFF].

**NOTE:** Your setting will not be affected even when [RESET] is done from the menu.

[INSTALLATION(1)]

Selecting Projector Orientation [ORIENTATION]
This reorients your image for your type of projection. The options are: desktop front projection, ceiling rear projection, desktop rear projection, and ceiling front projection.

This projector is a free-tilt projector with which it is possible to project images on the ceiling (upward) or floor (downward). When installed in the vertical direction, set the [FAN MODE] installation orientation. (→ page 108)
Selecting Aspect Ratio and Position for Screen [SCREEN]

<table>
<thead>
<tr>
<th>Screen type</th>
<th>Sets the aspect ratio of the projection screen.</th>
</tr>
</thead>
<tbody>
<tr>
<td>4:3 screen</td>
<td>For a screen with a 4:3 aspect ratio</td>
</tr>
<tr>
<td>16:9 screen</td>
<td>For a screen with a 16:9 aspect ratio</td>
</tr>
<tr>
<td>16:10 screen</td>
<td>For a screen with a 16:10 aspect ratio</td>
</tr>
</tbody>
</table>

Display position (for the PA600X/PA500X) When the screen type is set to 16:9 or 16:10, adjusts the vertical position of the display range.

- **Downward**
- **Upward**

**NOTE:**
- After changing the screen type, check the setting of [ASPECT RATIO] in the menu. (→ page 96)
- When the screen type is set to “4:3 screen”, this is displayed in light characters and cannot be selected.

Using Geometric Correction [GEOMETRIC CORRECTION]

This feature retrieves geometric data registered in the projector memory. Three presets of geometric data have been registered. To turn off this feature, select [OFF].

**NOTE:**
- The [KEYSTONE] and [CORNERSTONE] adjustments are not available when geometric data is applied.
- To clear your geometric data, press the 3D REFORM button for a minimum of 2 seconds.
- The [GEOMETRIC CORRECTION] feature can cause an image to be slightly blurred because the correction is made electronically.

Using Multi-Screen Compensation [MULTI-SCREEN COMP.]

This feature allows you to match hue of images projected from multiple projectors that are placed in parallel.

**MODE** ................. OFF: Turns off this function to return to the normal brightness.
ON: Turns on this function to make the screen darker. The [BRIGHTNESS] and the [CONTRAST] can be adjusted.

CONTRAST ............... Adjusts the bright part of the picture.
BRIGHTNESS ........... Adjusts the dark part of the picture.

Adjusting

1. Prepare black and white images so that the images can be displayed on the computer screen.
2. Display the black image on the computer screen, and project the image from the projector.
3. Select [MULTI-SCREEN COMP.] → [MODE] → [ON].
4. Adjust the dark part of the images.
   Press the ▼ button to select [BRIGHTNESS] and use the ◀ or ▶ to match the black part of another projector.
5. Display the white screen on the computer screen.
   Project the image from two or more projectors.
6. Adjust the bright part of the images.
   Press the ▼ button to select [CONTRAST] and use the ◀ or ▶ to match the white part of another projector.
   Moving the slide bar toward [+](plus) can change the white part of the image. Should this happen, move the slide bar toward [−](minus) to adjust the brightness.

TIP:
• When you use multiple projectors, you can use the [CONTROL ID] function to operate a single projector or all the projectors from the remote control. (→ page 106)
• Your setting will not be affected even when [RESET] is done from the menu.

[REF. WHITE BALANCE]
This feature allows you to adjust the white balance for all signals.
The white and black levels of the signal are adjusted for optimum color reproduction.
Uniformity is also adjusted when the redness (R) and blueness (B) of the white color in the screen’s horizontal (left/right) direction are uneven.

BRIGHTNESS R/BRIGHTNESS G/BRIGHTNESS B
........................................ These adjust the picture’s black color.
CONTRAST R/CONTRAST G/CONTRAST B
........................................ These adjust the picture’s white color.
UNIFORMITY R........ The further this is set to the + side, the stronger the redness on the left side of the picture (increasing towards the left edge) and the weaker the redness on the right side of the picture (decreasing towards the right edge).
   This is reversed when set to the − side.
UNIFORMITY B........ The further this is set to the + side, the stronger the blueness on the left side of the picture (increasing towards the left edge) and the weaker the blueness on the right side of the picture (decreasing towards the right edge).
   This is reversed when set to the − side.

[STATIC CONVERGENCE] (PA500U only)
This feature allows you to adjust for color deviation in the picture.
This can be adjusted in units of ± 1 pixel in the horizontal direction for HORIZONTAL R, G and B, in the vertical direction for VERTICAL R, G and B.

NOTE: This feature can only be set for the PA500U.
Disabling the Cabinet Buttons [CONTROL PANEL LOCK]

This option turns on or off the CONTROL PANEL LOCK function.

**NOTE:**
- This CONTROL PANEL LOCK does not affect the remote control functions.
- When the control panel is locked, pressing and holding the EXIT button on the projector cabinet for about 10 seconds will change the setting to [OFF].

**TIP:** When the [CONTROL PANEL LOCK] is turned on, a key lock icon [🔒] will be displayed at the bottom right of the menu.

Enabling Security [SECURITY]

This feature turns on or off the SECURITY function.

Unless the correct keyword is entered, the projector cannot project an image. (→ page 37)

**NOTE:** Your setting will not be affected even when [RESET] is done from the menu.

Selecting Communication Speed [COMMUNICATION SPEED]

This feature sets the baud rate of the PC Control port (D-Sub 9P). It supports data rates from 4800 to 115200 bps. The default is 38400 bps. Select the appropriate baud rate for your equipment to be connected (depending on the equipment, a lower baud rate may be recommended for long cable runs).

**NOTE:**
- Select [38400bps] or less when using the supplied software programs.
- Your selected communication speed will not be affected even when [RESET] is done from the menu.

Turning On or Off Remote Sensor [REMOTE SENSOR]

This option determines which remote sensor on the projector is enabled in wireless mode.

The options are: FRONT/BACK, FRONT, and BACK.

If the remote control system does not function when direct sunlight or strong illumination strikes the remote control sensor of the projector, change another option.

Setting ID to the Projector [CONTROL ID]

You can operate multiple projectors separately and independently with the single remote control that has the CONTROL ID function. If you assign the same ID to all the projectors, you can conveniently operate all the projectors together using the single remote control. To do so, you have to assign an ID number to each projector.

**CONTROL ID NUMBER.......Select a number from 1 to 254 you wish to assign to your projector.**

**CONTROL ID....................Select [OFF] to turn off the CONTROL ID setting and select [ON] to turn on the CONTROL ID setting.**
5. Using On-Screen Menu

NOTE:
• When [ON] is selected for [CONTROL ID], the projector cannot be operated by using the remote control that does not support the CONTROL ID function. (In this case the buttons on the projector cabinet can be used.)
• Your setting will not be affected even when [RESET] is done from the menu.
• Pressing and holding the ENTER button on the projector cabinet for 10 seconds will display the menu for canceling the Control ID.

Assigning or Changing the Control ID

1. Turn on the projector.

2. Press the ID SET button on the remote control.
   The CONTROL ID screen will be displayed.

   ![CONTROL ID Screen]

   If the projector can be operated with the current remote control ID, the [ACTIVE] will be displayed. If the projector cannot be operated with the current remote control ID, the [INACTIVE] will be displayed. To operate the inactive projector, assign the control ID used for the projector by using the following procedure (Step 3).

3. Press one of numeric keypad buttons while pressing and holding the ID SET button on the remote control.
   Example:
   To assign “3”, press the “3” button on the remote control.
   No ID means that all the projectors can be operated together with a single remote control. To set “No ID”, enter “000” or press the CLEAR button.

   TIP: The range of IDs is from 1 to 254.

4. Release the ID SET button.
   The updated CONTROL ID screen will be displayed.

NOTE:
• The IDs can be cleared in a few days after the batteries are run down or removed.
• Accidentally pressing any one of the buttons of the remote control will clear currently specified ID with batteries removed.
5. Using On-Screen Menu

[OPTIONS(1)]

Setting Auto Adjust [AUTO ADJUST]
This feature sets the Auto Adjust mode so that the computer signal can be automatically or manually adjusted for noise and stability. You can automatically make adjustment in two ways: [NORMAL] and [FINE].

OFF ....................... The computer signal will not be automatically adjusted. You can manually optimize the computer signal.
NORMAL ............... Default setting. The computer signal will be automatically adjusted. Normally select this option.
FINE ................. Select this option if fine adjustment is needed. It takes more time to switch to the source than when [NORMAL] is selected.

Selecting Fan Mode [FAN MODE]
Fan Mode is used to set the speed of the internal cooling fan.

MODE .................. Select three modes for fan speed: AUTO, HIGH, and HIGH ALTITUDE.
AUTO: The built-in fans automatically run at a variable speed according to the internal temperature.
HIGH: The built-in fans run at high speed.
HIGH ALTITUDE: The built-in fans run at a high speed. Select this option when using the projector at altitudes approximately 5500 feet/1600 meters or higher. To use the projector with ECO MODE ON in other installed conditions than desktop/ceiling with +/-20°, heed the following:
(1) Select [HIGH ALTITUDE] for [MODE] at altitude 3200 feet/1000 meters.
(2) Select [OFF] for [ECO MODE] at altitude 6800 feet/2100 meters or higher.

SETTING ............... Select either [NORMAL] or [VERTICAL TILT UP] according to the installation angle of the projector. Select [VERTICAL TILT UP] for angles of range from 60° to 120° indicated in gray. Select [NORMAL] for the other angle ranges.

Restrictions for using the projector in ECO MODE at high altitudes:
The projector should not be installed in any way other than the setting described in the table, otherwise lamp life could decrease dramatically.

<table>
<thead>
<tr>
<th>Orientation</th>
<th>ECO MODE</th>
<th>OFF</th>
<th>ON</th>
</tr>
</thead>
<tbody>
<tr>
<td>All orientations</td>
<td>NORMAL/VERTICAL TILT UP</td>
<td>NORMAL/VERTICAL TILT UP</td>
<td>VERTICAL TILT UP</td>
</tr>
<tr>
<td>1000 m or lower</td>
<td>3200 ft or lower AUTO</td>
<td>AUTO</td>
<td>AUTO</td>
</tr>
<tr>
<td>1000 to 1600 m</td>
<td>3200 to 5200 ft HIGH ALTITUDE</td>
<td>HIGH ALTITUDE</td>
<td>Not available</td>
</tr>
<tr>
<td>1600 to 2100 m</td>
<td>5200 to 6800 ft</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2100 to 2600 m</td>
<td>6800 to 8500 ft</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

When you wish to cool down the temperature inside the projector quickly, select [HIGH].
5. Using On-Screen Menu

NOTE:
• When [HIGH ALTITUDE] is selected for [FAN MODE], a symbol icon will be displayed at the bottom of the menu.
• It is recommended that you select High speed mode if you use the projector non-stop for consecutive days.
• Set [FAN MODE] to [HIGH ALTITUDE] when using the projector at altitudes approximately 5500 feet/1600 meters or higher.
• Using the projector at altitudes approximately 5500 feet/1600 meters or higher without setting to [HIGH ALTITUDE] can cause the projector to overheat and the protector could shut down. If this happens, wait a couple minutes and turn on the projector.
• Using the projector at altitudes less than approximately 5500 feet/1600 meters and setting to [HIGH ALTITUDE] can cause the lamp to overcool, causing the image to flicker. Switch [FAN MODE] to [AUTO].
• Using the projector at altitudes approximately 5500 feet/1600 meters or higher can shorten the life of optical components such as the lamp.
• Your setting will not be affected even when [RESET] is done from the menu.

Selecting the Signal Format [SIGNAL SELECT(COMP3)]
When an output device is connected to the COMPUTER 3 video input connectors, this sets the input signal.

RGB/COMPONENT. RGB and component signals are identified automatically.

VIDEO ................. This switches to the video signal.

NOTE: When a video cable (commercially available) is connected to the COMPUTER 3 video input connectors’ G/Y connector, video signals can be projected. In this case, set to “VIDEO”.

[SEAMLESS SWITCHING] (PA500U only)
When the input connector is switched, the image displayed before switching is held to switch to the new image without a break due to absence of a signal.

NOTE: This feature can only be set for the PA500U.

(COLOR SYSTEM)
This feature allows you to select the TV video signal, which differs from country to country (NTSC, PAL, etc.). This is set to [AUTO] by factory default. Set this if the projector cannot identify the signal automatically.

(DIGITAL AUDIO SELECT)
This feature allows you to select the audio inputs for the projector’s HDMI and DisplayPort input connectors.

HDMI ................. HDMI: Selects the HDMI input connector’s digital audio.

COMPUTER2: Selects the COMPUTER2 audio input connector.

DisplayPort ........ DisplayPort: Selects the DisplayPort input connector’s digital audio.

COMPUTER2: Selects the COMPUTER2 audio input connector.

Enabling Key Sound and Error Sound [BEEP]
This feature turns on or off the button sound or alarm when an error occurs or the following operations are performed.

• Displaying the main menu
• Switching sources
• Resetting data by using [RESET]
• Pressing POWER ON or POWER OFF button
5. Using On-Screen Menu

Selecting Power-saving in [STANDBY MODE]
The projector has three standby modes: [NORMAL], [POWER-SAVING] and [NETWORK STANDBY].
The POWER-SAVING mode is the mode that allows you to put the projector in the power-saving condition which consumes less power than the NORMAL mode. The projector is preset for NORMAL mode at the factory.

<table>
<thead>
<tr>
<th>Normal</th>
<th>Power Indicator: Orange light/STATUS Indicator: Green light</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power-Saving</td>
<td>Power Indicator: Red light/STATUS Indicator: Off</td>
</tr>
</tbody>
</table>

The following connectors, buttons or functions will not work during this mode:
- MONITOR OUT (COMP. 1) connector, and AUDIO OUT connector
- LAN and Mail Alert functions
- Buttons other than POWER button on the cabinet
- Buttons other than POWER ON button on the remote control
- Virtual Remote Tool function

When in the standby mode, the following connectors, buttons or functions will not work:
- MONITOR OUT (COMP. 1) connector, and AUDIO OUT mini jack
- Wireless LAN Unit
- [AUTO POWER ON (COMP1/3)]
- Buttons other than POWER button on the cabinet
- Buttons other than POWER ON button on the remote control
- PC control commands for other than power-on

Important:
- When [CONTROL PANEL LOCK] or [CONTROL ID] is turned on, or when [COMPUTER 1] or [COMPUTER 3] is selected for [AUTO POWER ON (COMP1/3)], the [STANDBY MODE] setting becomes invalid.
  This means that the projector is in the same condition when the [NORMAL] is selected for [STANDBY MODE].

NOTE:
- Even when [POWER-SAVING] is selected for [STANDBY MODE], power on or off can be done by using the PC CONTROL port.
- The power consumption in the standby mode will not be included in calculating CO₂ emission reduction.
- Your setting will not be affected even when [RESET] is done from the menu.

Enabling Direct Power On [DIRECT POWER ON]
Turns the projector on automatically when the power cord is inserted into an active power outlet. This eliminates the need to always use the POWER button on the remote control or projector cabinet.
5. Using On-Screen Menu

Turning On the Projector By Applying Computer Signal [AUTO POWER ON(COMP1/3)]

When the projector is in Standby mode, applying a computer signal from a computer connected to the COMPUTER1 IN or COMPUTER3 IN input will power on the projector and simultaneously project the computer's image. This functionality eliminates the need to always use the POWER button on the remote control or the projector cabinet to power on the projector.

To use this function, first connect a computer to the projector and the projector to an active AC input.

NOTE:
• Disconnecting a computer signal from the computer will not power off the projector. We recommend using this function in combination of the AUTO POWER OFF function.
• This function will not be available under the following conditions:
  - when a component signal is applied to the COMPUTER1 IN or COMPUTER3 IN connector
  - when a Sync on Green RGB signal or composite sync signal is applied
• When [AUTO POWER ON(COMP1/3)] is set, the [STANDBY MODE] setting becomes invalid. This means that the projector is in the same condition when the [NORMAL] is selected for [STANDBY MODE].
• To enable the AUTO POWER ON (COMP1/3) after turning off the projector, wait 3 seconds and input a computer signal. If a computer signal is still present when the projector is turned off, the AUTO POWER ON (COMP1/3) will not work and the projector remains in standby mode.

Enabling Power Management [AUTO POWER OFF]

When this option is selected you can enable the projector to automatically turn off (at the selected time: 5min., 10min., 20min., 30min.) if there is no signal received by any input or if no operation is performed.

NOTE:
• The [AUTO POWER OFF] function will not work when [VIEWER] or [NETWORK] is selected for [SOURCE].

Selecting Default Source [DEFAULT SOURCE SELECT]

You can set the projector to default to any one of its inputs each time the projector is turned on.

LAST .................. Sets the projector to default to the previous or last active input each time the projector is turned on.
AUTO ................. Searches for an active source in order of COMPUTER1 → COMPUTER2 → COMPUTER3 → HDMI → DisplayPort → VIDEO → S-VIDEO → VIEWER → COMPUTER1 and displays the first found source.
COMPUTER1 ........... Displays the computer signal from the COMPUTER 1 IN connector every time the projector is turned on.
COMPUTER2 ........... Displays the computer signal from the COMPUTER 2 IN connector every time the projector is turned on.
COMPUTER3 ........... Displays the computer signal from the COMPUTER 3 IN connector every time the projector is turned on.
HDMI ...................... Displays the digital source from the HDMI IN connector every time the projector is turned on.
DisplayPort ............. Displays the digital source from the DisplayPort every time the projector is turned on.
VIDEO .................... Displays the Video source from the VIDEO IN connector every time the projector is turned on.
S-VIDEO ................. Displays the Video source from the S-VIDEO IN connector every time the projector is turned on.
VIEWER ................. Displays slides or plays back movie files from the USB memory device every time the projector is turned on.
NETWORK ............... Displays the data sent from the computer via the LAN port (RJ-45) or the wireless LAN unit (sold separately) mounted on the projector is projected.
Menu Descriptions & Functions [INFO.]
Displays the status of the current signal and lamp usage. This item has nine pages. The information included is as follows:

TIP: Pressing the HELP button on the remote control will show the [INFO.] menu items.

[USAGE TIME]

[LAMP LIFE REMAINING] (%)*  
[LAMP HOURS USED] (H)  
[FILTER HOURS USED] (H)  
[TOTAL CARBON SAVINGS] (kg-CO2)

* The progress indicator shows the percentage of remaining bulb life. The value informs you of the amount of lamp usage. When the remaining lamp time reaches 0, the LAMP LIFE REMAINING bar indicator changes from 0% to 100 Hours and starts counting down. If the remaining lamp time reaches 0 hours, the projector will not turn on.

The message to the effect that the lamp or the filters should be replaced will be displayed for one minute when the projector is turned on and when the POWER button on the projector or the remote control is pressed. To dismiss this message, press any button on the projector or the remote control.

<table>
<thead>
<tr>
<th>Lamp life(H)</th>
<th>Replacement lamp</th>
</tr>
</thead>
<tbody>
<tr>
<td>ECO MODE</td>
<td></td>
</tr>
<tr>
<td>NORMAL (OFF)</td>
<td>NP21LP</td>
</tr>
<tr>
<td>3000</td>
<td></td>
</tr>
</tbody>
</table>

[TOTAL CARBON SAVINGS]
This displays the estimated carbon saving information in kg. The carbon footprint factor in the carbon saving calculation is based on the OECD (2008 Edition). (→ page 29)
5. Using On-Screen Menu

### [SOURCE(1)]

<table>
<thead>
<tr>
<th>Source</th>
<th>Adjust</th>
<th>Setup</th>
<th>INFO</th>
<th>Reset</th>
</tr>
</thead>
<tbody>
<tr>
<td>USAGE TIME</td>
<td>SOURCE(1)</td>
<td>SOURCE(2)</td>
<td>(1/3)</td>
<td></td>
</tr>
</tbody>
</table>

- **INPUT TERMINAL**: COMPUTER1
- **RESOLUTION**: 1024x768
- **HORIZONTAL FREQUENCY**: 48.58[kHz]
- **VERTICAL FREQUENCY**: 62.13[Hz]
- **SYNC TYPE**: SEPARATE SYNC
- **SYNC POLARITY**: H(-) V(-)
- **SCAN TYPE**: NON-INTERLACE
- **SOURCE NAME**: 1024x768
- **ENTRY NO.**: 1

### [SOURCE(2)]

<table>
<thead>
<tr>
<th>Source</th>
<th>Adjust</th>
<th>Setup</th>
<th>INFO</th>
<th>Reset</th>
</tr>
</thead>
<tbody>
<tr>
<td>USAGE TIME</td>
<td>SOURCE(1)</td>
<td>SOURCE(2)</td>
<td>(1/3)</td>
<td></td>
</tr>
</tbody>
</table>

- **SIGNAL TYPE**: RGB
- **VIDEO TYPE**: NTSC
- **BIT DEPTH**: 6[bits]
- **VIDEO LEVEL**: FULL
- **LINK RATE**: 2.7[GBps]
- **LINK LANE**: 1[lane]

### [WIRED LAN]

<table>
<thead>
<tr>
<th>Source</th>
<th>Adjust</th>
<th>Setup</th>
<th>INFO</th>
<th>Reset</th>
</tr>
</thead>
<tbody>
<tr>
<td>USAGE TIME</td>
<td>WIRED LAN</td>
<td>WIRELESS LAN(1)</td>
<td>WIRELESS LAN(2)</td>
<td>(2/3)</td>
</tr>
</tbody>
</table>

- **IP ADDRESS**: 192.168.1.11
- **SUBNET MASK**: 255.255.255.0
- **GATEWAY**: 192.168.1.1
- **MAC ADDRESS**: 00:01:02:03:04:05

### INPUT TERMINAL

- **RESOLUTION**: VERTICAL FREQUENCY
- **SYNC POLARITY**: SOURCE NAME

### [SOURCE(2)]

- **VIDEO TYPE**: VIDEO LEVEL
- **LINK LANE**: LINK LANE
5. Using On-Screen Menu

[**WIRELESS LAN(1)**]

<table>
<thead>
<tr>
<th>SOURCE</th>
<th>ADJUST</th>
<th>SETUP</th>
<th>INFO</th>
<th>RESET</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**IP ADDRESS**
192.168.1.11

**SUBNET MASK**
255.255.255.0

**GATEWAY**
192.168.1.1

**MAC ADDRESS**
00:08:00:00:00:00

[**WIRELESS LAN(2)**]

<table>
<thead>
<tr>
<th>SOURCE</th>
<th>ADJUST</th>
<th>SETUP</th>
<th>INFO</th>
<th>RESET</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**SSID**

**NETWORK TYPE**
EASY CONNECTION

**WEP/WPA**
OFF

**CHANNEL**
5

**SIGNAL LEVEL**
---

[**VERSION(1)**]

<table>
<thead>
<tr>
<th>SOURCE</th>
<th>ADJUST</th>
<th>SETUP</th>
<th>INFO</th>
<th>RESET</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**FIRMWARE**
1.00

**DATA**
1.00

**FIRMWARE2**
1.00

**SUB-CPU**
1.00
### 5. Using On-Screen Menu

#### [VERSION(2)]

<table>
<thead>
<tr>
<th>SOURCE</th>
<th>ADJUST</th>
<th>SETUP</th>
<th>INFO.</th>
<th>RESET</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>[VERSION(1) + VERSION(2) + OTHERS]</td>
<td>(3/3)</td>
</tr>
</tbody>
</table>

FIRMWARE3 1.00

#### [OTHERS]

<table>
<thead>
<tr>
<th>SOURCE</th>
<th>ADJUST</th>
<th>SETUP</th>
<th>INFO.</th>
<th>RESET</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>[VERSION(1) + VERSION(2) + OTHERS]</td>
<td>(3/3)</td>
</tr>
</tbody>
</table>

- PROJECTOR NAME: PA600X Series
- MODEL NO.: NP-PA600X
- SERIAL NUMBER: 
- LAN UNIT TYPE: 

CONTROL ID (when [CONTROL ID] is set)
Menu Descriptions & Functions [RESET]

Returning to Factory Default [RESET]
The RESET feature allows you to change adjustments and settings to the factory preset for a (all) source(s) except the following:

[CURRENT SIGNAL]
Resets the adjustments for the current signal to the factory preset levels.
The items that can be reset are: [PRESET], [CONTRAST], [BRIGHTNESS], [COLOR], [HUE], [SHARPNESS], [ASPECT RATIO], [HORIZONTAL], [VERTICAL], [CLOCK], [PHASE], and [OVERSCAN].

[ALL DATA]
Reset all the adjustments and settings for all the signals to the factory preset.
All items can be reset EXCEPT [LANGUAGE], [BACKGROUND], [FILTER MESSAGE], [SCREEN], [GEOMETRIC CORRECTION], [MULTI-SCREEN COMP.], [REF.WHTE BALANCE], [STATIC CONVERGENCE], [CONTROL PANEL LOCK], [SECURITY], [COMMUNICATION SPEED], [CONTROL ID], [STANDBY MODE], [FAN MODE], [LAMP LIFE REMAINING], [LAMP HOURS USED], [FILTER HOURS USED], [TOTAL CARBON SAVINGS], [WIRED LAN], and [WIRELESS LAN].
To reset the lamp usage time, see “Clearing Lamp Hour Meter [CLEAR LAMP HOURS]” below.

[ALL DATA (INCLUDING ENTRY LIST)]
Reset all the adjustments and settings for all the signals to the factory preset except [LANGUAGE], [BACKGROUND], [FILTER MESSAGE], [SCREEN], [MULTI-SCREEN COMP.], [REF.WHTE BALANCE], [STATIC CONVERGENCE], [CONTROL PANEL LOCK], [SEAMLESS SWITCHING], [SECURITY SETTINGS], [COMMUNICATION SPEED], [CONTROL ID], [FAN MODE], [LAMP LIFE REMAINING], [LAMP HOURS USED], [FILTER HOURS USED], [TOTAL CARBON SAVINGS], [WIRED LAN], and [WIRELESS LAN].
Also deletes all the signals in the [ENTRY LIST] and returns to the factory preset.

NOTE: Locked signals in Entry List cannot be reset.

Clearing Lamp Hour Meter [CLEAR LAMP HOURS]
Resets the lamp clock back to zero. Selecting this option displays submenu for a confirmation. Select [YES] and press the ENTER button.

NOTE: Elapsed time of the lamp use will not be affected even when [RESET] is done from the menu.

NOTE: The projector will turn off and go into standby mode when you continue to use the projector for another 100 hours after the lamp has reached the end of its life. In this condition you cannot clear the lamp hour meter on the menu. If this happens, press the HELP button on the remote control for 10 seconds to reset the lamp clock back to zero. Do this only after replacing the lamp.
5. Using On-Screen Menu

Clearing the Filter Usage Hours [CLEAR FILTER HOURS]
Resets the filter usage back to zero. Selecting this option displays submenu for a confirmation. Select [YES] and press the ENTER button.

The [OFF] item is selected for [FILTER MESSAGE] at the time of shipment. When [OFF] is selected, you do not need to clear the filter usage hour.

**NOTE:** Elapsed time of the filter use will not be affected even when [RESET] is done from the menu.
9 Application Menu

When [NETWORK] is selected from the [SOURCE] menu, the application menu [APPLICATION MENU] will be displayed. The application menu allows you to set up the User Supportware, Network Settings (NETWORK SETTINGS) and Tools (TOOLS).

The User Supportware is contained on the supplied NEC Projector CD-ROM. In [ADMINISTRATOR MODE], either [ADVANCED] menu or [BASIC] menu can be selected. (→ page 136)

The [BASIC] menu contains minimum essentials of menus and commands.

**IMAGE EXPRESS UTILITY**

This shows information for projector name, resolution, and network (wired/wireless) which are required to use Image Express Utility. Use this information to set up for your computer.

**DESKTOP CONTROL UTILITY**

This allows you to set up for password entry/deletion, computer searching and IP address on network (wired/wireless) which are required to use Desktop Control Utility.
NETWORK PROJECTOR
This shows information for projector name, resolution, and network (wired/wireless) which are required to use Network Projector. Use this information to set up for your computer.

REMOTE DESKTOP CONNECTION
This allows you to set up for computer name entry and effects for Remote Desktop.

NOTE:
• A USB keyboard is required to set up the Remote Desktop Connection.
NETWORK SETTINGS

**Important:**
- Consult with your network administrator about these settings.
- When using a wired LAN connection, connect a LAN cable (Ethernet cable) to the LAN port (RJ-45) of the projector. (→ page 150)

**TIP:** The network settings you make will not be affected even when [RESET] is done from the menu.

**Hints on How to Set Up LAN Connection**

To set up the projector for a LAN connection:
Select [WIRED LAN] or [WIRELESS LAN] → [PROFILES] → [PROFILE 1] or [PROFILE 2].
Two settings can be set for wired or wireless LAN.
Next turn on or off for [DHCP], [IP ADDRESS], [SUBNET MASK], and [GATEWAY] and select [OK] and press the ENTER button. (→ page 121)

To recall LAN settings stored in the profile number:
Select [PROFILE 1] or [PROFILE 2] for wired or wireless LAN, and then select [OK] and press the ENTER button. (→ page 121)

To connect a DHCP server:
Turn on [DHCP] for wired or wireless LAN. Select [ON] and press the ENTER button. To specify IP address without using the DHCP server, turn off [DHCP], (→ page 122)

To set only for wireless LAN (NETWORK TYPE and WEP/WPA):
Select [PROFILE 1] or [PROFILE 2] for wireless LAN, and then select [ADVANCED] and [OK] and press the ENTER button. The Advanced menu will be displayed. (→ page 123)

To select an SSID:
Select [ADVANCED] → [SITE SURVEY] and press the ENTER button.
Select an SSID and press the > button to select [OK] and press the ENTER button.
If you do not use [SITE SURVEY], type the SSID and select [INFRASTRUCTURE] or [AD HOC]. (→ page 123)

To receive lamp replacement time or error messages via e-mail:
Select [ALERT MAIL], and set [SENDER'S ADDRESS], [SMTP SERVER NAME], and [RECIPIENT'S ADDRESS].
Last, select [OK] and press the ENTER button. (→ page 134)

To execute [EASY CONNECTION] using Image Express Utility 2.0 or Image Express Utility 2 for Mac:
The [EASY CONNECTION] is a mode that can abbreviate the troublesome LAN settings when using the Image Express Utility and connecting the PC and projector via a wireless LAN.
The Image Express Utility Lite, Image Express Utility 2.0, and Image Express Utility 2 for Mac are contained on the supplied NEC Projector CD-ROM.
To use [EASY CONNECTION], select [WIRELESS LAN] → [PROFILES] → [EASY CONNECTION].

NOTE: The [EASY CONNECTION] function is available on Windows 7, Windows Vista or Windows XP SP3.
5. Using On-Screen Menu

WIRED LAN or WIRELESS LAN (ADVANCED menu only)

* To use the wireless LAN functions, connect a separately sold wireless LAN unit to the projector. (→ page 151)

PROFILES

- Up to two settings for the LAN port or USB wireless LAN unit can be stored in memory of the projector. Total of four settings can be stored.
  Five settings can be stored: two for the built-in LAN port, two for wireless LAN and one for WPS.
- Select [PROFILE 1] or [PROFILE 2] and then do settings for [DHCP] and the other options.
  After doing this, select [OK] and press the ENTER button. This will store your settings in memory.
- To recall the settings from memory:
  After selecting [PROFILE 1] or [PROFILE 2] from the [FILES] list.
  Select [OK] and press the ENTER button.
- To execute [EASY CONNECTION] using Image Express Utility 2.0 or Image Express Utility 2 for Mac, select [WIRELESS LAN] → [PROFILE] → [EASY CONNECTION].
- To stop emitting radio waves from the USB Wireless LAN Unit, select [DISABLE] from the [PROFILE] list.
- Selecting [SIMPLE ACCESS POINT] will allow the projector to create an infrastructure network.
  An SSID will be automatically created.
  When the IP address of the projector is changed, it will automatically take effect in one or two minutes.
  Select “Obtain an IP Address Automatically” to set the IP address of a connected computer.
  It takes a few seconds for a change of your computer’s IP address to come into effect in Windows 7/Windows Vista while it takes one or two minutes in Window XP.
  When you connect with your computer to save your profile and select “Automatically connect when within range” from the Properties tab of Wireless Network in Windows for your selected profile, your wireless LAN will be accessed under the following conditions:
  - at the time of turning on the computer or the projector
  - when the notebook type is within the range of the projector’s wireless LAN can be achieved.
  Data transmission between wireless LAN and wired LAN is not possible.
  When the [SIMPLE ACCESS POINT] mode is used to send images, it is recommended to connect to only one computer.
5. Using On-Screen Menu

- When selecting [WPS], the network will be connected by using settings stored automatically with the WPS function. Selecting [WPS] will allow the projector to access the network by using the settings the WPS function automatically stored.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>DHCP</td>
<td>Place a check mark to automatically assign an IP address to the projector from your DHCP server. Clear this check box to register the IP address or subnet mask number obtained from your network administrator.</td>
<td>Up to 12</td>
</tr>
<tr>
<td>IP ADDRESS</td>
<td>Set your IP address of the network connected to the projector when [DHCP] is turned off.</td>
<td>numeric</td>
</tr>
<tr>
<td>SUBNET MASK</td>
<td>Set your subnet mask number of the network connected to the projector when [DHCP] is turned off.</td>
<td>numeric</td>
</tr>
<tr>
<td>GATEWAY</td>
<td>Set the default gateway of the network connected to the projector when [DHCP] is turned off.</td>
<td>numeric</td>
</tr>
<tr>
<td>WNS CONFIGURATION</td>
<td>Set the IP address of your WINS server of the network connected to the projector when [DHCP] is turned off.</td>
<td>numeric</td>
</tr>
<tr>
<td>AUTO DNS</td>
<td>Place a check mark to automatically assign the IP address of your DNS server connected to the projector from your DHCP server. Clear this check box to set the IP address of your DNS server connected to the projector.</td>
<td>numeric</td>
</tr>
<tr>
<td>DNS CONFIGURATION</td>
<td>Set the IP address of your DNS server on the network connected to the projector when [AUTO DNS] is cleared.</td>
<td>numeric</td>
</tr>
<tr>
<td>ADVANCED*</td>
<td>This menu allows you to set various items for your wireless LAN connection (network type, security).</td>
<td></td>
</tr>
<tr>
<td>RECONNECT</td>
<td>Retry to connect the projector to a network. Try this if you have changed [PROFILES].</td>
<td></td>
</tr>
</tbody>
</table>

* The [ADVANCED] setting screen is available for [WIRELESS LAN] only.

NOTE:
- If you select [EASY CONNECTION] from [PROFILES], you cannot make settings to DHCP and its following items except [CHANNEL] in [ADVANCED].

Advanced Settings (settings only required when using a separately sold wireless LAN unit) (ADVANCED menu only)
### 5. Using On-Screen Menu

#### SITE SURVEY
Displays a list of available SSIDs for wireless LAN on site. Select an SSID which you can access.

To select an SSID, highlight [SSID] and use the ▶ to select [OK] and press the ENTER button.

- ................. Wireless access point
- ................. Ad Hoc PC
- .................. WEP or WPA enabled

#### SECURITY
This will turn on or off the encryption mode for secure transmission.

To use encryption, specify a WEP key or encryption key. Select your security type appropriate for your computer and the wireless LAN unit.

- DISABLE ................. Will not turn on the encryption feature. Your communications may be monitored by someone.
- WEP(64bit) ............ Uses 64-bit datalength for secure transmission.
- WEP(128bit) ............ Uses 128-bit datalength for secure transmission. This option will increase privacy and security when compared to use of 64-bit datalength encryption.
- WPA-PSK/WPA2-PSK/WPA-EAP/WPA2-EAP  ................. These options provide stronger security than WEP.

**NOTE:**
- The security type, WEP key, and encryption key settings must be the same as communication devices such as PC or access point in your wireless network.
- When you use [SECURITY], your image transmission speed will slow down.
- [WPA-PSK], [WPA-EAP], [WPA2-PSK] and [WPA2-EAP] are not available when [AD HOC] is selected from [NETWORK TYPE].

#### SSID
Enter an identifier (SSID) for wireless LAN. Communication can be done only with equipment whose SSID matches SSID for your wireless LAN.

**Up to 32 alphanumeric characters (case sensitive).**

#### NETWORK TYPE
Select communication method when using wireless LAN.

- INFRASTRUCTURE...Select this option when communicating with one or more equipment connected to the wireless or wired LAN network via a wireless access point.
- AD HOC .................. Select this option when using the wireless LAN to directly communicate with a computer in peer-to-peer mode.

#### CHANNEL
Select a channel. Available channels vary depending on the country and region. When you select [INFRASTRUCTURE], make sure that the projector and your access point are on the same channel; when you select [AD HOC], make sure that the projector and your computer are on the same channel.
When [WEP(64bit)] or [WEP(128bit)] is selected for [SECURITY TYPE]

**KEY SELECT**
Selects one WEP key from the four keys below.

**KEY1, KEY2, KEY3, KEY4**
Enter a WEP key.

- **Maximum number of characters**

<table>
<thead>
<tr>
<th>Option</th>
<th>Alphanumeric (ASCII)</th>
<th>Hexadecimal (HEX)</th>
</tr>
</thead>
<tbody>
<tr>
<td>WEP 64bit</td>
<td>5</td>
<td>10</td>
</tr>
<tr>
<td>WEP 128bit</td>
<td>13</td>
<td>26</td>
</tr>
</tbody>
</table>

When [WPA-PSK], [WPA-EAP], [WPA2-PSK], or [WPA2-EAP] is selected for [SECURITY TYPE]

<table>
<thead>
<tr>
<th><strong>ENCRIPTION TYPE</strong></th>
<th>Select [TKIP] or [AES].</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>KEY</strong></td>
<td>Enter encryption key. Key length must be 8 or greater and 63 or less.</td>
</tr>
</tbody>
</table>
[AUTHENTICATION] (required for wireless only)
Setting is required for using WPA-EAP or WPA2-EAP.

Preparation before setting
Select a wireless LAN compliant WPA-EAP or WPA2-EAP authentication and install a digital certificate on the projector.

1. Set [DATE AND TIME] on the projector. (→ page 140)
2. Use a computer to save digital certificates (files) for WPA-EAP or WPA2-EAP setting to your USB memory device.
   After completing saving the file, remove the USB memory device from the computer.

Important:
• The file formats of digital certificate that are supported by the projector are DER and PKCS#12 only.
• The projector cannot handle any digital certificate whose file size exceeds 8 KB.
• CRL (Certificate Relocation List) is not supported.
• Client certificate chain is not supported.

3. Plug the USB memory device into the USB port of the projector.

Setting Procedures
1. Select [NETWORK SETTINGS] → [WIRELESSSS LAN].

2. Set items such as PROFILES, DHCP, IP ADDRESS, SUBNET MASK and others as required.
   • Select [PROFILE 1] or [PROFILE 2] for [PROFILES]. If [EASY CONNECTION] is selected, WPA-PSK, WPA2-PSK, WPA-EAP, or WPA2-EAP is not available.
3. Select [ADVANCED] and press the ENTER button.
   The [ADVANCED] setting screen will be displayed.
4. Select [SITE SURVEY] and press the ENTER button.

![Image]

The "SSID" list will be displayed.

5. Select a connecting SSID, and then select [OK].

![Image]

Finally press the ENTER button.

- Select the SSID for which WPA-PSK or WPA2-PSK is set.
- Select [INFRASTRUCTURE ( )] for [NETWORK TYPE]. WPA-PSK, WPA2-PSK, WPA-EAP, or WPA2-EAP is not available when [AD HOC ( )] is selected.


The [SECURITY] page will be displayed.

7. Select the [SECURITY TYPE] field and press the ENTER button.

![Image]

The pull-down list will be displayed.

8. Select [WPA-EAP] or [WPA2-EAP] and press the ENTER button.

9. Select the [TKIP/AES] field and press the ENTER button.

![Image]

The pull-down list will be displayed.

10. Select [TKIP] or [AES] and press the ENTER button.

Select [TKIP] or [AES] according to the setting for your access point.
11. Select the [AUTHENTICATION] tab.

![AUTHENTICATION menu](image)

The [AUTHENTICATION] page will be displayed.

Select either [EAP-TLS] or [PEAP-MSCHAPv2] for [EAP TYPE]. The setting items vary depending on the EAP type.

See the table below.

<table>
<thead>
<tr>
<th>EAP Type</th>
<th>Setting Item</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>EAP-TLS</td>
<td>User Name</td>
<td>1 character or more and 32 characters or less</td>
</tr>
<tr>
<td></td>
<td>Client Certificate</td>
<td>PKCS#12 format file</td>
</tr>
<tr>
<td></td>
<td>CA Certificate</td>
<td>DER format file</td>
</tr>
<tr>
<td></td>
<td>(Certificate authority's certificate)</td>
<td></td>
</tr>
<tr>
<td>PEAP-MSCHAPv2</td>
<td>User Name</td>
<td>1 character or more and 32 characters or less</td>
</tr>
<tr>
<td></td>
<td>Password</td>
<td>1 character or more and 32 characters or less</td>
</tr>
<tr>
<td></td>
<td>CA Certificate</td>
<td>DER format file</td>
</tr>
<tr>
<td></td>
<td>(Certificate authority's certificate)</td>
<td></td>
</tr>
</tbody>
</table>

① Selecting [EAP-TLS] for [EAP TYPE]:

The following section explains the operation for selecting [EAP-TLS].

For selecting [PEAP-MSCHAPv2], go on to Step 12 on page 129.

12. Select the [USER NAME] field and press the ENTER button.

![USER NAME input](image)

The character entry screen (software keyboard) will be displayed. Set a user name.

- A user name must be 1 character or more and 32 characters or less.

(→ page 131)
13. Select [CLIENT CERTIFICATE] and press the ENTER button.

A list of files (thumbnail screen) will be displayed.
- For operating the thumbnail screen, see “4. Using the Viewer” in the “User’s Manual” (PDF).
- To return to the [AUTHENTICATION] page, press the EXIT button.

NOTE:
Installing a digital certificate
You can install each digital certificate (client certificate and CA certificate) for [PROFILE 1 (or 2)] on a file-by-file basis.
- Install a root CA certificate for a CA certificate.
- If you install a digital certificate over your existing digital certificate, the existing digital certificate will be overwritten with the new digital certificate.
- Once a digital certificate has been installed, its information cannot be deleted even if you stop setting WPA-EAP or WPA2-EAP.

14. On the thumbnail screen, select a digital certificate (PKCS#12 format file) saved in your USB memory device and press the ENTER button.

The password screen will be displayed.

15. Select [PASSWORD] field and press the ENTER button.

The character entry screen (software keyboard) will be displayed. Set the password of the private key. A password must be 1 character or more and 32 characters or less.
The selected digital certificate file will be installed on the projector.
- When the root CA certificate is not included in the file that was selected in Step 14, proceed to Step 16. When the root certification authority certificate is included, proceed to Step 18.

16. Select [CA CERTIFICATE] and press the ENTER button.
The drive list screen will be displayed.
17. On the thumbnail screen, select a digital certificate (DER format file) saved in your USB memory device and press the ENTER button.
   • Select your root CA certificate here.
   The selected digital certificate will be installed on the projector.

18. After completing required settings, select [OK] and press the ENTER button.
   The [WIRELESS] page will be returned.

19. Select [RECONNECT] and press the ENTER button.

20. Select [OK] and press the ENTER button.

This will complete setting [EAP-TLS] for [EAP TYPE] in [WPA-EAP] or [WPA2-EAP].

**TIP:**

**Clearing the digital certificate that is installed on the projector**

To clear the digital certificate installed on the projector, follow the steps below.
By doing the following procedure, all the digital certificates for the currently displayed profile will be cleared.

1. Select [CLEAR CERTIFICATES] in the bottom left of the [ADVANCED] setting screen and press the ENTER button.
   A message for confirmation will be displayed.
2. Select [YES] and press the ENTER button.
   The digital certificates will be cleared.

**TIP:**

• The PKCS#12 format digital certificate including a CA certificate will be installed as a root CA certificate.

② Selecting [PEAP-MSCHAPv2] for [EAP TYPE]:

12. From the [AUTHENTICATION] page, select [EAP TYPE] field and press the ENTER button.

   The pull-down list will be displayed.

13. Select [PEAP-MSCHAPv2] and press the ENTER button.

14. Select [USER NAME] field and press the ENTER button.
   The character entry screen (software keyboard) will be displayed. Set a user name.
   • A user name must be 32 characters or less.
   (√ page 131)
5. Using On-Screen Menu

15. After completing setting a user name, select the [PASSWORD] field and press the ENTER button.

The character entry screen (software keyboard) will be displayed. Set a password.

- A password must be 32 characters or less.

16. After completing setting the password, select [CA CERTIFICATE] field and press the ENTER button.

The drive list screen will be displayed.

- For operating the thumbnail screen, see “4. Using the Viewer” in the “User’s Manual” (PDF).
- To return to the [AUTHENTICATION] page, press the EXIT button.

NOTE:
Installing a digital certificate
You can install each digital certificate (client certificate and CA certificate) for [PROFILE 1 (or 2)] on a file-by-file basis.

- Install a root CA certificate for a CA certificate.
- If you install a digital certificate over your existing digital certificate, the existing digital certificate will be overwritten with the new digital certificate.
- Once a digital certificate has been installed, its information cannot be deleted even if you stop setting WPA-EAP or WPA2-EAP.

17. On the thumbnail screen, select a digital certificate (DER format file) saved in your USB memory device and press the ENTER button.

- Select your root CA certificate here.
  The selected digital certificate will be installed on the projector.
5. Using On-Screen Menu

18. After completing required settings, select [OK] and press the ENTER button.
   The [WIRELESS] page will be returned.
19. Select [RECONNECT] and press the ENTER button.
20. Select [OK] and press the ENTER button.

This will complete setting [PEAP-MSCHAPv2] for [EAP TYPE] in [WPA-EAP] or [WPA2-EAP].

TIP:

Clearing the digital certificate that is installed on the projector
To clear the digital certificate installed on the projector, follow the steps below.
By doing the following procedure, all the digital certificates for the currently displayed profile will be cleared.
1. Select [CLEAR CERTIFICATES] in the bottom left of the [ADVANCED] setting screen and press the ENTER button.
   A message for confirmation will be displayed.
2. Select [YES] and press the ENTER button.
   The digital certificates will be cleared.

TIP:

Entering WEP keys (Switching between Alphanumeric characters and hexadecimal)
To enter from [KEY1] to [KEY4], do the following:
1. Select one of [KEY 1], [KEY 2], [KEY 3] and [KEY 4] and press the ENTER button.
   The character entry screen (software keyboard) will be displayed.

2. Use the ▼, ▲, ◀, or ► button to select a character and press the ENTER button.
   • To enter a WEP key or passphrase, use alphanumeric characters (ASCII) or hexadecimal (HEX). To enter a PSK key, use alphanumeric characters (ASCII).
   • Press the [HEX] button to change to [ASCII] to set the key in ASCII digit. You can toggle this button between [ASCII] and [HEX].
   • Enter 0x(numeral and alphabet respectively) right in front of your key code.
   • Hexadecimal uses 0 to 9 and A to F.
3. After entering your WEP key or passphrase, use the ▼, ▲, ◀, or ► button to select [OK] and press the ENTER button.
   The character entry screen (software keyboard) will be closed.
5. Using On-Screen Menu

WPS
When the wireless LAN access point connected to the projector supports WPS (Wi-Fi Protected Setup TM), you can use PIN method or push button method to set up the wireless LAN for the projector.

PIN TYPE
Set a 4-digit or 8 digit-PIN code of WPS for your access point to complete setting for the SSID security.

PUSH BUTTON TYPE
Press the dedicated button of the access point and the projector’s wireless LAN unit to complete setting for the SSID security.

NETWORK INFORMATION
The following information will be displayed when the projector is connected to a network (wired LAN or wireless LAN).

PROJECTOR NAME
HOST NAME
DOMAIN
NETWORK INFORMATION (WIRED LAN/WIRELESS LAN)
CONNECTION STATUS, IP ADDRESS, SUBNET MASK, GATEWAY, WINS, DNS, MAC ADDRESS, SSID, NETWORK TYPE, WEP/WPA, CHANNEL, SIGNAL LEVEL, AUTHENTICATION, AUTHENTICATION PERIOD
DISPLAY THE INFORMATION IN APPLICATION MENU
Turn on or off the display of the network information.

The meanings of these status statements are described below.

<table>
<thead>
<tr>
<th>Statement</th>
<th>Authentication status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authenticated</td>
<td>Authentication is done correctly.</td>
</tr>
<tr>
<td>Failure</td>
<td>Authentication failed.</td>
</tr>
<tr>
<td>Authenticating</td>
<td>Authentication is in process.</td>
</tr>
<tr>
<td>Expired</td>
<td>The digital certificate is expired. Or [DATE, TIME PRESET] is not set correctly.</td>
</tr>
<tr>
<td>Time Error</td>
<td>The [DATE, TIME PRESET] has been cleared. Set the correct date and time.</td>
</tr>
</tbody>
</table>
### PROJECTOR NAME (ADVANCED menu only)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Characters allowed</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROJECTOR NAME</td>
<td>Set a unique projector name.</td>
<td>Up to 16 alphanumeric characters and symbols</td>
</tr>
</tbody>
</table>

### DOMAIN (ADVANCED menu only)

Set a host name and domain name of the projector.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Characters allowed</th>
</tr>
</thead>
<tbody>
<tr>
<td>HOST NAME</td>
<td>Set a host name of the projector.</td>
<td>Up to 15 alphanumeric characters</td>
</tr>
<tr>
<td>DOMAIN NAME</td>
<td>Set a domain name of the projector.</td>
<td>Up to 60 alphanumeric characters</td>
</tr>
</tbody>
</table>
**ALERT MAIL (ADVANCED menu only)**

<table>
<thead>
<tr>
<th>ALERT MAIL</th>
<th>This option will notify your computer of lamp replace time or error messages via e-mail when using wireless or wired LAN. Placing a checkmark will turn on the Alert Mail feature. Clearing a checkmark will turn off the Alert Mail feature. Sample of a message to be sent from the projector:</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALERT MAIL</td>
<td>The lamp and filters are at the end of its usable life. Please replace the lamp and filters. Projector Name: NEC Projector Lamp Hours Used: 100 [H]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>HOST NAME</th>
<th>Type in a host name.</th>
<th>Up to 15 alphanumeric characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>DOMAIN NAME</td>
<td>Type in a domain name of the network connected to the projector.</td>
<td>Up to 60 alphanumeric characters</td>
</tr>
<tr>
<td>SENDER’S ADDRESS</td>
<td>Specify the sender’s address.</td>
<td>Up to 60 alphanumeric characters and symbols</td>
</tr>
<tr>
<td>SMTP SERVER NAME</td>
<td>Type in the SMTP server name to be connected to the projector.</td>
<td>Up to 60 alphanumeric characters</td>
</tr>
<tr>
<td>RECIPIENT’S ADDRESS 1, 2, 3</td>
<td>Type in your recipient’s address.</td>
<td>Up to 60 alphanumeric characters and symbols</td>
</tr>
</tbody>
</table>
| TEST MAIL | Send a test mail to check if your settings are correct. **NOTE:**  
• If you entered an incorrect address in a test, you may not receive an Alert mail. Should this happen, check if the Recipient’s Address is correctly set.  
• Unless any one of the [SENDER’S ADDRESS], [SMTP SERVER’S NAME] or [RECIPIENT’S ADDRESS 1-3] is selected, [TEST MAIL] is not available.  
• Be sure to highlight [OK] and press the ENTER button before executing [TEST MAIL]. | — |
## NETWORK SERVICE (ADVANCED menu only)

<table>
<thead>
<tr>
<th>HTTP SERVER</th>
<th>PJLink</th>
<th>AMX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set a password for your HTTP server.</td>
<td>This option allows you to set a password when you use the PJLink feature.</td>
<td>Turn on or off for detection from AMX Device Discovery when connecting to the network supported by AMX's NetLinx control system.</td>
</tr>
</tbody>
</table>

**NOTE:**
- Do not forget your password. However, if you forget your password, consult with your dealer.
- What is PJLink?
  PJLink is a standardization of protocol used for controlling projectors of different manufacturers. This standard protocol is established by Japan Business Machine and Information System Industries Association (JBMIA) in 2005. The projector supports all the commands of PJLink Class 1.
- Setting of PJLink will not be affected even when [RESET] is done from the menu.

**Tip:**
When using a device that supports AMX Device Discovery, all AMX NetLinx control system will recognize the device and download the appropriate Device Discovery Module from an AMX server.

Placing a checkmark will enable detecting the projector from AMX Device Discovery. Clearing a checkmark will disable detecting the projector from AMX Device Discovery.
ADMINISTRATOR MODE
This allows you to select MENU MODE, save settings, and set a password for the administrator mode.

<table>
<thead>
<tr>
<th>MENU MODE</th>
<th>Select either [BASIC] or [ADVANCED] menu. (→ page 84)</th>
<th>—</th>
</tr>
</thead>
<tbody>
<tr>
<td>NOT SAVE SETTING VALUES</td>
<td>Placing a check mark will not save your projector settings. Clear this check box to save your projector settings.</td>
<td>—</td>
</tr>
<tr>
<td>NEW PASSWORD/CONFIRM PASS-WORD</td>
<td>Assign a password for the administrator mode.</td>
<td>Up to 10 alphanumeric characters</td>
</tr>
</tbody>
</table>

**NOTE:**
When [LAST] is selected for [DEFAULT SOURCE SELECT], placing a check mark for [NOT SAVE SETTING VALUES] will forcibly select NETWORK for source at every power-on time.
To avoid this, select [AUTO] for [DEFAULT SOURCE SELECT].

**TIP:**
To return to the ADVANCED menu from the BASIC menu, do the following:
1. **Use the SOURCE button on the cabinet or press the NETWORK button on the remote control to select [NETWORK] to display the APPLICATION MENU.**
2. **Select [TOOLS] → [ADMINISTRATOR MODE] → [MENU MODE] → [ADVANCED MODE].**
5. Using On-Screen Menu

PROGRAM TIMER

This option turns on/off the projector and changes video signals, and selects ECO mode automatically at a specified time.

NOTE:
• Before using [PROGRAM TIMER], make sure that the [DATE AND TIME] feature is set. (→ page 140)
• Make sure that the projector is in the stand by condition with the POWER cord connected.
• The projector has a built-in clock. The clock will keep working for about two weeks after the main power is turned off. If the main power is not supplied to the projector for two weeks or more, the built-in clock stops working.
• When [PROGRAM TIMER] is enabled, the [STANDBY MODE] setting becomes invalid. This means that the projector is in the same condition when the [NORMAL] is selected for [STANDBY MODE].

Setting a new program timer
1. On the PROGRAM TIMER screen, use the ▲ or▼ button to select [SETTINGS] and press the ENTER button.

The [PROGRAM LIST] screen will be displayed.

2. Select a blank program number and press the ENTER button.

The [EDIT] screen will be displayed.

3. Make settings for each item as required.

ACTIVE ................. Place a check mark to enable the program.
DAY.......................... Select days of the week for the program timer. To execute the program from Monday to Friday, select [MON-FRI]. To execute the program in everyday basis, select [EVERYDAY].

TIME ....................... Set the time to execute the program. Enter time in 24-hour format.

FUNCTION .................. Select a function to be executed. Selecting [POWER] will allow you to turn on or off the projector by setting [ADVANCED SETTINGS]. Selecting [SOURCE] will allow you to select a video source by setting [ADVANCED SETTINGS]. Selecting [ECO MODE] will allow you to select [ECO MODE] by setting [ADVANCED SETTINGS].

ADVANCED SETTINGS
............................... Select power on/off, a type of video source, or ECO MODE for the selected item in [FUNCTION].

REPEAT ........................ Place a check mark to repeat the program continuing basis. To use the program this week only, clear the check mark.

4. Select [OK] and press the ENTER button.
   This will complete the settings.
   You will be returned to the [PROGRAM LIST] screen.

5. Select [BACK] and press the ENTER button.
   You will be returned to the [PROGRAM TIMER] screen.

6. Select [OK] and press the ENTER button.
   You will be returned to the [TOOLS] screen.

NOTE:
• Up to 30 different timer settings can be programmed.
• When [PROGRAM TIMER] is turned on, the [STANDBY MODE] setting is ignored.
• The Program Timer is executed on a set time basis, not in a program basis.
• Once the program not marked with a check in [REPEAT] has been executed, the check mark in the [ACTIVE] check box will be cleared automatically and the program will be disabled.
• When the on-time and the off-time set for the same time, the off-time setting will take preference.
• Two different sources are set for the same time, the larger program number will take preference.
• The on-time setting will not be executed while the cooling fans are running or an error is occurring.
• If the off-time setting is expired under the condition in which the power off is not possible, the off-timer setting will not be executed until the power off becomes possible.
• Programs not marked with a check mark in [ACTIVE] of the [EDIT] screen will not be executed even if the Program Timer is enabled.
• When the projector is turned on by using the program timer and if you want to turn off the projector, set the off-time or do it manually so as not to leave the projector on for a long period of time.
Activating the program timer

   The [ENABLE] will be activated.
2. Select [OK] and press the ENTER button.
   The [PROGRAM TIMER] screen will be changed to the [TOOL] screen.

NOTE:
• Clearing [ENABLE] will disable the Program Timer even when a program is marked with a check mark on [PROGRAM LIST] screen.
• When [ENABLE] is selected, the [PROGRAM LIST] cannot be edited. To edit the programs, select [ENABLE] to turn off the Program Timer.

Changing the programmed settings

1. On the [PROGRAM LIST] screen, select a program you want to edit and press the ENTER button.
2. Change the settings on the [EDIT] screen.
3. Select [OK] and press the ENTER button.
   The programmed settings will be changed.
   You will be returned to the [PROGRAM LIST] screen.

Changing the order of programs

1. On the [PROGRAM LIST] screen, select a program whose order you want to change and press the ► button.
2. Press the ▼ button to select ▲ or ▼.
3. Press the ENTER button a few times to select a row to which you wish to move the program.
   The order of the programs will be changed.

Deleting the programs

1. On the [PROGRAM LIST] screen, select a program number you want to delete and press the ► button.
2. Press the ▼ button to select [DELETE].
3. Press the ENTER button.
   The confirmation screen will be displayed.
4. Select [YES] and press the ENTER button.
   The program will be deleted.

This will complete deleting the program.
DATE AND TIME

You can set the current time, month, date, and year.

NOTE: The projector has a built-in clock. The clock will keep working for about 2 weeks after the main power is turned off. If the main power is off for 2 weeks or more, the built-in clock will cease. If the built-in clock ceases, set the date and time again. The built-in clock will not cease while in the standby mode.

TIME ZONE SETTINGS…………. Select your time zone.
DATE AND TIME SETTINGS…….. Set your current date (MM/DD/YYYY) and time (HH:MM).
INTERNET TIME SERVER........ If you place a check mark, the projector's built-in clock will be synchronized with an Internet time server in every 24 hours and at the time of projector's startup.
UPDATE------------------------ Synchronizes the projector's built-in clock immediately. The UPDATE button is not available unless the INTERNET TIME SERVER check box is turned on.
SUMMER TIME SETTINGS........ If you place a check mark, the clock for daylight saving will be enabled.

MOUSE

This option lets you to change your USB mouse settings. The mouse settings feature is available for USB mouse only. Choose the settings you want:

MOUSE BUTTON………………. [RIGHT HAND] or [LEFT HAND]
MOUSE SENSITIVITY………….. [FAST], [MEDIUM] or [SLOW]
6. Connecting to Other Equipment

Mounting a lens (sold separately)

Five separate bayonet style lenses can be used with this projector. The descriptions here are for the NP13ZL (2x zoom) lens. Mount other lenses in the same manner.

NOTE:
- The projector and lenses are made of precision parts. Do not subject them to shock or excessive forces.
- Remove the separately sold lens when moving the projector. If not, the lens could be subject to shock while the projector is being moved, damaging the lens and the lens shift mechanism.
- Turn off the power and wait for the cooling fan to stop before mounting or removing the lens.
- Never touch the lens surface while the projector is operating.
- Be very careful not to let dirt, grease, etc., on the lens surface and not to scratch the lens surface.
- Perform these operations on a flat surface over a piece of cloth, etc., to prevent the lens from getting scratched.
- When leaving the lens off the projector for long periods of time, mount the dust cap on the projector to prevent dust or dirt from getting inside.
- If you have multiple projectors, be careful of the following:
  - When mounting a lens designed exclusively for this projector onto another projector in the NP series, be sure to remove the lens attachment before mounting the lens on the projector. The lens cannot be mounted if its attachment is on. For the types of lenses that can be mounted and instructions on removing them, see the lens’s operating instructions.
  - Other types of lenses cannot be mounted on this projector.

Mounting the lens

1. Remove the dust cap from the projector.

2. Remove the lens cap on the back of the lens.

3. Insert the lens onto the projector with the yellow-marked protrusion on the lens facing upwards.
   
   There is a positioning slit on the projector’s lens insertion slot. Insert the lens slowly all the way in, keeping the positioning slit at the same angle.
4. **Turn the lens clockwise.**
   
   Turn until a click is heard.
   The lens is now fastened onto the projector.

**TIP:** Mounting the lens theft prevention screw
Fasten the lens theft prevention screw included with the projector to the bottom of the projector so that the lens cannot be removed easily.

---

**Removing the lens**

1. **While pressing the lens release button on the projector’s front panel fully in, turn the lens counterclockwise.**
   
   The lens comes off.

   **NOTE:** If the lens cannot be removed when the lens release button is pressed, check whether the lens theft prevention screw is mounted.

2. **Slowly pull the lens off the projector.**
   
   - After removing the lens, mount the lens caps (front and back) included with the lens before storing the lens.
   
   - If no lens is going to be mounted on the projector, mount the dust cap included with the projector.
2 Making Connections

The projector can be connected to a computer using the computer cable (included), a BNC cable (5-core type) (commercially available), HDMI cable (commercially available) or DisplayPort cable (commercially available).

Analog RGB signal connection

- Connect the included computer cable between the computer's display output connector (mini D-Sub 15-pin) and the projector's Computer 1 or Computer 2 video input connector.

- When connecting the computer's display output connector (mini D-Sub 15-pin) and the projector's Computer 3 video input connector, use a BNC cable (5-core) → mini D-Sub 15-pin converter cable.

NOTE: For Macintosh, use a commercially available pin adapter (not supplied) to connect to your Mac’s video port.

Select the source name for its appropriate input connector after turning on the projector.

<table>
<thead>
<tr>
<th>Input connector</th>
<th>SOURCE button on the projector cabinet</th>
<th>Button on the remote control</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMPUTER 1 IN</td>
<td>☑ COMPUTER 1</td>
<td>COMPUTER 1</td>
</tr>
<tr>
<td>COMPUTER 2 IN</td>
<td>☑ COMPUTER 2</td>
<td>COMPUTER 2</td>
</tr>
<tr>
<td>COMPUTER 3 IN</td>
<td>☑ ☒ COMPUTER 3</td>
<td>COMPUTER 3</td>
</tr>
</tbody>
</table>

STEREO mini-plug audio cable (not supplied)
6. Installation and Connections

Digital RGB signal connection

- Connect a commercially available HDMI cable between the computer’s HDMI output connector and the projector’s HDMI input connector.
- Connect a commercially available DisplayPort cable between the computer’s DisplayPort output connector and the projector’s DisplayPort input connector.

• Select the source name for its appropriate input connector after turning on the projector.

<table>
<thead>
<tr>
<th>Input connector</th>
<th>SOURCE button on the projector cabinet</th>
<th>Button on the remote control</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDMI IN</td>
<td>HDMI</td>
<td>HDMI</td>
</tr>
<tr>
<td>DisplayPort</td>
<td>DisplayPort</td>
<td>DisplayPort</td>
</tr>
</tbody>
</table>

**NOTE:**
- Turn off the power of the computer and projector before connecting.
- Lower the computer’s volume setting before connecting an audio cable to the headphones connector. When using with a computer connected to the projector, adjust the volume of both the projector and computer to set the appropriate volume level.
- If the computer has a mini-jack type audio output connector, we recommend connecting the audio cable to that connector.
- This projector does not support NEC video unit (model ISS-6020) video decoded outputs.
- When a video deck is connected via a scan converter, etc., the display may not be correct during fast-forwarding and rewinding.

**TIP**
- The Computer 1 and Computer 2 video input connectors support Windows Plug and Play. The Computer 3 video input connector does not support Windows Plug and Play.
- A Macintosh signal adapter (commercially available) may be required to connect a Macintosh computer.
  To connect a Macintosh computer equipped with a Mini DisplayPort to the projector, use a commercially available Mini DisplayPort → DisplayPort converter cable.
Cautions when connecting an HDMI cable

- Use a certified High Speed HDMI® Cable or High Speed HDMI® Cable with Ethernet.

Cautions when connecting a DisplayPort cable

- Use a certified DisplayPort cable.

- Depending on the computer, some time may be required until the image is displayed.
- Some DisplayPort cables (commercially available) have locks.
- To disconnect the cable, press the button on the top of the cable’s connector, then pull the cable out.
- No power is supplied from the DisplayPort input connector to the connected device.
- When signals from a device that uses a signal converter adapter are connected to the DisplayPort input connector, in some cases the image may not be displayed.
- When the HDMI output of a computer is connected to the DisplayPort input connector, use a converter (commercially available).

Cautions when using a DVI signal

- When the computer has a DVI output connector, use a commercially available converter cable to connect the computer to the projector’s HDMI input connector (only digital video signals can be input). Also, connect the computer’s audio output to the projector’s Computer 2 audio input connector. In this case, switch the HDMI setting at on-screen menu’s audio selection on the projector to [COMPUTER2]. (→ page 109)

To connect the computer’s DVI output connector to the projector’s DisplayPort input connector, use a commercially available converter.

NOTE: When Viewing a DVI Digital Signal

- Use a DVI-to-HDMI cable compliant with DDWG (Digital Display Working Group) DVI (Digital Visual Interface) revision 1.0 standard. The cable should be within 197'/5 m long.
- Turn off the projector and the PC before connecting the DVI-to-HDMI cable.
- To project a DVI digital signal: Connect the cables, turn the projector on, then select the HDMI input. Finally, turn on your PC. Failure to do so may not activate the digital output of the graphics card resulting in no picture being displayed. Should this happen, restart your PC.
- Some graphics cards have both analog RGB (15-pin D-Sub) and DVI (or DFP) outputs. Use of the 15-pin D-Sub connector may result in no picture being displayed from the digital output of the graphics card.
- Do not disconnect the DVI-to-HDMI cable while the projector is running. If the signal cable has been disconnected and then reconnected, an image may not be correctly displayed. Should this happen, restart your PC.
Connecting an External Monitor

You can connect a separate, external monitor to your projector to simultaneously view on a monitor the computer analog image you’re projecting.

**NOTE:**
- Daisy chain connection is not possible.
- When audio equipment is connected, the projector speaker is disabled.
Connecting Your DVD Player or Other AV Equipment

Connecting Video/S-Video Input

- Select the source name for its appropriate input connector after turning on the projector.

<table>
<thead>
<tr>
<th>Input connector</th>
<th>SOURCE button on the projector cabinet</th>
<th>Button on the remote control</th>
</tr>
</thead>
<tbody>
<tr>
<td>VIDEO IN</td>
<td>📽 VIDEO</td>
<td>VIDEO</td>
</tr>
<tr>
<td>S-VIDEO IN</td>
<td>📽 S-VIDEO</td>
<td>S-VIDEO</td>
</tr>
</tbody>
</table>

**NOTE:** The AUDIO IN L and R jacks (RCA) are shared between the Video and S-Video inputs.

**NOTE:** Refer to your VCR owner’s manual for more information about your equipment’s video output requirements.

**NOTE:**

- An image may not be displayed correctly when a Video or S-Video source is played back in fast-forward or fast-rewind via a scan converter.
- Video signals can be projected when a video cable (commercially available) is connected to the Computer 3 video input connector’s G/Y connector. In this case, set the on-screen menu’s SETUP → OPTION(1) → SIGNAL SELECT(COMP3) to [VIDEO] and select Computer 3 for the input selection.
6. Installation and Connections

Connecting Component Input

- Select the source name for its appropriate input connector after turning on the projector.

<table>
<thead>
<tr>
<th>Input connector</th>
<th>SOURCE button on the projector cabinet</th>
<th>Button on the remote control</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMPUTER 1 IN</td>
<td>🖱 COMPUTER 1</td>
<td>COMPUTER 1</td>
</tr>
<tr>
<td>COMPUTER 2 IN</td>
<td>🖱 COMPUTER 2</td>
<td>COMPUTER 2</td>
</tr>
<tr>
<td>COMPUTER 3 IN</td>
<td>🖱 COMPUTER 3</td>
<td>COMPUTER 3</td>
</tr>
</tbody>
</table>

**NOTE:**
- Normally the computer signal and component signal are identified and switched automatically. If the signal cannot be identified, however, select the signal at [ADJUST] → [VIDEO] → [SIGNAL TYPE] on the projector’s on-screen menu. Select “COMPUTER” or “VIDEO” for the Computer 3 video input connector at [SETUP] → [OPTION (1)] → [SIGNAL SELECT(COMP3)] (→ page 109).
- To connect to a video device with a D connector, use the sold separately D connector converter adapter (model ADP-DT1E).
Connecting HDMI Input

You can connect the HDMI output of your DVD player, hard disk player, Blu-ray player, or notebook type PC to the HDMI IN connector of your projector.

NOTE: The HDMI IN connector supports Plug & Play (DDC2B).

<table>
<thead>
<tr>
<th>Input connector</th>
<th>SOURCE button on the projector cabinet</th>
<th>Button on the remote control</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDMI IN</td>
<td>[HDMI]</td>
<td>[HDMI]</td>
</tr>
</tbody>
</table>

TIP: For users of audio video equipment with an HDMI connector:
Select “Enhanced” rather than “Normal” if HDMI output is switchable between “Enhanced” and “Normal”. This will provide improved image contrast and more detailed dark areas.
For more information on settings, refer to the instruction manual of the audio video equipment to be connected.

- When connecting the HDMI IN connector of the projector to the DVD player, the projector’s video level can be made settings in accordance with the DVD player’s video level. In the menu select [HDMI SETTINGS] → [VIDEO LEVEL] and make necessary settings.
- If the HDMI input sound cannot be heard, in the menu select [AUDIO SELECT] → [HDMI].
- If the HDMI input’s sound is not output, check that [OPTIONS(1)] → [DIGITAL AUDIO SELECT] → [HDMI] on the projector’s on-screen menu is set to “HDMI”. (→ page 109)
Connecting to a Wired LAN
The projector comes standard with a LAN port (RJ-45) which provides a LAN connection using a LAN cable. To use a LAN connection, you are required to set the LAN on the projector menu. Select [APPLICATION MENU] → [NETWORK SETTINGS] → [WIRED LAN]. (→ page 121).

Example of LAN connection
Example of wired LAN connection

NOTE: Use a Category 5 or higher LAN cable.
Connecting to a Wireless LAN (sold separately)
The separately sold wireless LAN unit allows you to use a wireless LAN environment. When using the projector in a wireless LAN environment, the IP address and other settings must be made on the projector.

Important:
• If you use the projector with the USB Wireless LAN Unit in the area where the use of wireless LAN equipment is prohibited, remove the USB Wireless LAN Unit from the projector.
• Buy the appropriate USB Wireless LAN Unit for your country or area.

NOTE:
• The green LED on the USB Wireless LAN Unit flashes to show that the USB Wireless LAN Unit is working.
• Your computer’s wireless LAN adapter (or unit) must be complied with Wi-Fi (IEEE802.11b/g/n) standard.

Flow of Setting Wireless LAN
Step 1: Attach the USB Wireless LAN Unit to the projector if required.
Step 2: Display [NETWORK SETTINGS] from [APPLICATION MENU]. (→ page 120)
Step 3: Select [NETWORK SETTINGS] → [WIRELESS LAN] → [PROFILES] and set [EASY CONNECTION], [PROFILE 1], or [PROFILE 2]. (→ page 121)

TIP:
Access the HTTP server function to set [NETWORK SETTINGS] → [SETTINGS] → [WIRELESS] → [EASY CONNECTION], [PROFILE1], [PROFILE2].

Mounting a wireless LAN unit

⚠️ CAUTION:
• The wireless LAN unit is mounted inside the projector. Before mounting it, turn off the power, unplug the power cord and let the projector cool down completely. Removing the filter unit while the projector is running could result in burns or electric shocks from touching internal parts.

NOTE:
• The wireless LAN unit has a front and a back and must be mounted in the wireless LAN port in a specific direction. The port is designed so that the unit cannot be mounted in the opposite direction, but trying to push it in by force could damage the wireless LAN unit port.
• To prevent damage due to static electricity, touch a nearby metal object (a door knob, aluminum sash, etc.) before touching the wireless LAN unit to eliminate the static electricity from your body.
• Disconnect the power cord when mounting and removing the wireless LAN unit.
• Mounting and removing the wireless LAN unit while the projector’s power is on could damage the wireless LAN unit or result in malfunction on the projector. If the projector should malfunction, turn off the projector’s power, unplug the power cord, then plug the power cord back in.
• Do not connect any USB device other than the wireless LAN unit to the USB (LAN) port. Also, do not connect the wireless LAN unit to the USB port in the connector section.
1. **Press the button to set the projector to the standby mode, then disconnect the power cord.**
   Wait for the projector to fully cool off.

2. **Remove the filter cover.**
   Pressing the buttons on the left and right sides of the filter cover upwards, pull the filter cover towards you to remove it.

3. **Remove the filter unit.**
   Pull the hooks on the left and right sides of the filter unit towards you to remove the filter unit.

4. **Slowly insert the wireless LAN unit into the USB (LAN) port.**
   - Remove the wireless LAN unit’s cap, set the unit with the front (the side with the indicator) facing upwards, hold the back edge and insert the unit gently.
     Next, press the wireless LAN unit in with a finger.
   - The cap you have removed will be used when the wireless LAN unit is removed, so store it in a safe place.

   **NOTE:** If the wireless LAN unit is hard to insert, do not push it in by force.

5. **Mount the filter unit.**
   Insert the filter unit onto the projector with the sides on which the left and right hooks are located on the outside.

6. **Mount the filter cover.**
   Insert the 4 catches on the top of the filter cover into the grooves in the projector, then press the left and right buttons to close.
   - A click is heard and the filter cover is fastened in place.
To remove the wireless LAN unit
1. Remove the filter unit following steps 1 to 3 above.
2. Remove the wireless LAN unit.
   If the wireless LAN unit is hard to remove, place a cloth, etc., over needle-nose pliers to grasp the wireless LAN unit and pull it out.

   NOTE: Do not grasp the wireless LAN unit with excessive force. Doing so will damage it.

3. Mount the filter unit and filter cover as described in steps 5 and 6 above.
6. Installation and Connections

Example of wireless LAN connection (Network Type → Infrastructure) (→ page 123)

Example of wireless LAN connection (Network Type → Ad Hoc)

To enable direct communication (i.e., peer-to-peer) between computers and projectors, you need to select the Ad Hoc mode. (→ page 123)
7. Maintenance

This section describes the simple maintenance procedures you should follow to clean the filters, the lens, the cabinet, and to replace the lamp and the filters.

1 Cleaning the Filters

The air-filter sponge keeps dust and dirt from getting inside the projector and should be frequently cleaned. If the filter is dirty or clogged, your projector may overheat.

NOTE: The message for filter cleaning will be displayed for one minute after the projector is turned on or off. When the message is displayed, clean the filters. The time to clean the filters is set to [OFF] at time of shipment. (→ page 103)

To cancel the message, press any button on the projector cabinet or the remote control.

The two-layer filter on the projector improves cooling and dust-proof capabilities compared with the conventional models.

The outsides (intake side) of the first and second layer filters remove dust.

To clean the filter, detach the filter unit and the filter cover.

⚠️ CAUTION

• Before cleaning the filters, turn off the projector, disconnect the power cord and then allow the cabinet to cool. Failure to do so can result in electric shock or burn injuries.

1. Push up the buttons on the left and right to release the filter unit and pull it out.

2. Remove the filter unit by pulling out the tab.

3. Remove the four filters.

   (1) Turn the filter unit over and pull out the two soft accordion filters.
7. Maintenance

(2) Push the left edges of the filters and remove the two hard honeycomb filters.
   - The filters cannot be removed by pressing the left and right edges.

4. Use a vacuum cleaner to vacuum all the dust inside.
   Get rid of dust in the accordion filter

   **NOTE:**
   - Whenever you vacuum the filter, use the soft brush attachment to vacuum. This is to avoid damage to the filter.
   - Do not wash the filter with water. Doing so can result in filter clogging.

5. Remove dust from the filter unit and the filter cover.
   Clean both outside and inside.

6. Attach the four filters to the filter unit.
   (1) Insert the hard honeycomb filters into the tips of the flanges at the center, then bend the filters and push them in under the hooks.
      - The filters cannot be inserted from the outside.

   (2) Turn the filter unit over.
      Mount the accordion filters under the flanges along the outer edges.
      - Each accordion filter has slits in it. Align the slits with the protrusions on the filter unit.

7. Mount the filter unit back onto the projector cabinet.
   Insert the filter unit onto the projector with the sides on which the left and right hooks are located on the outside.
8. **Put the filter cover back to the projector cabinet.**

   Insert the 4 catches on the top of the filter cover into the grooves in the projector, then press the left and right buttons to close.
   - Push the filter cover until it clicks into place.

9. **Clear the filter usage hours.**

   Plug the power cord into the wall outlet, and then turn on the projector.
   From the menu, select [RESET] → [CLEAR FILTER HOURS].
   (→ page 117)

   The interval time to clean the filters is set to [OFF] at time of shipment. When using the projector as it is, you do not clear the filter usage.
2 Cleaning the Lens

- Turn off the projector before cleaning.
- The projector has a plastic lens. Use a commercially available plastic lens cleaner.
- Do not scratch or mar the lens surface as a plastic lens is easily scratched.
- Never use alcohol or glass lens cleaner as doing so will cause damage to the plastic lens surface.

3 Cleaning the Cabinet

Turn off the projector, and unplug the projector before cleaning.

- Use a dry soft cloth to wipe dust off the cabinet.
  If heavily soiled, use a mild detergent.
- Never use strong detergents or solvents such as alcohol or thinner.
- When cleaning the ventilation slits or the speaker using a vacuum cleaner, do not force the brush of the vacuum cleaner into the slits of the cabinet.

Vacuum the dust off the ventilation slits.

- Clogged ventilation slits may cause a rise in the internal temperature of the projector, resulting in malfunction.
- Do not scratch or hit the cabinet with your fingers or any hard objects
- Contact your dealer for cleaning the inside of the projector.

NOTE: Do not apply volatile agent such as insecticide on the cabinet, the lens, or the screen. Do not leave a rubber or vinyl product in prolonged contact with it. Otherwise the surface finish will be deteriorated or the coating may be stripped off.
Replacing the Lamp and the Filters

When the lamp reaches the end of its life, the LAMP indicator in the cabinet will blink red and the message “THE LAMP HAS REACHED THE END OF ITS USABLE LIFE. PLEASE REPLACE THE LAMP AND FILTER. USE THE SPECIFIED LAMP FOR SAFETY AND PERFORMANCE.” will appear (*). Even though the lamp may still be working, replace the lamp to maintain the optimal projector performance. After replacing the lamp, be sure to clear the lamp hour meter. (→ page 116)

**CAUTION**

- DO NOT TOUCH THE LAMP immediately after it has been used. It will be extremely hot. Turn the projector off and then disconnect the power cord. Allow at least one hour for the lamp to cool before handling.

- Use the specified lamp for safety and performance.
- DO NOT REMOVE ANY SCREWS except one lamp cover screw and two lamp housing screws. You could receive an electric shock.
- Do not break the glass on the lamp housing.
  Keep finger prints off the glass surface on the lamp housing. Leaving finger prints on the glass surface might cause an unwanted shadow and poor picture quality.
- The projector will turn off and go into standby mode when you continue to use the projector for another 100 hours after the lamp has reached the end of its life. If this happens, be sure to replace the lamp. If you continue to use the lamp after the lamp reaches the end of its life, the lamp bulb may shatter, and pieces of glass may be scattered in the lamp case. Do not touch them as the pieces of glass may cause injury. If this happens, contact your NEC dealer for lamp replacement.

*NOTE: This message will be displayed under the following conditions:
- for one minute after the projector has been powered on
- when the (POWER) button on the projector cabinet or the POWER OFF button on the remote control is pressed

To turn off the message, press any button on the projector cabinet or the remote control.

Optional lamp and tools needed for replacement:
- Phillips screwdriver (plus-head)
- Replacement lamp: NP21LP

Flow of Replacing the Lamp and the Filters

**Step 1.** Replace the lamp

**Step 2.** Replace the filters (→ page 162)

**Step 3.** Clear the lamp usage hours and the filter usage hours (→ page 116, 117)
To replace the lamp:

1. *Remove the lamp cover.*
   
   (1) Loosen the lamp cover screw
   
   • The lamp cover screw is not removable.
   
   (2) Pull the bottom of the lamp cover towards you and remove it.

2. *Remove the lamp housing.*

   (1) Loosen the two screws securing the lamp housing until the phillips screwdriver goes into a freewheeling condition.
   
   • The two screws are not removable.
   
   • There is an interlock on this case to prevent the risk of electrical shock. Do not attempt to circumvent this interlock.

   (2) Remove the lamp housing by holding it.

---

**CAUTION:**

Make sure that the lamp housing is cool enough to before removing it.
3. **Install a new lamp housing.**
   (1) Insert a new lamp housing until the lamp housing is plugged into the socket.
   (2) Position so that the guide hole in the bottom right of the lamp house is over the protrusion on the projector then press all the way in.
   (3) Secure it in place with the two screws.
   • Be sure to tighten the screws.

4. **Reattach the lamp cover.**
   (1) Insert the top edge of the lamp cover into the groove in the projector and close the lamp cover.
   (2) Tighten the screw to secure the lamp cover.
   • Be sure to tighten the screw.

---

This completes the lamp replacement.  
Go on to the filter replacement.

---

**NOTE:** When you continue to use the projector for another 100 hours after the lamp has reached the end of its life, the projector cannot turn on and the menu is not displayed.  
If this happens, press the HELP button on the remote control for 10 seconds to reset the lamp clock back to zero.  
When the lamp time clock is reset to zero, the LAMP indicator goes out.
To replace the filters:

Four filters are packaged with the replacement lamp.

Honeycomb filter (coarse mesh): Large and small sizes (attached to the outside of the filter unit)

Accordion filter (fine mesh): Large and small sizes (attached to the inside of the filter unit)

NOTE:

• Replace all four filters at the same time.
• Before replacing the filters, wipe off dust and dirt from the projector cabinet.
• The projector is precision equipment. Keep out dust and dirt during filter replacement.
• Do not wash the filters with soap and water. Soap and water will damage the filter membrane.
• Put filters into place. Incorrect attachment of a filter may cause dust and dirt to get into the inside of the projector.

Before replacing the filters, replace the lamp. (→ page 159)

1. Push up the buttons on the left and right to release the filter unit and pull it out.

2. Remove the filter unit by pulling out the tab.

3. Remove the four filters.

   (1) Turn the filter unit over and pull out the two soft accordion filters (large and small).
7. Maintenance

(2) Push the left edges of the filters and remove the two hard honeycomb filters (large and small).
   • The filters cannot be removed by pressing the left and right edges.

4. Remove dust from the filter unit and the filter cover.
   Clean both outside and inside.

5. Attach four new filters to the filter unit.
   (1) Insert the hard honeycomb filters into the tips of the flanges at the center, then bend the filters and push them in under the hooks.
   - The filters cannot be inserted from the outside.

   (2) Turn the filter unit over.
   Mount the accordion filters under the flanges along the outer edges.
   • Each accordion filter has slits in it. Align the slits with the protrusions on the filter unit.

6. Mount the filter unit back onto the projector cabinet.
   Insert the filter unit onto the projector with the sides on which the left and right hooks are located on the outside.

7. Mount the filter cover back onto the projector cabinet.
   Insert the 4 catches on the top of the filter cover into the grooves in the projector, then press the left and right buttons to close.

This completes the filter replacement.
Go on to the clearing lamp and filter hour meters.

To clear the lamp usage hours and the filter usage hours:
1. Place the projector where you use it.
2. Plug the power cord into the wall outlet, and then turn on the projector.
3. Clear the lamp usage hours and the filter usage hours.
   1. From the menu, select [RESET] → [CLEAR LAMP HOURS] and reset the lamp usage hours.
   2. Select [CLEAR FILTER HOURS] and reset the filter usage hours. (→ page 117)
8. User Supportware

1 Installing Software Program

Installation for Windows software

The software programs except Image Express Utility 2 for Mac support Windows 7, Windows Vista, and Windows XP.

**NOTE:**
- To install or uninstall each software program, the Windows user account must have “Administrator” privilege (Windows 7, Windows Vista) or “Computer Administrator” privilege (Windows XP).
- Exit all running programs before installation. If another program is running, the installation may not be completed.
- To run Virtual Remote Tool or PC Control Utility Pro 4 on Windows XP Home Edition and Windows XP Professional, “Microsoft .NET Framework Version 2.0 or later” is required. The Microsoft .NET Framework Version 2.0 or later is available from Microsoft's web page. Download and install it on your computer.
- Image Express Utility Lite will be installed to the system drive of your computer. If the message “There is not enough free space on destination” is displayed, free up enough space (about 100 MB) to install the program.

1 **Insert the accompanying NEC Projector CD-ROM into your CD-ROM drive.**

   The menu window will be displayed.

   ![Image of NEC Projector CD-ROM](image)

   **TIP:**
   If the menu window will not be displayed, try the following procedure.

   For Windows 7
   1. Click “start” on Windows.
   2. Click “All Programs” → “Accessories” → “Run”.
   3. Type your CD-ROM drive name (example: “Q:" ) and “LAUNCHER.EXE” in “Name”. (example: Q:\LAUNCHER.EXE)
   4. Click “OK”.

   the menu window will be displayed.
2 Click a software program you wish to install on the menu window.
   The installation will start.

   ![Software Installation Window](image.png)

   • Follow the instructions on the installer screens to complete the installation.

TIP:

Uninstalling a Software Program

Preparation:
Exit the software program before uninstalling. To uninstall the software program, the Windows user account must have “Administrator” privilege (Windows 7 and Windows Vista) or “Computer Administrator” privilege (Windows XP).

• For Windows 7/WINDOWS Vista
  1 Click “Start” and then “Control Panel”.
     The Control Panel window will be displayed.
  2 Click “Uninstall a program” under “Programs”
     The “Programs and Features” window will be displayed.
  3 Select the software program and click it.
  4 Click “Uninstall/Change” or “Uninstall”.
     • When the “User Account Control” windows is displayed, click “Continue”.
       Follow the instructions on the screens to complete the uninstallation.

• For Windows XP
  1 Click “Start” and then “Control Panel”.
     The Control Panel window will be displayed.
  2 Double-click “Add / Remove Programs”.
     The Add / Remove Programs window will be displayed.
  3 Click the software program from the list and then click “Remove”.
     Follow the instructions on the screens to complete the uninstallation.
Installation for Macintosh software

Image Express Utility 2 for Mac supports Mac OS X.

1 Insert the accompanying NEC Projector CD-ROM into your CD-ROM drive.
The menu window will be displayed.

2 Double-click the CD-ROM icon.

3 Double-click the “Mac OS X” folder.

4 Double-click “Image Express Utility 2 (Intel).dmg”.

The “Image Express Utility 2” folder will be displayed.

• If your Mac is PowerPC-based, double-click “Image Express Utility 2.dmg”.

5 Move the “Image Express Utility 2” folder to “Applications” folder using a drag-and-drop operation.

TIP:

• Uninstalling a software program

1. Put the “Image Express Utility 2” folder to the Trash icon.
2. Put the configuration file of Image Express Utility 2 to the Trash icon.

• The configuration file of Image Express Utility 2 is located in “/user/your user name/library/Preferences/jp.co. nec.nevt.ImageExpressUtility.plist”.

166
8. User Supportware

Operating the Projector Via the LAN (Virtual Remote Tool)

This will help you perform operations such as projector's power on or off and signal selection via a LAN connection. It is also used to send an image to the projector and register it as the logo data of the projector. After registering it, you can lock the logo to prevent it from changing.

Control Functions

Power On/Off, signal selection, picture freeze, picture mute, audio mute, Logo transfer to the projector, and remote control operation on your PC.

NOTE:

• Logo data (graphics) that can be sent to the projector with Virtual Remote Tool has the following restrictions:
  - File size: 256 KB or less
  - Image size (resolution): the native resolution of the projector
• The logo data that is sent with Virtual Remote Tool will be displayed at the center of the screen. Its surrounding will be painted out in black.

TIP:

• Virtual Remote Tool can be used also with a serial connection.

Connect the projector to a LAN.

Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 150), “Connecting to a Wireless LAN (sold separately)” (→ page 151) and “9 Application Menus - NETWORK SETTINGS” (→ page 120)
8. User Supportware

Start Virtual Remote Tool

Start using the shortcut icon

• Double-click the shortcut icon on the Windows Desktop.

Start from the Start menu

• Click [Start] → [All Programs] or [Programs] → [NEC Projector User Supportware] → [Virtual Remote Tool] → [Virtual Remote Tool].

When Virtual Remote Tool starts for the first time, “Easy Setup” window will be displayed.

The “Easy Setup” feature is not available on this model. Click “Close Easy Setup”.

Closing the “Easy Setup” window will display the “Projector List” window.

Select your projector you wish to connect. This will display the Virtual Remote screen.

TIP:
• The Virtual Remote Tool screen (or Toolbar) can be displayed without displaying “Easy Setup” window. To do so, click to place a check mark for “Do not use Easy Setup next time” on the screen.

NOTE:
• When [POWER-SAVING] is selected for [STANDBY MODE] from the menu, the projector cannot be turned on via the network (wired LAN/wireless LAN) connection. When [NETWORK STANDBY] is selected for [STANDBY MODE], the projector cannot be turned on via wireless LAN connection.
8. User Supportware

Exiting Virtual Remote Tool

1. **Click the Virtual Remote Tool icon** on the Taskbar.
   
The pop-up menu will be displayed.

2. **Click “Exit”**.
   
The Virtual Remote Tool will be closed.

Viewing the help file of Virtual Remote Tool

• Displaying the help file using the taskbar

1. **Click the Virtual Remote Tool icon** on the taskbar when Virtual Remote Tool is running.
   
The pop-up menu will be displayed.

2. **Click “Help”**.
   
The Help screen will be displayed.

• Displaying the help file using the Start Menu.

1. **Click “Start”. “All programs” or “Programs”. “NEC Projector User Supportware”. “Virtual Remote Tool”. and then “Virtual Remote Tool Help” in this order.**
   
The Help screen will be displayed.
Projecting Your Computer’s Screen Image from the Projector over a LAN (Image Express Utility Lite)

Using Image Express Utility Lite allows you to send the computer’s screen image to the projector over a wired or wireless LAN.
This section will show you an outline about how to connect the projector to a LAN and to use Image Express Utility Lite. For the operation of Image Express Utility Lite, see the help of Image Express Utility Lite.

What you can do with Image Express Utility Lite
• Image transmission
  • The screen of your computer can be sent to the projector via a wired or wireless network without a computer cable (VGA).
  • By using “EASY CONNECTION” function, the complicated network settings can be simplified and the computer will automatically connect to the projector.
  • The screen of your computer can be sent to up to four projectors at the same time.
• Geometric Correction Tool (GCT)
  See “❹ Projecting an Image from an Angle (Geometric Correction Tool in Image Express Utility Lite)”.

Connect the projector to a LAN.
Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 150), “Connecting to a Wireless LAN (sold separately)” (→ page 151) and “9 Application Menus - NETWORK SETTINGS” (→ page 120)

Start Image Express Utility Lite.
1. On Windows, click “Start” → “All programs” → “NEC Projector UserSupportware” → “Image Express Utility Lite” → “Image Express Utility Lite”.
   Image Express Utility Lite will start.
   The select window for network connection will be displayed
2. Select Network and click “OK”.
   The select window for destination will show a list of connectable projectors.
   • When connecting the computer directly to the projector by one-to-one, “Easy Connection” is recommended.

   When one or more networks for “EASY CONNECTION” are found, the “Easy Connection Selection Screen” window will be displayed.
   • To check for the network available for connected projectors, from the menu, select [INFO.] → [WIRELESS LAN] → [SSID].

3. Select “Easy Connection” network you wish to connect, and click “Select”.
   The target selection window will be displayed.
4. Place a check mark for projectors to be connected, and then click “Connect”.
   • When one or more projectors are displayed, from the menu on the projector, select [INFO.] → [WIRELESS LAN] → [IP ADDRESS].
8. User Supportware

When connecting with the projector is established, you can operate the control window to control the projector.

NOTE:

• When [POWER-SAVING] or [NETWORK STANDBY] is selected for [STANDBY MODE] from the menu, the projector that is turned off will not be displayed in the select window for destination.

• When the PA500U is found, "1280 x 800" will be displayed in the resolution field.

Control Window Operations

1. (Source) Selects an input source of the projector.
2. (Picture) Turns on or off the Mute (Picture mute), Freeze (Freeze a picture), Play, and Geometric Correction Tool (GCT) functions.
3. (Sound) Turns on or off Mute (Sound mute), play the sound and turns up or down the volume.
4. (Etc.) Uses “Update”, “HTTP Server”*, “Settings” and “Information”.
5. (Exit) Exit Image Express Utility Lite. You can also turn off the projector at the same time.
6. (Help) Displays the help of Image Express Utility Lite.

TIP:

Viewing the Help of Image Express Utility Lite

• Displaying the Help file of Image Express Utility Lite while it is running.
  Click the [?] (help) icon on the control window.
  The Help screen will be displayed.

• Displaying the Help file of GCT while it is running.
  Click “Help (C)” → “Help” on the Cornerstone Edit screen.
  The Help screen will be displayed.

• Displaying the help file using the Start Menu.
  Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “Image Express Utility Lite” → “Image Express Utility Lite Help”.
  The Help screen will be displayed.
4 Projecting an Image from an Angle (Geometric Correction Tool in Image Express Utility Lite)

The Geometric Correction Tool (GCT) function allows you to correct distortion of images projected even from an angle.

What you can do with GCT

- The GCT feature includes the following three functions
  - **4-point Correction**: You can fit a projected image within the border of the screen easily by aligning the four corners of an image to the ones of the screen.
  - **Multi-point Correction**: You can correct a distorted image on the corner of a wall or irregular shaped screen by using many separated screens to correct the image as well as 4-point Correction.
  - **Parameters Correction**: You can correct a distorted image by using a combination of transformational rules prepared in advance.

This section will show an example for use with 4-point Correction. For information about “Multi-point Correction” and “Parameters Correction”, see the help file of Image Express Utility Lite. (→ page 171)

- Your correction data can be stored in the projector or your computer which can be restored when necessary.
- Geometric correction data can be used when connected to the network (by wired or wireless LAN) or by video cable.

Preparation: Adjust the projector position or the zoom so that the projected image can cover the whole screen area.

1. **Click the “ ” (Picture) icon and then the “ ” button.**

   ![Image](image1)

   The “4-point Correction” window will be displayed.

2. **Click the “Start Correction” button and then “Start 4-point Correction” button.**

   ![Image](image2)

   A green frame and a mouse pointer ( ) will be displayed.

   - Four [ ] marks will be appeared at four corners of the green frame
3. Use the mouse to click the [●] mark of which corner you wish to move.
The currently selected [●] mark will turn red.

4. Drag the selected [●] mark to the point you wish to correct and drop it.
   • When you click somewhere within the project image area, the nearest [●] mark will go to the position where
     the mouse cursor is.

5. Repeat Step 3 and 4 to correct the distortion of the projected image.

6. After completing, right-click the mouse.
   The green frame and the mouse pointer will disappear from the projected image area. This will complete the cor-
   rection.

7. Click the “X” (close) button on the “4-point Correction” window.
   The “4-point Correction” window will disappear and the 4-point correction will take effect.

8. Click the “ ” button on the control window to exit the GCT.

TIP:
• After performing the 4-point correction, you can save the 4-point correction data to the projector by clicking “File” → “Writing to
  the projector…” on the “4-point Correction” window.
• See the Help of Image Express Utility Lite for operating “4-point Correction” window and other functions than GCT. (→ page
  171)
Projecting Images or Videos from the Projector over a LAN (Image Express Utility 2.0)

What you can do with Image Express Utility 2.0

- Using Image Express Utility 2.0 allows you to send the screens of your computers to the projector via wired/wireless LAN.
  
  The difference from Image Express Utility Lite is that projected images can be sent from a computer to not only one projector but also to two or more projectors at the same time.
  
  When “Meeting Mode” is used, projected images can be sent and received between two or more computers.

- High-speed, high-quality image transmissions based on NEC’s original compression algorithm
  
  NEC’s original compression algorithm allows high-quality images to be sent over the network at high speed, from your computer to the projector.

- Simultaneous projection by multiple projectors
  
  Images can be sent from a computer to not only one projector but also to two or more projectors at the same time.

- “Easy Connection” function for connecting wireless LAN
  
  By using “Easy Connection” function*, the complicated setting of wireless LAN can be simplified.

  * This function can be used when Windows XP is used as the OS and when you have a “Computer Administrator” privilege. If the OS is Windows 7/Windows Vista, input of logon password as “Administrator” may be prompted.
8. User Supportware

- **Projected images can be transferred and saved to computers.**
  
  When “Meeting Mode” is used, projected images can be sent to the computers of all the participants (attendants) of a “Meeting”. The received images can be saved to your computer with a memo (text data) attached.

- **1-click switching of presenter**
  
  When switching to another presenter during the conference, the participants (attendants) can simply click a button to switch over to the new presenter.

- **Central management of the projecting computer**
  
  Using the Training Mode allows you to use a single computer (Manager) to manage which computer (Attendant) projects. Possible operation includes switching projecting computers to project from, as well as temporarily terminating communication with the projector.

---

**NOTE:**

The Training Mode is not installed via the “Typical” installation option when Image Express Utility 2.0 is installed.

To use Training Mode, select “Extension” installation option on the install selection screen that is displayed while Image Express Utility 2.0 installation is in progress, and select “Training Mode (Attendant)” or “Training Mode (Manager)”.

---

**Connecting the projector to a LAN**

Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 150), “Connecting to a Wireless LAN” (→ page 151) and “9 Application Menus - NETWORK SETTINGS” (→ page 120)
Basic Operation of Image Express Utility 2.0

This section explains the following three cases as examples of operating Image Express Utility 2.0.

(1) Transferring images to the projector
(2) Holding a conference
(3) Participating in a conference

Sending Images to Projector

• Connecting projector

1 Turn on the power to the projector for which LAN has been set.

2 Click Windows [Start] → [All Programs] → [NEC Projector User Supportware] → [Image Express Utility 2.0] → [Image Express Utility 2.0], in that order.

   The “Selection Of Network Connections” window will be displayed.
   A list of the network equipment connected to your computer will be displayed.

   IMPORTANT:
   A screen like the one below is displayed when the software is started on a PC installed with Windows XP Service Pack 2 (SP2) (or later).
   Click “Unblock” if this is displayed.

3 Select the network equipment that is to be used and click [OK].

   Select the network device displaying “Easy Connection” if the product LAN setting is for “Easy Connection.” This will call up the “Projector List” window.
4 Check(✔) the projector to connect and click [Connect].
If the name of the projector to connect is not on the list or if it is hidden, click [Update].

The screen of your computer will be projected from the projector.
At this time, the input signal of the projector will automatically change to “NETWORK”.

NOTE:
• When the PA500U is found, “1280 x 800” will be displayed in the resolution field.

• Transferring images
When your computer is connected to the projector, the screen of the computer is projected from the projector as is. To make your presentation by using a PowerPoint file, open the PowerPoint file and start your presentation.
• **Stopping or resuming the transmission of images**
The transmission of the screen of the computer to the projector can be temporarily stopped and then resumed.

1. **Click the projector icon ( ) on the Windows taskbar.**
   A pop-up menu will be displayed.

2. **Click [Stop Sending].**
   The projector icon on the taskbar will change ( ).

   **NOTE:**
   Even if the screen of the computer is changed in this status, the image projected from the projector does not change.
   To manipulate the screen that should not be disclosed (projected from the projector), stop transmission.

3. **Click the projector icon ( ) on the Windows taskbar.**
   A pop-up menu will be displayed.

4. **Click [Start Sending].**
   The projector icon on the taskbar will change ( ).
   The transmission of the screen for the computer will be resumed, and the current screen of the computer will be projected from the projector.

• **End the transmission of images**
Exit Image Express Utility 2.0.

1. **Click the projector icon ( ) on the Windows taskbar.**
   A pop-up menu will be displayed.

2. **Click [Exit].**
Holding Conferences

• Holding conferences

1  Follow steps 1 through 4 in “Connecting projector” of “Sending Images to Projector” (→ page 176).
   The screen of your computer will be projected from the projector.

• Disclose a file to the participants of the conference.

NOTE:
To disclose a file to the participants, selection can be made only in folder units.
Therefore, a folder only having files that can be disclosed to the participants must be created in advance.

1  Click the projector icon ( ) on the Windows taskbar.
   A pop-up menu will be displayed.

2  Before clicking [Send to PC and Projector], check that there is a “•” mark applied.

3  Click the [Image Express Utility 2.0] button on the taskbar.

   The presenter window will be opened.

4  Click [Select Folder].
5 Select a folder saving the file to be disclosed to the participants, and click [OK].
   The file in the selected folder will be displayed in the list of files to transfer.

6 Click [Download].
   The file will be shown to the participants.

NOTE:
When the computer is connected to the projector, the computer screen that is in of being progress is also projected from the projec-
tor. To manipulate a screen that should not be shown (not projected), temporarily stop the transmission (→ page 178).

• Ending conference
  1 Click [File] in the presenter window, and click [Exit].
     You can also end the conference by clicking [×] at the upper right of the presenter window.

Participating in Conference
• Participating in conferences
  1 Click Windows [Start] → [All Programs] → [NEC Projector User Supportware] → [Image Express Utility 2.0] → [Image Express Utility 2.0 ], in that order.
     The “Selection Of Network Connections” window will be displayed.
     A list of the network equipment connected to your computer will be displayed.

IMPORTANT:
A screen like the one below is displayed when the software is started on a PC installed with Windows XP Service Pack 2 (SP2) (or later).
Click “Unblock” if this is displayed.

2 Select the network equipment that is to be used and click [OK].

Select the network device displaying “Easy Connection” if the product LAN setting is for “Easy Connection.” This will call up the “Meeting List” window.
3 Click the Meeting Name to participate, and click [Connect].

The computer will be connected to the selected conference and the attendant window will be displayed. If the presenter selects “Send to PC And Projector”, the image projected from the projector is displayed in the attendant window.
8. User Supportware

• Saving received images

1 Click [Memo] in the attendant window.
   A memo pane will be displayed.

2 Click [Save Image] in the attendant window.
   The image displayed in the attendant window will be saved.
   • The saved image is added to the memo list and a thumbnail is displayed.
   • A memo can be attached to the saved image.

REFERENCE:
• In case of Windows XP, a created file is saved to “My Documents\ImageExpress\” under the default settings. In case of Windows 7/Windows Vista, “Document\ImageExpress\” is the default folder to save a created file.
• A folder is created below the default folder based on the time and date of the conference, and the image is saved to a file in the created folder.
   For example, if a conference is held at 11:20 on May 14, 2009, the default folder name on Windows XP will be “My Documents\ImageExpress\2009-05-14_11-20_Meeting Records”.
   In this folder, an HTML file named “Meeting Records” is created.
   The saved image is saved in “Images” folder.
8. User Supportware

• Downloading disclosed file

1 Click [File Transfer] in the attendant window.
   The “File Transfer” window will be opened.

2 Select a file to download, and click [Download].
   Downloading will begin.
   The progress of the downloading is displayed at the lower left of the window.

3 When downloading is complete, click [File] in the “File Transfer” window, and click [Exit].
   The “File Transfer” window will be closed.

REFERENCE:
• If “Open After Downloading” is checked, the file is opened by specified Windows application software after downloading is complete.
• In case of Windows XP, a created file is saved to “My Documents\ImageExpress1” under the default settings. In case of Windows 7/Windows Vista, “Document\ImageExpress” is the default folder to save a created file.
• A folder is created below the default folder based on the time and date of the conference, and the image is saved to a file in the created folder.
   For example, if a conference is held at 11:20 on May 14, 2009, the default folder name on Windows XP will be “My Documents\ImageExpress\2009-05-14_11-20_Meeting Records”.

1 Click
8. User Supportware

• Changing presenter
Three types of settings may be made to change the presenter: “Not Approved”, “Approved”, and “Changing Prohibited” (these can be selected only by the presenter).
In the following example, “Not Approved” is selected.
• **Click [Become A Presenter] in the attendant window.**
  You will change from a participant to a presenter.

![Image](image.png)

1. Click

• Leaving conference
Leave the conference and exit Image Express Utility 2.0.
• **Click [File] in the attendant window, and click [Exit].**
  You can also leave the conference by clicking [×] at the upper right of the attendant window.
Using Desktop Control Utility 1.0 allows you to remotely operate your computer placed at a distance from the projector over a network (wired LAN or wireless LAN).

What you can do with Desktop Control Utility 1.0

- A commercially available USB mouse is connected to the projector to operate the computer.
- Suppose, for example, a PowerPoint file to be presented in a conference is saved to a computer in your office. If this computer is connected to the projector in the conference room with LAN when the conference is held, the desktop screen of the computer in your office (Windows 7/Windows Vista/Windows XP) can be projected and the PowerPoint file can be presented by operating the projector. In other words the computer does not need to be brought into the conference room.

IMPORTANT:

- You can use the Desktop Control Utility 1.0 to operate a computer located in a separate room from the projector over a network. Therefore, care must be exercised to prevent any third party from viewing the screen of your computer (important documents), copying files, or turning off the power.
- NEC assumes no liability for any loss or damages arising from information leak or system failure while you are using Desktop Control Utility 1.0.
- This will disconnect LAN connection when the computer goes in the standby mode while the Desktop Control Utility 1.0 is being used.
  - In the Windows 7/Windows Vista, select [Control Panel] → [Hardware and Sound] → [Power Options]. Set [Change when the computer sleeps] to [Never].
  - In the Windows XP, click [Control Panel] → [Performance and Maintenance] → [Power Options] → [System Standby] → [Never].
- The screen saver function is off while Desktop Control Utility 1.0 is running.

Connecting the projector to a LAN

Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 150), “Connecting to a Wireless LAN” (→ page 151) and “9 Application Menus - NETWORK SETTINGS” (→ page 120)
Using the projector to operate your computer’s desktop screen

IMPORTANT:

- In case of Windows 7/Windows Vista, disable the user account control before using Desktop Control Utility 1.0. Windows Vista has “User Account Control” function to protect the computer. The user account confirmation window may be displayed.

Since Desktop Control Utility 1.0 cannot transfer the user account confirmation window, this window makes the operation unavailable. Before using Desktop Control Utility 1.0, it is necessary to disable the user account control of Windows 7/Windows Vista. After logging on with the administrator account, follow the procedure below to change the setting:

[Change Procedure]

<For Windows 7>
1. Click [Control Panel] from the Start Menu.
2. Click [User Accounts and Family Safety].
3. Click [User Accounts].
4. Click [Change User Account Control settings].
5. Change [Choose when to be notified about changes to your computer] to [Never notify] and click [OK].
   - If restarting is requested, click [Restart now].

<For Windows Vista>
1. Click [Control Panel] from the Start Menu.
2. Click [User Accounts and Family Safety].
3. Click [User Account].
4. Click [Enable/Disable User Account Control].
5. Remove the checkmark for [Use User Account Control (UAC) to Help Computer Protection] and click [OK].
   - If rebooting is requested, click [Reboot Now].

Upon completion of Desktop Control Utility, it is recommended to enable the user account control.
8. User Supportware

- **Operation on computer**

1. **Click Windows [Start] → [All Programs] → [NEC Projector User Supportware] → [Desktop Control Utility 1.0] → [Desktop Control], in that order.**

   The “Selection Of Network Connections” window is displayed.
   This displays a list of the network devices connected to the computer you are using.

2. **Select the network device to use and click [OK].**

   The “Startup password settings” window will be displayed.
   - In case of Windows 7/Windows Vista, the User Account Control Window is displayed. Click [OK] or input the administrator password.

   ![Screen when Desktop Control Utility 1.0 is started first time already](image1)
   ![Screen if starting password has been set](image2)

   **IMPORTANT:**
   - Be sure to write down the starting password in case you forget it.
   - The starting password must be input each time Desktop Control Utility 1.0 is started.
   - Should you forget the starting password, reinstall the Desktop Control Utility 1.0.
   
   A screen like the one below is displayed when the software is started on a PC installed with Windows XP Service Pack 2 (SP2) (or later). Click “Unblock” if this is displayed.
3 Input the starting password of Desktop Control Utility 1.0, and click [OK].
   The “Current password” window will be displayed.

   ![Image of the Current password window]

   **NOTE:**
   The character string displayed in the password field varies each time Desktop Control Utility 1.0 is started.

4 Write down the character string displayed in the password field.
   Write down “PMHN” in the screen example of step 3.

5 Click [OK].
   Desktop Control Utility 1.0 will be started.
   Move to the room where the projector is installed, with the paper on which you have written down the password in step 4.
• Operating the projector (connecting computer)

1 Connect a USB mouse that is commercially available to the projector.

2 Turn on the power to the projector.
Set the LAN setting of the projector in advance.

3 Press the SOURCE button on the projector unit.
The Source list will be displayed.
In case of the remote control, press the NETWORK button.
The “network menu” screen will be displayed, proceed to step 5.

4 Press the ▼/▲ buttons to select [NETWORK], and then press the ENTER button.
The “network menu” screen will be displayed.
5 Click [DESKTOP CONTROL UTILITY].
The “DESKTOP CONTROL UTILITY menu” screen will be displayed.

6 Click “ENTRY”.
A password input screen will be displayed.

7 Input the password you have written down in step 4 of “Operation on computer”.
• Click the [BS] button on the right side of the [PASSWORD] field to delete the character to the left of the character insertion point.

8 After inputting the password, click the button on the right side of the [PASSWORD] field.
You are returned to the “DESKTOP CONTROL UTILITY” menu screen.

9 Click [COMPUTER SEARCH].
The “COMPUTER LIST” screen will be displayed.

If the connection destination has not been found as a result of a COMPUTER SEARCH, search for the connection destination by inputting the IP address of the computer at the connection destination, click “Input IP Address”.

If the connection destination has not been found as a result of a COMPUTER SEARCH, search for the connection destination by inputting the IP address of the computer at the connection destination, click “Input IP Address”.
10 Click the computer at the connection destination and then [OK].

The desktop screen of the computer at the connection destination will be displayed.

- Operating the projector (manipulating desktop screen)

The displayed desktop screen can be manipulated by using the USB mouse connected to the projector. If the EXIT button of the projector or remote control is pressed while the desktop screen is displayed, an auxiliary operation bar is displayed at the lower left of the screen. Manipulate the auxiliary operation bar by using the buttons of the projector or remote control.
• Operating the projector (disconnecting communications)

1 **Press the EXIT button while the desktop screen is displayed.**

   An auxiliary operation bar will be displayed at the lower left of the screen.

2 **Move the highlight to (cut-off icon) and press the ENTER button.**

   Communication will be disconnected and you are returned to the “DESKTOP CONTROL UTILITY” menu screen.

   To resume communication, click [COMPUTER SEARCH].

   After that, follow step 10 on the preceding page.

**REFERENCE:**
Communication can also be disconnected by clicking the projector icon on the taskbar and then clicking “Disconnect” while the desktop screen is displayed.
8. User Supportware

• Operating the projector (exiting Desktop Control Utility 1.0)

1. **Click the projector icon [ ] on the taskbar while the desktop screen is displayed.**

2. **Click [Exit].**
   
   Desktop Control Utility 1.0 will be terminated.

3. **Press the EXIT button on the projector unit or on the remote control.**
   
   The “network menu” screen will be displayed.

4. **Press the MENU button on the projector unit or on the remote control.**
   
   The on-screen menu will be displayed.

5. **Select an input source other than [NETWORK].**
8. User Supportware

7 Controlling the Projector over a LAN (PC Control Utility Pro 4)

Using the utility software “PC Control Utility Pro 4”, the projector can be controlled from a computer over a LAN.

Control Functions
Power On/Off, signal selection, picture freeze, picture mute, audio mute, adjusting, error message notification, event schedule.

Screen of PC Control Utility Pro 4

This section provides an outline of preparation for use of PC Control Utility Pro 4. For information on how to use PC Control Utility Pro 4, see Help of PC Control Utility Pro 4.

TIP:
• PC Control Utility Pro 4 can be used with a serial connection.

Connect the projector to a LAN.

Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 150), “Connecting to a Wireless LAN (sold separately)” (→ page 151) and “9 Application Menus - NETWORK SETTINGS” (→ page 120)

Start PC Control Utility Pro 4
Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “PC Control Utility Pro 4” → “PC Control Utility Pro 4”.

NOTE:
• For the Schedule function of the PC Control utility Pro 4 to work, you must have your computer running and not in standby/sleep mode. Select “Power Options” from the “Control Panel” in Windows and disable its standby/sleep mode before running the scheduler.

[Example] For Windows 7:
Select “Control Panel” → “System and Security” → “Power Options” → “Change when the computer sleeps” → “Put the computer to sleep” → “Never”.

NOTE:
• When [POWER-SAVING] is selected for [STANDBY MODE] from the menu, the projector cannot be turned on via the network (wired LAN/wireless LAN) connection.

When [NETWORK STANDBY] is selected for [STANDBY MODE], the projector cannot be turned on via wireless LAN connection.

TIP:

Viewing the Help of PC Control Utility Pro 4

• Displaying the Help file of PC Control Utility Pro 4 while it is running.

Click “Help (H)” → “Help (H) …” of window of PC Control Utility Pro 4 in this order.

The pop-up menu will be displayed.

• Displaying the help file using the Start Menu.

Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “PC Control Utility Pro 4” → “PC Control Utility Pro 4 Help”.

The Help screen will be displayed.
Converting PowerPoint files to Slides (Viewer PPT Converter 3.0)

Using Viewer PPT Converter 3.0 allows you to convert PowerPoint files into JPEG files. Converted JPEG files and Index files (.idx) can be saved to a USB memory. When the USB memory inserted into the projector, these JPEG files and Index files (.idx) can be displayed with the viewer function of the projector without connecting a computer.

NOTE:
When Viewer PPT Converter 3.0 has been installed, once start Viewer PPT Converter 3.0 once with the privilege used for installation. Then exit from Viewer PPT Converter 3.0 without doing anything.

• Starting
Click Window’s [Start] → [All Programs] → [NEC Projector User Supportware] → [Viewer PPT Converter 3.0] → [Viewer PPT Converter 3.0], in that order.

NOTE:
• When installing Viewer PPT Converter 3.0 onto a computer that has PowerPoint installed, Viewer PPT Converter 3.0 is automatically registered as a PowerPoint add-in.
  It is necessary to cancel Viewer PPT Converter 3.0 add-in before uninstalling Viewer PPT Converter 3.0.
  Refer to Viewer PPT Converter 3.0 Help to unregister the add-in.
• The projector does not support the add-in’s “Run Slide Show”.

Converting PowerPoint files and saving them to a USB memory
1. Insert the USB memory into the USB port of the computer.
2. On Windows, click “Start” → “All programs” → “NEC Projector User Supportware” → “Viewer PPT Converter 3.0” → “Viewer PPT Converter 3.0”.
   Viewer PPT Converter 3.0 will start.

3. Click “Browse...” and select a PowerPoint file you wish to convert, and then click “Open”.

4. Click “Next”.
5. Select the USB memory drive for “Card Drive” and type in “Index name”.
   Index name must be eight alphanumeric characters or less. 2-byte character and file with a long filename cannot be used.

6. Click “Export”.
   A confirmation message will be displayed.

7. Click “OK”.
   Exporting a file will start.

8. Click “OK”.

9. Click “Exit”.
   Viewer PPT Converter 3.0 will exit.

10. Remove the USB memory from the computer.

NOTE:
• Before removing the USB memory from the USB port of the computer, click the “Safe to Remove Hardware” icon on the taskbar.
9 Projecting Your Mac’s Screen Image from the Projector over a LAN (Image Express Utility 2 for Mac)

Using Image Express Utility 2 for Mac contained allows you to send the Mac’s screen image to the projector over a network (wired or wireless LAN).
Image Express Utility 2 for Mac runs on Mac OS X 10.2.8 or later.
It runs on both Mac OS X (PowerPC) and Mac OS X (Intel).
Hereafter, “Image Express Utility 2 for Mac” is abbreviated as “Image Express Utility 2”.

What you can do with Image Express Utility 2
• Via the network images on the screen of your Mac can be sent to the projector and projected on the screen.
• One computer can send images to more than one projector.

Operating environment
Supported OS
Mac OS X 10.2.8 or later required
Mac OS X 10.3.0 or later recommended
Processor (CPU)
PowerPC G3 600 MHz processor required
PowerPC G4 800 MHz or higher recommended
or
Intel Core Solo 1.5 GHz or higher required
Memory
256 MB or higher required
Network environment
Wired or wireless LAN required that supports TCP/IP
Only the AirPort and AirPort Extreme wireless LAN cards are guaranteed to work with Image Express Utility 2.
“Easy Connection” supports only AirPort and AirPort Extreme.
Supported resolution
VGA (640 × 480) or higher required
XGA (1024 × 768) recommended
(1024 × 768 - 1280 × 800 recommended for PA550W/PA500U)
Supported screen colors
32 thousands of colors, 16.7 million colors required
* 256 or fewer colors are not supported.

Connecting the projector to a LAN
Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 150), “Connecting to a Wireless LAN” (→ page 151) and “9 Application Menus - NETWORK SETTINGS” (→ page 120)
Using Image Express Utility 2

Connecting to a projector

1 Confirm that the projector has been turned on.

2 Click the AirPort status ( ) on the Macintosh menu bar, and click “Turn AirPort On”. The AirPort status is changed to “ ” or “ ”.

- AirPort status types and meanings
  - AirPort : Off
  - AirPort : On ( in infrastructure connection )
  - AirPort : On ( in adhoc connection )

REFERENCE:

When the AirPort status ( / / ) is not displayed on the menu bar:

1 Click Apple Menu ( ) and [System Preferences...]. The “System Preferences” window will be displayed.

2 Click [Network]. The Network configuration window will be displayed.

3 Select [AirPort] in [Show].

4 Click [AirPort] tab. The AirPort configuration item will be displayed.

5 Check the “Show AirPort status in menu bar” check box at the bottom configuration item. The AirPort status ( / / ) will be displayed on the menu bar.

6 Click the [ ] button at the upper left on the Network configuration window. The Network configuration window will be closed.
3 **Double-click the “Image Express Utility 2” icon in the “Image Express Utility 2” folder.**

![Image Express Utility 2]

- At the initial start, the “License Agreement” window is displayed.
  Thoroughly read the agreement shown on the screen, and click “I accept the terms in the license agreement” and the [OK] button.
  Next, the “Authenticate” window will be displayed.

4 **Enter the administrator name and password of your Macintosh computer, and click the [OK] button.**

![Authenticate]

The [Projector Selection] window will be displayed.

![Projector Selection]

5 **Check the (✓) check box to the left of the projector name to connect and click [Connect].**
  The Macintosh computer and the projector are connected via wireless LAN, and images on the Macintosh screen are projected from the projector.

![Connection]
8. User Supportware

Stopping/Restarting Image Transmission

• Stopping image transmission
  1 Click [Tools] on the menu bar, and click [Stop Sending].
  Image transmission is temporarily stopped.

• Restarting image transmission
  1 Click [Tools] on the menu bar, and click [Start Sending].
  Image transmission is started again.

Exiting Image Express Utility 2

1 Click [Image Express Utility 2] on the menu bar, and click [Quit Image Express Utility 2].
Image Express Utility 2 is exited.
9. Appendix

1 Throw distance and screen size

Five separate bayonet style lenses can be used on this projector. Refer to the information on this page and use a lens suited for the installation environment (screen size and throw distance). For instructions on mounting the lens, see page 141.

Lens types and throw distance

<table>
<thead>
<tr>
<th>Screen size</th>
<th>NP11FL</th>
<th>NP12ZL</th>
<th>NP13ZL</th>
<th>NP14ZL</th>
<th>NP15ZL</th>
</tr>
</thead>
<tbody>
<tr>
<td>30&quot;</td>
<td>0.7 - 0.9</td>
<td>0.9 - 1.2</td>
<td>1.2 - 2.4</td>
<td>3.6 - 5.8</td>
<td>5.7 - 8.7</td>
</tr>
<tr>
<td>40&quot;</td>
<td>0.6</td>
<td>0.9 - 1.2</td>
<td>1.2 - 2.4</td>
<td>3.6 - 5.8</td>
<td>5.7 - 8.7</td>
</tr>
<tr>
<td>60&quot;</td>
<td>1.0</td>
<td>1.4 - 1.9</td>
<td>1.8 - 3.7</td>
<td>4.8 - 7.8</td>
<td>7.6 - 11.6</td>
</tr>
<tr>
<td>80&quot;</td>
<td>1.3</td>
<td>1.9 - 2.5</td>
<td>2.4 - 4.9</td>
<td>4.8 - 7.8</td>
<td>7.6 - 11.6</td>
</tr>
<tr>
<td>100&quot;</td>
<td>1.6</td>
<td>2.4 - 3.2</td>
<td>3.0 - 6.1</td>
<td>6.0 - 9.7</td>
<td>9.6 - 14.6</td>
</tr>
<tr>
<td>120&quot;</td>
<td>2.0</td>
<td>2.9 - 3.8</td>
<td>3.7 - 7.4</td>
<td>7.3 - 11.7</td>
<td>11.5 - 17.6</td>
</tr>
<tr>
<td>150&quot;</td>
<td>2.5</td>
<td>3.7 - 4.8</td>
<td>4.6 - 9.2</td>
<td>9.1 - 14.7</td>
<td>14.4 - 22.0</td>
</tr>
<tr>
<td>200&quot;</td>
<td>4.9 - 6.4</td>
<td>6.1 - 12.3</td>
<td>12.2 - 19.6</td>
<td>19.3 - 29.4</td>
<td></td>
</tr>
<tr>
<td>240&quot;</td>
<td>5.9 - 7.7</td>
<td>7.4 - 14.8</td>
<td>14.7 - 23.6</td>
<td>23.2 - 35.3</td>
<td></td>
</tr>
<tr>
<td>300&quot;</td>
<td>7.4 - 9.6</td>
<td>9.2 - 18.5</td>
<td>18.4 - 29.5</td>
<td>29.1 - 44.2</td>
<td></td>
</tr>
<tr>
<td>400&quot;</td>
<td>9.8 - 12.8</td>
<td>12.3 - 24.7</td>
<td>24.6 - 39.4</td>
<td>38.8 - 59.0</td>
<td></td>
</tr>
<tr>
<td>500&quot;</td>
<td>12.3 - 16.0</td>
<td>15.4 - 30.8</td>
<td>30.7 - 49.2</td>
<td>48.6 - 73.8</td>
<td></td>
</tr>
</tbody>
</table>

TIP

Calculation of the throw distance from the screen size

NP11FL lens throw distance (m) = H × 0.8 : 0.6 m (min.) to 2.5 m (max.)

NP12ZL lens throw distance (m) = H × 1.2 to H × 1.6 : 0.7 m (min.) to 16.0 m (max.)

NP13ZL lens throw distance (m) = H × 1.5 to H × 3.0 : 1.2 m (min.) to 30.8 m (max.)

NP14ZL lens throw distance (m) = H × 3.0 to H × 4.8 : 3.6 m (min.) to 49.2 m (max.)

NP15ZL lens throw distance (m) = H × 4.7 to H × 7.3 : 5.7 m (min.) to 73.8 m (max.)

“H” (Horizontal) refers to the screen width.

* Figures differ by several % with the table above because the calculation is approximate.

Ex.: Throw distance when projecting on a 150" screen with the PA600X/PA500X using the NP13ZL lens:

According to the “Screen Size (for reference)” table (→ page 204), H (screen width) = 304.8 cm.

The throw distance is 304.8 cm × 1.5 to 304.8 cm × 3.0 = 457.2 cm to 914.4 cm (because of the zoom lens).
### PA550W

<table>
<thead>
<tr>
<th>Screen size</th>
<th>NP11FL</th>
<th>NP12ZL</th>
<th>NP13ZL</th>
<th>NP14ZL</th>
<th>NP15ZL</th>
</tr>
</thead>
<tbody>
<tr>
<td>30&quot;</td>
<td>0.7 - 1.0</td>
<td>1.0 - 1.3</td>
<td>1.3 - 2.5</td>
<td>3.8 - 6.1</td>
<td>5.9 - 9.1</td>
</tr>
<tr>
<td>40&quot;</td>
<td>1.0</td>
<td>1.5 - 2.0</td>
<td>1.9 - 3.8</td>
<td>3.8 - 6.1</td>
<td>5.9 - 9.1</td>
</tr>
<tr>
<td>60&quot;</td>
<td>1.4</td>
<td>2.0 - 2.6</td>
<td>2.6 - 5.1</td>
<td>5.1 - 8.2</td>
<td>8.0 - 12.2</td>
</tr>
<tr>
<td>80&quot;</td>
<td>1.7</td>
<td>2.5 - 3.3</td>
<td>3.2 - 6.4</td>
<td>6.3 - 10.2</td>
<td>10.0 - 15.4</td>
</tr>
<tr>
<td>100&quot;</td>
<td>2.1</td>
<td>3.1 - 4.0</td>
<td>3.9 - 7.7</td>
<td>7.6 - 12.3</td>
<td>12.1 - 18.5</td>
</tr>
<tr>
<td>120&quot;</td>
<td>2.6</td>
<td>3.8 - 5.0</td>
<td>4.8 - 9.7</td>
<td>9.6 - 15.4</td>
<td>15.2 - 23.1</td>
</tr>
<tr>
<td>150&quot;</td>
<td>3.0</td>
<td>4.7 - 6.7</td>
<td>6.5 - 12.9</td>
<td>12.8 - 20.6</td>
<td>20.3 - 30.9</td>
</tr>
<tr>
<td>200&quot;</td>
<td>6.2</td>
<td>7.8 - 15.5</td>
<td>15.4 - 24.7</td>
<td>24.4 - 37.1</td>
<td></td>
</tr>
<tr>
<td>240&quot;</td>
<td>7.7</td>
<td>9.7 - 19.4</td>
<td>19.3 - 30.9</td>
<td>30.5 - 46.5</td>
<td></td>
</tr>
<tr>
<td>300&quot;</td>
<td>10.3</td>
<td>13.0 - 25.9</td>
<td>25.8 - 41.3</td>
<td>40.7 - 62.0</td>
<td></td>
</tr>
<tr>
<td>400&quot;</td>
<td>12.9</td>
<td>16.2 - 32.4</td>
<td>32.2 - 51.7</td>
<td>51.0 - 77.6</td>
<td></td>
</tr>
</tbody>
</table>

**TIP**

Calculation of the throw distance from the screen size

NP11FL lens throw distance (m) = \( H \times 0.8 \) : 0.7 m (min.) to 2.6 m (max.)

NP12ZL lens throw distance (m) = \( H \times 1.2 \) to \( H \times 1.6 \) : 0.7 m (min.) to 16.8 m (max.)

NP13ZL lens throw distance (m) = \( H \times 1.5 \) to \( H \times 3.0 \) : 1.3 m (min.) to 32.4 m (max.)

NP14ZL lens throw distance (m) = \( H \times 3.0 \) to \( H \times 4.8 \) : 3.8 m (min.) to 51.7 m (max.)

NP15ZL lens throw distance (m) = \( H \times 4.7 \) to \( H \times 7.2 \) : 5.9 m (min.) to 77.6 m (max.)

“H” (Horizontal) refers to the screen width.

* Figures differ by several % with the table above because the calculation is approximate.

Ex.: Throw distance when projecting on a 150" screen with the PA550W using the NP13ZL lens:

According to the “Screen Size (for reference)” table (→ page 204), \( H \) (screen width) = 323.1 cm.

The throw distance is \( 323.1 \text{ cm} \times 1.5 \) to \( 323.1 \text{ cm} \times 3.0 = 484.7 \text{ cm to 969.3 cm} \) (because of the zoom lens).

### PA500U

<table>
<thead>
<tr>
<th>Screen size</th>
<th>NP11FL</th>
<th>NP12ZL</th>
<th>NP13ZL</th>
<th>NP14ZL</th>
<th>NP15ZL</th>
</tr>
</thead>
<tbody>
<tr>
<td>30&quot;</td>
<td>0.7 - 0.9</td>
<td>1.0 - 1.3</td>
<td>1.2 - 2.5</td>
<td>3.7 - 6.0</td>
<td>5.9 - 9.0</td>
</tr>
<tr>
<td>40&quot;</td>
<td>1.0</td>
<td>1.5 - 1.9</td>
<td>1.9 - 3.8</td>
<td>3.7 - 6.0</td>
<td>5.9 - 9.0</td>
</tr>
<tr>
<td>60&quot;</td>
<td>1.4</td>
<td>2.0 - 2.6</td>
<td>2.5 - 5.1</td>
<td>5.0 - 8.0</td>
<td>7.9 - 12.1</td>
</tr>
<tr>
<td>80&quot;</td>
<td>1.7</td>
<td>2.5 - 3.3</td>
<td>3.2 - 6.3</td>
<td>6.3 - 10.1</td>
<td>9.9 - 15.1</td>
</tr>
<tr>
<td>100&quot;</td>
<td>2.1</td>
<td>3.0 - 3.9</td>
<td>3.4 - 7.6</td>
<td>7.5 - 12.1</td>
<td>11.9 - 18.2</td>
</tr>
<tr>
<td>120&quot;</td>
<td>2.6</td>
<td>3.8 - 4.9</td>
<td>4.8 - 9.5</td>
<td>9.4 - 15.2</td>
<td>14.9 - 22.8</td>
</tr>
<tr>
<td>150&quot;</td>
<td>5.1</td>
<td>6.6 - 12.7</td>
<td>12.6 - 20.3</td>
<td>20.0 - 30.5</td>
<td></td>
</tr>
<tr>
<td>200&quot;</td>
<td>6.1</td>
<td>7.6 - 15.3</td>
<td>15.2 - 24.4</td>
<td>24.0 - 36.6</td>
<td></td>
</tr>
<tr>
<td>240&quot;</td>
<td>7.6</td>
<td>9.6 - 19.1</td>
<td>19.0 - 31.5</td>
<td>30.1 - 45.8</td>
<td></td>
</tr>
<tr>
<td>300&quot;</td>
<td>10.2</td>
<td>12.8 - 25.5</td>
<td>25.4 - 40.7</td>
<td>40.1 - 61.1</td>
<td></td>
</tr>
<tr>
<td>400&quot;</td>
<td>12.7</td>
<td>16.0 - 31.9</td>
<td>31.8 - 50.9</td>
<td>50.2 - 76.4</td>
<td></td>
</tr>
</tbody>
</table>

**TIP**

Calculation of the throw distance from the screen size

NP11FL lens throw distance (m) = \( H \times 0.8 \) : 0.5 m (min.) to 2.6 m (max.)

NP12ZL lens throw distance (m) = \( H \times 1.2 \) to \( H \times 1.5 \) : 0.7 m (min.) to 16.5 m (max.)

NP13ZL lens throw distance (m) = \( H \times 1.5 \) to \( H \times 3.0 \) : 1.2 m (min.) to 31.9 m (max.)

NP14ZL lens throw distance (m) = \( H \times 2.9 \) to \( H \times 4.7 \) : 3.7 m (min.) to 50.9 m (max.)

NP15ZL lens throw distance (m) = \( H \times 4.6 \) to \( H \times 7.1 \) : 5.9 m (min.) to 76.4 m (max.)

“H” (Horizontal) refers to the screen width.

* Figures differ by several % with the table above because the calculation is approximate.

Ex.: Throw distance when projecting on a 150" screen with the PA500U using the NP13ZL lens:

According to the “Screen Size (for reference)” table (→ page 204), \( H \) (screen width) = 323.1 cm.

The throw distance is \( 323.1 \text{ cm} \times 1.5 \) to \( 323.1 \text{ cm} \times 3.0 = 484.7 \text{ cm to 969.3 cm} \) (because of the zoom lens).
## Projection range for the different lenses

<table>
<thead>
<tr>
<th>Lenses</th>
<th>Projection Range</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PA600X/PA500X</strong></td>
<td>40-150”</td>
</tr>
<tr>
<td><strong>PA550W</strong></td>
<td>40-500”</td>
</tr>
<tr>
<td><strong>PA500U</strong></td>
<td>60-500”</td>
</tr>
</tbody>
</table>

- **PA600X/PA500X**
  - NP11FL: 0.6 - 2.5m
  - NP12FL: 0.7 - 16.0m
  - NP13FL: 1.2 - 30.8m
  - NP14FL: 3.6 - 49.2m
  - NP15FL: 5.7 - 73.8m

- **PA550W**
  - NP11FL: 0.7 - 2.6m
  - NP12FL: 0.7 - 16.8m
  - NP13FL: 1.2 - 32.4m
  - NP14FL: 3.8 - 51.7m
  - NP15FL: 5.9 - 77.6m

- **PA500U**
  - NP11FL: 0.5 - 2.6m
  - NP12FL: 0.5 - 16.5m
  - NP13FL: 1.2 - 31.9m
  - NP14FL: 3.7 - 50.9m
  - NP15FL: 5.9 - 76.4m
## Tables of screen sizes and dimensions

### PA600X/PA500X

<table>
<thead>
<tr>
<th>Size (inches)</th>
<th>Screen width (inches)</th>
<th>Screen height (inches)</th>
<th>Screen width (cm)</th>
<th>Screen height (cm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>30</td>
<td>24</td>
<td>18</td>
<td>61.0</td>
<td>45.7</td>
</tr>
<tr>
<td>40</td>
<td>32</td>
<td>24</td>
<td>81.3</td>
<td>61.0</td>
</tr>
<tr>
<td>60</td>
<td>48</td>
<td>36</td>
<td>121.9</td>
<td>91.4</td>
</tr>
<tr>
<td>80</td>
<td>64</td>
<td>48</td>
<td>162.6</td>
<td>121.9</td>
</tr>
<tr>
<td>100</td>
<td>80</td>
<td>60</td>
<td>203.2</td>
<td>152.4</td>
</tr>
<tr>
<td>120</td>
<td>96</td>
<td>72</td>
<td>243.8</td>
<td>182.9</td>
</tr>
<tr>
<td>150</td>
<td>120</td>
<td>90</td>
<td>304.8</td>
<td>228.6</td>
</tr>
<tr>
<td>200</td>
<td>160</td>
<td>120</td>
<td>406.4</td>
<td>304.8</td>
</tr>
<tr>
<td>240</td>
<td>192</td>
<td>144</td>
<td>487.7</td>
<td>365.8</td>
</tr>
<tr>
<td>300</td>
<td>240</td>
<td>180</td>
<td>609.6</td>
<td>457.2</td>
</tr>
<tr>
<td>400</td>
<td>320</td>
<td>240</td>
<td>812.8</td>
<td>609.6</td>
</tr>
<tr>
<td>500</td>
<td>400</td>
<td>300</td>
<td>1016.0</td>
<td>762.0</td>
</tr>
</tbody>
</table>

### PA550W/PA500U

<table>
<thead>
<tr>
<th>Size (inches)</th>
<th>Screen width (inches)</th>
<th>Screen height (inches)</th>
<th>Screen width (cm)</th>
<th>Screen height (cm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>30</td>
<td>25.4</td>
<td>15.9</td>
<td>64.6</td>
<td>40.4</td>
</tr>
<tr>
<td>40</td>
<td>33.9</td>
<td>21.2</td>
<td>86.2</td>
<td>53.8</td>
</tr>
<tr>
<td>60</td>
<td>50.9</td>
<td>31.8</td>
<td>129.2</td>
<td>80.8</td>
</tr>
<tr>
<td>80</td>
<td>67.8</td>
<td>42.4</td>
<td>172.3</td>
<td>107.7</td>
</tr>
<tr>
<td>100</td>
<td>84.8</td>
<td>53.0</td>
<td>215.4</td>
<td>134.6</td>
</tr>
<tr>
<td>120</td>
<td>101.8</td>
<td>63.6</td>
<td>258.5</td>
<td>161.5</td>
</tr>
<tr>
<td>150</td>
<td>127.2</td>
<td>79.5</td>
<td>323.1</td>
<td>201.9</td>
</tr>
<tr>
<td>200</td>
<td>169.6</td>
<td>106.0</td>
<td>430.8</td>
<td>269.2</td>
</tr>
<tr>
<td>240</td>
<td>203.5</td>
<td>127.2</td>
<td>516.9</td>
<td>323.1</td>
</tr>
<tr>
<td>300</td>
<td>254.4</td>
<td>159.0</td>
<td>646.2</td>
<td>403.9</td>
</tr>
<tr>
<td>400</td>
<td>339.2</td>
<td>212.0</td>
<td>861.6</td>
<td>538.5</td>
</tr>
<tr>
<td>500</td>
<td>424.0</td>
<td>265.0</td>
<td>1077.0</td>
<td>673.1</td>
</tr>
</tbody>
</table>
**Lens shifting range**

This projector is equipped with a lens shift function for adjusting the position of the projected image by turning the lens shift dials. The lens can be shifted within the range shown below.

Description of symbols: V indicates vertical (height of the projected image), H indicates horizontal (width of the projected image).

**NOTE:** The lens shift function cannot be used when using the NP11FL lens.

**PA600X/PA500X**

Desk/front projection

Ceiling/front projector

**PA550W**

Desk/front projection
9. Appendix

Ceiling/front projector

![Diagram of Ceiling/front projector]

PA500U

Desk/front projection

![Diagram of Desk/front projection]

Ceiling/front projector

![Diagram of Ceiling/front projector]

NOTE*: Horizontal lens shift range is 0.15H at more than 150" projected image with the lens NP13ZL.

Ex.: When projecting on a 150" screen
This section is illustrated in the example for PA600X/PA500X (4:3)
- The following description can apply to the PA550W and PA500U (16:10). To calculate, use screen sizes and the maximum value for the lens shift for PA550W and PA500U.
According to the tables of screen sizes and dimensions (→ page 204), H = 304.8 cm, V = 228.6 cm.
Adjustment range in the vertical direction: The projected image can be moved upwards 0.5 × 228.6 cm = 114 cm, downwards 0.1 × 228.6 cm = 22 cm (when the lens is at the center position). For a ceiling/front installation, the above figures are inverted.
Adjustment range in the horizontal direction: The projected image can be moved to the left 0.3 × 304.8 cm = 91 cm, to the right 0.3 × 304.8 cm = 91 cm.
* Figures differ by several % because the calculation is approximate.
## Compatible Input Signal List

### Analog RGB

<table>
<thead>
<tr>
<th>Signal</th>
<th>Resolution (dots)</th>
<th>Aspect Ratio</th>
<th>Refresh Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>VGA</td>
<td>640 × 480</td>
<td>4 : 3</td>
<td>60/72/75/85/iMac</td>
</tr>
<tr>
<td>SVGA</td>
<td>800 × 600</td>
<td>4 : 3</td>
<td>56/60/72/75/85/iMac</td>
</tr>
<tr>
<td>XGA</td>
<td>1024 × 768</td>
<td>4 : 3</td>
<td>60/70/75/85/iMac</td>
</tr>
<tr>
<td>XGA+</td>
<td>1152 × 864</td>
<td>4 : 3</td>
<td>60/70/75/85</td>
</tr>
<tr>
<td>WXGA</td>
<td>1280 × 768</td>
<td>15 : 9</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>1280 × 800</td>
<td>16 : 10</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>1360 × 768</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>1366 × 768</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>Quad-VGA</td>
<td>1280 × 960</td>
<td>4 : 3</td>
<td>60/75/85</td>
</tr>
<tr>
<td>SXGA</td>
<td>1280 × 1024</td>
<td>5 : 4</td>
<td>60/75/85</td>
</tr>
<tr>
<td>SXGA+</td>
<td>1400 × 1050</td>
<td>4 : 3</td>
<td>60/75</td>
</tr>
<tr>
<td>WXGA+</td>
<td>1440 × 900</td>
<td>16 : 10</td>
<td>60</td>
</tr>
<tr>
<td>WXGA++</td>
<td>1600 × 900</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>UXGA</td>
<td>1600 × 1200</td>
<td>4 : 3</td>
<td>60/65/70/75</td>
</tr>
<tr>
<td>WSXGA+</td>
<td>1680 × 1050</td>
<td>16 : 10</td>
<td>60</td>
</tr>
<tr>
<td>WUXGA+</td>
<td>1920 × 1200</td>
<td>16 : 10</td>
<td>60 (Reduced Blanking)</td>
</tr>
<tr>
<td>HD</td>
<td>1280 × 720</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>Full HD</td>
<td>1920 × 1080</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>MAC 13”</td>
<td>640 × 480</td>
<td>4 : 3</td>
<td>67</td>
</tr>
<tr>
<td>MAC 16”</td>
<td>832 × 624</td>
<td>4 : 3</td>
<td>75</td>
</tr>
<tr>
<td>MAC 19”</td>
<td>1024 × 768</td>
<td>4 : 3</td>
<td>75</td>
</tr>
<tr>
<td>MAC 21”</td>
<td>1152 × 870</td>
<td>4 : 3</td>
<td>75</td>
</tr>
<tr>
<td>MAC 23”</td>
<td>1280 × 1024</td>
<td>5 : 4</td>
<td>65</td>
</tr>
</tbody>
</table>

### HDMI

<table>
<thead>
<tr>
<th>Signal</th>
<th>Resolution (dots)</th>
<th>Aspect Ratio</th>
<th>Refresh Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>VGA</td>
<td>640 × 480</td>
<td>4 : 3</td>
<td>60</td>
</tr>
<tr>
<td>SVGA</td>
<td>800 × 600</td>
<td>4 : 3</td>
<td>60</td>
</tr>
<tr>
<td>XGA</td>
<td>1024 × 768</td>
<td>4 : 3</td>
<td>60</td>
</tr>
<tr>
<td>HD</td>
<td>1280 × 720</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>WXGA</td>
<td>1280 × 768</td>
<td>15 : 9</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>1280 × 800</td>
<td>16 : 10</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>1366 × 768</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>Quad-VGA</td>
<td>1280 × 960</td>
<td>4 : 3</td>
<td>60/75/85</td>
</tr>
<tr>
<td>SXGA</td>
<td>1280 × 1024</td>
<td>5 : 4</td>
<td>60/75/85</td>
</tr>
<tr>
<td>SXGA+</td>
<td>1400 × 1050</td>
<td>4 : 3</td>
<td>60/75</td>
</tr>
<tr>
<td>WXGA+</td>
<td>1440 × 900</td>
<td>16 : 10</td>
<td>60</td>
</tr>
<tr>
<td>WXGA++</td>
<td>1600 × 900</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>WSXGA+</td>
<td>1680 × 1050</td>
<td>16 : 10</td>
<td>60</td>
</tr>
<tr>
<td>UXGA</td>
<td>1600 × 1200</td>
<td>4 : 3</td>
<td>60</td>
</tr>
<tr>
<td>Full HD</td>
<td>1920 × 1080</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>WUXGA+</td>
<td>1920 × 1200</td>
<td>16 : 10</td>
<td>60 (Reduced Blanking)</td>
</tr>
<tr>
<td>HDTV(1080p)</td>
<td>1920 × 1080</td>
<td>16 : 9</td>
<td>50/60</td>
</tr>
<tr>
<td>HDTV(1080i)</td>
<td>1920 × 1080</td>
<td>16 : 9</td>
<td>50/60</td>
</tr>
<tr>
<td>HDTV(720p)</td>
<td>1280 × 720</td>
<td>16 : 9</td>
<td>50/60</td>
</tr>
<tr>
<td>SDTV(480p)</td>
<td>720 × 480</td>
<td>4:3 / 16:9</td>
<td>60</td>
</tr>
<tr>
<td>SDTV(576p)</td>
<td>720 × 576</td>
<td>4:3 / 16:9</td>
<td>50</td>
</tr>
<tr>
<td>SDTV(480i)</td>
<td>1440 × 480</td>
<td>4:3 / 16:9</td>
<td>60</td>
</tr>
<tr>
<td>SDTV(576i)</td>
<td>1440 × 576</td>
<td>4:3 / 16:9</td>
<td>50</td>
</tr>
</tbody>
</table>
### DisplayPort

<table>
<thead>
<tr>
<th>Signal</th>
<th>Resolution (dots)</th>
<th>Aspect Ratio</th>
<th>Refresh Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>VGA</td>
<td>640 x 480</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>SVGA</td>
<td>800 x 600</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>XGA</td>
<td>1024 x 768</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>HD</td>
<td>1280 x 720</td>
<td>16:9</td>
<td>60</td>
</tr>
<tr>
<td>WXGA</td>
<td>1280 x 768</td>
<td>16:9</td>
<td>60</td>
</tr>
<tr>
<td>Quad-VGA</td>
<td>1280 x 960</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>SXGA</td>
<td>1280 x 1024</td>
<td>5:4</td>
<td>60</td>
</tr>
<tr>
<td>SXGA+</td>
<td>1400 x 1050</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>WXGA+</td>
<td>1440 x 900</td>
<td>16:10</td>
<td>60</td>
</tr>
<tr>
<td>WXGA++</td>
<td>1600 x 900</td>
<td>16:9</td>
<td>60</td>
</tr>
<tr>
<td>WSXGA+</td>
<td>1680 x 1050</td>
<td>16:10</td>
<td>60</td>
</tr>
<tr>
<td>UXGA</td>
<td>1600 x 1200</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>Full HD</td>
<td>1920 x 1080</td>
<td>16:9</td>
<td>60</td>
</tr>
<tr>
<td>WUXGA</td>
<td>1920 x 1200</td>
<td>16:10</td>
<td>60 (Reduced Blanking)</td>
</tr>
<tr>
<td>HDTV(1080p)</td>
<td>1920 x 1080</td>
<td>16:9</td>
<td>50/60</td>
</tr>
<tr>
<td>HDTV(720p)</td>
<td>1280 x 720</td>
<td>16:9</td>
<td>50/60</td>
</tr>
<tr>
<td>SDTV(480p)</td>
<td>720 x 480</td>
<td>4:3 / 16:9</td>
<td>60</td>
</tr>
<tr>
<td>SDTV(576p)</td>
<td>720 x 576</td>
<td>4:3 / 16:9</td>
<td>50</td>
</tr>
</tbody>
</table>

### Component

<table>
<thead>
<tr>
<th>Signal</th>
<th>Resolution (dots)</th>
<th>Aspect Ratio</th>
<th>Refresh Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDTV(1080p)</td>
<td>1920 x 1080</td>
<td>16:9</td>
<td>50/60</td>
</tr>
<tr>
<td>HDTV(1080i)</td>
<td>1920 x 1080</td>
<td>16:9</td>
<td>50/60</td>
</tr>
<tr>
<td>HDTV(720p)</td>
<td>1280 x 720</td>
<td>16:9</td>
<td>50/60</td>
</tr>
<tr>
<td>SDTV(480p)</td>
<td>720 x 480</td>
<td>4:3 / 16:9</td>
<td>60</td>
</tr>
<tr>
<td>SDTV(576p)</td>
<td>720 x 576</td>
<td>4:3 / 16:9</td>
<td>50</td>
</tr>
</tbody>
</table>

### Composite Video/S-Video

<table>
<thead>
<tr>
<th>Signal</th>
<th>Aspect Ratio</th>
<th>Refresh Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>PAL</td>
<td>4:3</td>
<td>50</td>
</tr>
<tr>
<td>PAL60</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>SECAM</td>
<td>4:3</td>
<td>50</td>
</tr>
</tbody>
</table>

*1 Native resolution on XGA model (PA600X/PA500X)
*2 Native resolution on WXGA model (PA550W)
*3 Native resolution on WUXGA model (PA500U)
*4 The projector may fail to display these signals correctly when [AUTO] is selected for [ASPECT RATIO] in the on-screen menu. The factory default is [AUTO] for [ASPECT RATIO]. To display these signals, select [16:9] for [ASPECT RATIO].
*5 The projector may fail to display these signals correctly when [AUTO] is selected for [ASPECT RATIO] in the on-screen menu. The factory default is [AUTO] for [ASPECT RATIO]. To display these signals, select [4:3] for [ASPECT RATIO].

- Signals exceeding the projector’s resolution are handled with Advanced AccuBlend.
- With Advanced AccuBlend, the size of characters and ruled lines may be uneven and colors may be blurred.
- Upon shipment, the projector is set for signals with standard display resolutions and frequencies, but adjustments may be required depending on the type of computer.
## Specifications

<table>
<thead>
<tr>
<th>Model name</th>
<th>PA600X/PA500X/PA550W/PA500U</th>
</tr>
</thead>
<tbody>
<tr>
<td>Method</td>
<td>Three primary color liquid crystal shutter projection method</td>
</tr>
</tbody>
</table>

### Specifications of main parts

<table>
<thead>
<tr>
<th>Liquid crystal panel</th>
<th>Size</th>
<th>Pixels (*1)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>PA600X/PA500X: 0.79&quot; (with MLA) × 3 (aspect ratio: 4:3)</td>
<td>PA600X/PA500X: 786,432 (1024 dots × 768 lines)</td>
</tr>
<tr>
<td></td>
<td>PA550W: 0.75&quot; (with MLA) × 3 (aspect ratio: 16:10)</td>
<td>PA550W: 1,024,000 (1280 dots × 800 lines)</td>
</tr>
<tr>
<td></td>
<td>PA500U: 0.76&quot; (with MLA) × 3 (aspect ratio: 16:10)</td>
<td>PA500U: 2,304,000 (1920 dots × 1200 lines)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Projection lenses</th>
<th>Zoom</th>
<th>Focus</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Manual (zoom range depends on lens)</td>
<td>Manual</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Light output (*2) ECO OFF</th>
<th>Light output (*2) ECO ON(80 %)</th>
</tr>
</thead>
<tbody>
<tr>
<td>PA600X: 6000 lm, PA500X: 5000 lm, PA550W: 5500 lm, PA500U: 5000 lm</td>
<td>PA600X: 4800 lm, PA500X: 4000 lm, PA550W: 4400 lm, PA500U: 4000 lm</td>
</tr>
</tbody>
</table>

| Contrast ratio (*2) (all white/all black) | 2000:1 |
| Screen size (throw distance)               | 30" to 500" (throw distance depends on lens) |
| Color reproducibility                     | 10-bit color processing (approx. 1.07 billion colors) (*4) |

<table>
<thead>
<tr>
<th>Audio output</th>
<th>Built-in 10W monaural speaker</th>
</tr>
</thead>
</table>

### Main adjustment functions

- Manual zoom, manual focus, manual lens shift, input signal switching (Computer/HDMI/DisplayPort/Video/S-Video/Viewer/Network), auto image adjustment, picture enlarging, picture position adjustment, muting (both video and audio), power on/off, on-screen display/selection, etc.

### Max. display resolution (horizontal × vertical)

- PA600X/PA500X/PA550W: 1920 × 1200 (handled with Advanced AccuBlend)
- PA500U: 1920 × 1200

### Input signals

<table>
<thead>
<tr>
<th>R,G,B,H,V</th>
</tr>
</thead>
<tbody>
<tr>
<td>RGB: 0.7Vp-p/75Ω</td>
</tr>
<tr>
<td>Y: 1.0Vp-p/75Ω (with Negative Polarity Sync)</td>
</tr>
<tr>
<td>Cb, Cr (Pb, Pr): 0.7Vp-p/75Ω</td>
</tr>
<tr>
<td>H/V Sync: 4.0Vp-p/TTL</td>
</tr>
<tr>
<td>Composite Sync: 4.0Vp-p/TTL</td>
</tr>
<tr>
<td>Sync on G: 1.0Vp-p/75Ω (with Sync)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Composite video</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0Vp-p/75Ω</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>S-Video</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y: 1.0Vp-p/75Ω</td>
</tr>
<tr>
<td>C: 286Vp-p/75Ω</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y: 1.0Vp-p/75Ω (with Sync)</td>
</tr>
<tr>
<td>Cb, Cr (Pb, Pr): 0.7Vp-p/75Ω</td>
</tr>
<tr>
<td>DTV: 480i, 480p, 720p, 1080i, 1080p (60Hz)</td>
</tr>
<tr>
<td>576i, 576p, 720p, 1080i (50Hz)</td>
</tr>
<tr>
<td>DVD: Progressive signal (50/60Hz)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Audio</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.5Vrms/22kΩ or greater</td>
</tr>
<tr>
<td>Model name</td>
</tr>
<tr>
<td>------------</td>
</tr>
<tr>
<td>Input/output connectors</td>
</tr>
<tr>
<td><strong>Computer/Component</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>HDMI</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>DisplayPort</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Video</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>S-Video</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>PC control connector</strong></td>
</tr>
<tr>
<td><strong>USB port</strong></td>
</tr>
<tr>
<td><strong>USB port for wireless LAN</strong></td>
</tr>
<tr>
<td><strong>LAN port</strong></td>
</tr>
<tr>
<td><strong>Remote connector</strong></td>
</tr>
<tr>
<td><strong>Usage environment</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Power supply</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Rated input current</strong></td>
</tr>
<tr>
<td><strong>External dimensions</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Weight</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

*1: Effective pixels are more than 99.99%.
*2 This is the light output value (lumens) when the [PRESET] mode is set to [HIGH-BRIGHT]. If any other mode is selected as the [PRESET] mode, the light output value may drop slightly.
*3 Compliance with ISO21118-2005
*4: Full color (approx. 16.77 million colors or greater) when the HDMI, DisplayPort, viewer or network input connector is selected.
*5: HDMI® (Deep Color, Lip Sync) with HDCP
What is HDCP/HDCP technology?
HDCP is an acronym for High-bandwidth Digital Content Protection. High bandwidth Digital Content Protection (HDCP) is a system for preventing illegal copying of video data sent over a Digital Visual Interface (DVI). If you are unable to view material via the HDMI input, this does not necessarily mean the projector is not functioning properly. With the implementation of HDCP, there may be cases in which certain content is protected with HDCP and might not be displayed due to the decision/intention of the HDCP community (Digital Content Protection, LLC).
*6: 35 to 40ºC – “Forced eco mode”
- These specifications and the product’s design are subject to change without notice.
Cabinet Dimensions

Unit: mm (inch)
Mounting the separately sold cable cover on the projector allows you hide the cables for a cleaner appearance.

⚠️ CAUTION
- After mounting the cable cover, be sure to fasten using the screws provided. If not, the cable cover could fall, damaging the cable cover and possibly resulting in injury.
- Do not bundle the power cord and place it under the cable cover. Doing so could lead to fire.
- Do not apply excessive force to the cable cover. Doing so could damage the cable cover, resulting in the projector falling or causing injury.

Mounting
Preparations:
1. Connect the power cord and cables to the projector (the connection cords are omitted from the diagrams).
2. Prepare a Phillips screwdriver.

1. Insert the two round protrusions on the left and right edges of the cable cover into the grooves in the bottom of the projector to line it up.

NOTE: Be careful not to let the power cord and cables get pinched by the cable cover.

2. Turn the cable cover screw clockwise.
   - Tighten the screw securely.

Removing
1. Turn the cable cover screw counterclockwise until it turns loosely.
   - Hold the cable cover while doing this to prevent it from falling.
   - The screw does not come completely off.

2. Remove the cable cover.
   - Turn the cable cover a little, then lift it off.
Pin Assignments of D-Sub COMPUTER Input Connector

Mini D-Sub 15 Pin Connector

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>RGB Signal (Analog)</th>
<th>YCbCr Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Red</td>
<td>Cr</td>
</tr>
<tr>
<td>2</td>
<td>Green or Sync on Green</td>
<td>Y</td>
</tr>
<tr>
<td>3</td>
<td>Blue</td>
<td>Cb</td>
</tr>
<tr>
<td>4</td>
<td>Ground</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Red Ground</td>
<td>Cr Ground</td>
</tr>
<tr>
<td>7</td>
<td>Green Ground</td>
<td>Y Ground</td>
</tr>
<tr>
<td>8</td>
<td>Blue Ground</td>
<td>Cb Ground</td>
</tr>
<tr>
<td>9</td>
<td>No Connection</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Sync Signal Ground</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>No Connection</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Bi-directional DATA (SDA)</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Horizontal Sync or Composite Sync</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Vertical Sync</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Data Clock</td>
<td></td>
</tr>
</tbody>
</table>
## Troubleshooting

This section helps you resolve problems you may encounter while setting up or using the projector.

### Indicator Messages

#### Power Indicator

<table>
<thead>
<tr>
<th>Indicator display</th>
<th>Projector status</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Power is off.</td>
<td>–</td>
</tr>
<tr>
<td>Flashing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Blue (short flashes)</td>
<td>Preparing to turn power on</td>
<td>Wait a while.</td>
</tr>
<tr>
<td>Blue (long flashes)</td>
<td>Off timer (enabled)</td>
<td>–</td>
</tr>
<tr>
<td>Orange (short flashes)</td>
<td>Projector cooling</td>
<td>Wait a while.</td>
</tr>
<tr>
<td>Orange (long flashes)</td>
<td>Program timer (off time enabled)</td>
<td>–</td>
</tr>
<tr>
<td>Lit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Blue</td>
<td>Power on</td>
<td>–</td>
</tr>
<tr>
<td>Orange</td>
<td>Standby mode (NORMAL or NETWORK STANDBY)</td>
<td>–</td>
</tr>
<tr>
<td>Red</td>
<td>Standby mode (POWER-SAVING)</td>
<td>–</td>
</tr>
</tbody>
</table>

#### Status Indicator

<table>
<thead>
<tr>
<th>Indicator display</th>
<th>Projector status</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>No problem, or standby mode (POWER-SAVING or NETWORK STANDBY)</td>
<td>–</td>
</tr>
<tr>
<td>Flashing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Red (cycles of 1)</td>
<td>Cover problem</td>
<td>The lamp cover is not properly mounted. Mount it properly. (<a href="#">→ Page 161</a>)</td>
</tr>
<tr>
<td>Red (cycles of 4)</td>
<td>Fan problem</td>
<td>The cooling fan has stopped turning. Contact an NEC projector customer support center for repairs.</td>
</tr>
<tr>
<td>Red (cycles of 9)</td>
<td>Iris error</td>
<td>The iris is not operating properly. Contact an NEC projector customer support center for repairs.</td>
</tr>
<tr>
<td>Flashing</td>
<td>Network conflict</td>
<td>It is not possible to connect the projector’s built-in LAN and wireless LAN simultaneously to the same network. To connect the projector’s built-in LAN and wireless LAN simultaneously, connect them to different networks.</td>
</tr>
<tr>
<td>Lit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Green</td>
<td>Standby mode (NORMAL)</td>
<td>–</td>
</tr>
<tr>
<td>Orange</td>
<td>Button has been pressed while projector is in key lock mode</td>
<td>The projector’s keys are locked. The setting must be canceled to operate the projector. (<a href="#">→ Page 106</a>)</td>
</tr>
<tr>
<td></td>
<td>Projector’s ID number and remote control’s ID number do not match</td>
<td>Check the control IDs. (<a href="#">→ Pages 106 and 107</a>)</td>
</tr>
</tbody>
</table>
### Lamp Indicator

<table>
<thead>
<tr>
<th>Indicator display</th>
<th>Projector status</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>The lamp is turned off.</td>
<td>–</td>
</tr>
<tr>
<td>Flashing Green</td>
<td>Preparing to relight lamp after lighting has failed</td>
<td>Wait a while.</td>
</tr>
<tr>
<td>Red</td>
<td>Lamp replacement grace period</td>
<td>The lamp has reached the end of its service life and is now in the replacement grace period (100 hours). Replace the lamp as soon as possible. (→ page 159)</td>
</tr>
<tr>
<td>Red (cycles of 6)</td>
<td>Lamp does not light</td>
<td>The lamp has not turned on. Wait at least 1 minute, then turn the power back on. If the lamp still does not light, contact an NEC projector customer support center.</td>
</tr>
<tr>
<td>Lit Red</td>
<td>Lamp usage time exceeded</td>
<td>The lamp has exceeded its usage time. The projector’s power cannot be turned on until the lamp is replaced. (→ page 159)</td>
</tr>
<tr>
<td>Lit Orange</td>
<td>High surrounding temperature</td>
<td>The surrounding temperature is high. Lower the room temperature.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Indicator display</th>
<th>Projector status</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>No problem</td>
<td></td>
</tr>
<tr>
<td>Flashing Red (cycles of 2)</td>
<td>Temperature problem</td>
<td>The temperature protector has been activated. If the room temperature is high, move the projector to a cool place. If the problem still persists, contact an NEC projector customer support center.</td>
</tr>
<tr>
<td>Lit Orange</td>
<td>High surrounding temperature</td>
<td>The surrounding temperature is high. Lower the room temperature.</td>
</tr>
</tbody>
</table>

### Temp. Indicator

**If the temperature protector is activated**

If the projector’s internal temperature rises abnormally, the lamp turns off and the temperature indicator flashes (repeatedly in cycles of 2).

It may happen that the projector’s temperature protector is simultaneously activated and the projector’s power turns off.

If this happens, do the following:

- Unplug the power cord from the power outlet.
- If using in a place where the surrounding temperature is high, move the projector to a different, cool place.
- If there is dust in the ventilation holes, clean. (→ pages 155 and 158)
- Wait as such about 1 hour for the projector’s internal temperature to lower.
### 9. Appendix

#### Common Problems & Solutions

(→ “Power/Status/Lamp Indicator” on page 214.)

<table>
<thead>
<tr>
<th>Problem</th>
<th>Check These Items</th>
</tr>
</thead>
</table>
| Does not turn on or shut down | • Check that the power cord is plugged in and that the power button on the projector cabinet or the remote control is on. (→ pages 13, 14)  
  • Ensure that the lamp cover is installed correctly. (→ page 161)  
  • Check to see if the projector has overheated. If there is insufficient ventilation around the projector or if the room where you are presenting is particularly warm, move the projector to a cooler location.  
  • Check to see if you continue to use the projector for another 100 hours after the lamp has reached the end of its life. If so, replace the lamp. After replacing the lamp, reset the lamp hours used. (→ page 116)  
  • The lamp may fail to light. Wait a full minute and then turn on the power again.  
  • Set [FAN MODE] to [HIGH ALTITUDE] when using the projector at altitudes approximately 5500 feet/1600 meters or higher. Using the projector at altitudes approximately 5500 feet/1600 meters or higher without setting to [HIGH ALTITUDE] can cause the projector to overheat and the projector could shut down. If this happens, wait a couple minutes and turn on the projector. (→ page 108)  
  - If you turn on the projector immediately after the lamp is turned off, the fans run without displaying an image for some time and then the projector will display the image. Wait for a moment. |
| Will turn off | • Ensure that the [OFF TIMER], [AUTO POWER OFF] or [PROGRAM TIMER] is off. (→ page 101, 111) |
| No picture | • Check if the appropriate input is selected. (→ page 16) If there is still no picture, press the SOURCE button or one of the input buttons again.  
  • Ensure your cables are connected properly.  
  • Use menus to adjust the brightness and contrast. (→ page 93)  
  • Ensure that the lens cover is open. (→ page 14)  
  • Reset the settings or adjustments to factory preset levels using the [RESET] in the Menu. (→ page 116)  
  • Enter your registered keyword if the Security function is enabled. (→ page 37)  
  • If the HDMI input or the DisplayPort signal cannot be displayed, try the following.  
    - Reinstall your driver for the graphics card built in your computer, or use the updated driver.  
    - For reinstalling or updating your driver, refer to the user guide accompanied with your computer or graphics card, or contact the support center for your computer manufacturer.  
    - Install the updated driver or OS on your own responsibility.  
    - We are not liable for any trouble and failure caused by this installation.  
  • Be sure to connect the projector and notebook PC while the projector is in standby mode and before turning on the power to the notebook PC.  
  - In most cases the output signal from the notebook PC is not turned on unless connected to the projector before being powered up.  
    - If the screen goes blank while using your remote control, it may be the result of the computer’s screen-saver or power management software.  
  • See also the page 218. |
| Picture suddenly becomes dark | • Check if the projector is in the Forced ECO mode because of too high ambient temperature. If this is the case, lower the internal temperature of the projector by selecting [HIGH] for [FAN MODE]. (→ page 108) |
| Color tone or hue is unusual | • Check if an appropriate color is selected in [WALL COLOR]. If so, select an appropriate option. (→ page 101)  
  • Adjust [HUE] in [PICTURE]. (→ page 93) |
| Image isn’t square to the screen | • Reposition the projector to improve its angle to the screen. (→ page 17)  
  • Use the Keystone correction function to correct the trapezoid distortion. (→ page 22) |
| Picture is blurred | • Adjust the focus. (→ page 19)  
  • Reposition the projector to improve its angle to the screen. (→ page 17)  
  • Ensure that the distance between the projector and screen is within the adjustment range of the lens. (→ page 201)  
  • Has the lens been shifted by an amount exceeding the guaranteed range? (→ page 205)  
  • Condensation may form on the lens if the projector is cold, brought into a warm place and is then turned on. Should this happen, let the projector stand until there is no condensation on the lens. |
### 9. Appendix

<table>
<thead>
<tr>
<th>Issue</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flicker appears on screen</td>
<td>- Set [FAN MODE] to other than [HIGH ALTITUDE] mode when using the projector at altitudes approximately 5500 feet/1600 meters or lower. Using the projector at altitudes less than approximately 5500 feet/1600 meters and setting to [HIGH ALTITUDE] can cause the lamp to overcool, causing the image to flicker. Switch [FAN MODE] to [AUTO]. ([→ page 108])</td>
</tr>
</tbody>
</table>
| Image is scrolling vertically, horizontally or both | - Check the computer’s resolution and frequency. Make sure that the resolution you are trying to display is supported by the projector. ([→ page 207])  
- Adjust the computer image manually with the Horizontal/Vertical in the [IMAGE OPTIONS]. ([→ page 95]) |
| Remote control does not work               | - Install new batteries. ([→ page 9])  
- Make sure there are no obstacles between you and the projector.  
- Stand within 22 feet (7 m) of the projector. ([→ page 9])  
- To perform computer mouse operations using the projector’s remote control, connect the optional mouse receiver to the computer. ([→ page 30]) |
| Indicator is lit or blinking               | - See the POWER/STATUS/LAMP Indicator. ([→ page 214]) |
| Cross color in RGB mode                    | - Press the AUTO ADJ. button on the projector cabinet or the remote control. ([→ page 24])  
- Adjust the computer image manually with [CLOCK]/[PHASE] in [IMAGE OPTIONS] in the menu. ([→ page 94]) |

For more information contact your dealer.
If there is no picture, or the picture is not displayed correctly.

- Power on process for the projector and the PC.
  Be sure to connect the projector and notebook PC while the projector is in standby mode and before turning on the power to the notebook PC.
  In most cases the output signal from the notebook PC is not turned on unless connected to the projector before being powered up.

**NOTE:** You can check the horizontal frequency of the current signal in the projector's menu under Information. If it reads “0kHz”, this means there is no signal being output from the computer. (→ page 113 or go to next step)

- Enabling the computer’s external display.
  Displaying an image on the notebook PC’s screen does not necessarily mean it outputs a signal to the projector. When using a PC compatible laptop, a combination of function keys will enable/disable the external display. Usually, the combination of the “Fn” key along with one of the 12 function keys gets the external display to come on or off. For example, NEC laptops use Fn + F3, while Dell laptops use Fn + F8 key combinations to toggle through external display selections.

- Non-standard signal output from the computer
  If the output signal from a notebook PC is not an industry standard, the projected image may not be displayed correctly. Should this happen, deactivate the notebook PC’s LCD screen when the projector display is in use. Each notebook PC has a different way of deactivate/reactivate the local LCD screens as described in the previous step. Refer to your computer’s documentation for detailed information.

- Image displayed is incorrect when using a Macintosh
  When using a Macintosh with the projector, set the DIP switch of the Mac adapter (not supplied with the projector) according to your resolution. After setting, restart your Macintosh for the changes to take affect.
  For setting display modes other than those supported by your Macintosh and the projector, changing the DIP switch on a Mac adapter may bounce an image slightly or may display nothing. Should this happen, set the DIP switch to the 13” fixed mode and then restart your Macintosh. After that, restore the DIP switches to a displayable mode and then restart the Macintosh again.

**NOTE:** A Video Adapter cable manufactured by Apple Computer is needed for a PowerBook which does not have a mini D-Sub 15-pin connector.

- Mirroring on a PowerBook
  * When using the projector with a Macintosh PowerBook, output may not be set to 1024 × 768 unless “mirroring” is off on your PowerBook. Refer to owner’s manual supplied with your Macintosh computer for mirroring.

- Folders or icons are hidden on the Macintosh screen
  Folders or icons may not be seen on the screen. Should this happen, select [View] → [Arrange] from the Apple menu and arrange icons.
PC Control Codes and Cable Connection

PC Control Codes

<table>
<thead>
<tr>
<th>Function</th>
<th>Code Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>POWER ON</td>
<td>02H 00H 00H 00H 00H 02H</td>
</tr>
<tr>
<td>POWER OFF</td>
<td>02H 01H 00H 00H 00H 03H</td>
</tr>
<tr>
<td>INPUT SELECT COMPUTER 1</td>
<td>02H 03H 00H 00H 02H 01H 01H 09H</td>
</tr>
<tr>
<td>INPUT SELECT COMPUTER 2</td>
<td>02H 03H 00H 00H 02H 01H 02H 0AH</td>
</tr>
<tr>
<td>INPUT SELECT COMPUTER 3</td>
<td>02H 03H 00H 00H 02H 01H 03H 0BH</td>
</tr>
<tr>
<td>INPUT SELECT HDMI</td>
<td>02H 03H 00H 00H 02H 01H 01H 0AH</td>
</tr>
<tr>
<td>INPUT SELECT DisplayPort</td>
<td>02H 03H 00H 00H 02H 01H 01H 01H 1AH 22H</td>
</tr>
<tr>
<td>INPUT SELECT VIDEO</td>
<td>02H 03H 00H 00H 02H 01H 01H 06H 0EH</td>
</tr>
<tr>
<td>INPUT SELECT S-VIDEO</td>
<td>02H 03H 00H 00H 02H 01H 01H 06H 0EH</td>
</tr>
<tr>
<td>INPUT SELECT VIEWER</td>
<td>02H 03H 00H 00H 02H 01H 01H 01H 01H 01H 01H 01H 1FH 27H</td>
</tr>
<tr>
<td>INPUT SELECT NETWORK</td>
<td>02H 03H 00H 00H 02H 01H 01H 01H 01H 01H 01H 01H 01H 01H 01H 20H 28H</td>
</tr>
<tr>
<td>PICTURE MUTE ON</td>
<td>02H 10H 00H 00H 00H 12H</td>
</tr>
<tr>
<td>PICTURE MUTE OFF</td>
<td>02H 11H 00H 00H 00H 13H</td>
</tr>
<tr>
<td>SOUND MUTE ON</td>
<td>02H 12H 00H 00H 00H 14H</td>
</tr>
<tr>
<td>SOUND MUTE OFF</td>
<td>02H 13H 00H 00H 00H 15H</td>
</tr>
</tbody>
</table>

NOTE: Contact your local dealer for a full list of the PC Control Codes if needed.

Cable Connection

Communication Protocol

Baud rate .................. 38400 bps
Data length ................. 8 bits
Parity ........................ No parity
Stop bit ........................ One bit
X on/off ........................ None
Communications procedure .......... Full duplex

NOTE: Depending on the equipment, a lower baud rate may be recommended for long cable runs.

PC Control Connector (D-SUB 9P)

<table>
<thead>
<tr>
<th>Pin</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>To TxD of PC</td>
</tr>
<tr>
<td>2</td>
<td>To RxD of PC</td>
</tr>
<tr>
<td>3</td>
<td>To GND of PC</td>
</tr>
<tr>
<td>4</td>
<td>To RTS of PC</td>
</tr>
<tr>
<td>5</td>
<td>To CTS of PC</td>
</tr>
<tr>
<td>6</td>
<td>To GND of PC</td>
</tr>
<tr>
<td>7</td>
<td>To RTS of PC</td>
</tr>
<tr>
<td>8</td>
<td>To CTS of PC</td>
</tr>
<tr>
<td>9</td>
<td>To GND of PC</td>
</tr>
</tbody>
</table>

NOTE 1: Pins 1, 4, 6 and 9 are not used.

NOTE 2: Jumper “Request to Send” and “Clear to Send” together on both ends of the cable to simplify cable connection.

NOTE 3: For long cable runs it is recommended to set communication speed within projector menus to 9600 bps.
9. Appendix

Troubleshooting Check List

Before contacting your dealer or service personnel, check the following list to be sure repairs are needed also by referring to the “Troubleshooting” section in your user's manual. This checklist below will help us solve your problem more efficiently.

* Print this page and the next page for your check.

**Frequency of occurrence**
- □ always
- □ sometimes (How often? _____________________)
- □ other (__________________)

**Power**
- □ No power (POWER indicator does not light blue) See also “Status indicator (STATUS)”.
- □ Power cord’s plug is fully inserted into the wall outlet.
- □ Lamp cover is installed correctly.
- □ Lamp Hours Used (lamp operation hours) was cleared after lamp replacement.
- □ No power even though you press and hold the POWER button for 1 second.
- □ Shut down during operation.
- □ Power cord’s plug is fully inserted into the wall outlet.
- □ Lamp cover is installed correctly.
- □ [AUTO POWER OFF] is turned off (only models with the [AUTO POWER OFF] function).
- □ [OFF TIMER] is turned off (only models with the [OFF TIMER] function).

**Video and Audio**
- □ No image is displayed from your PC or video equipment to the projector.
- □ Still no image even though you connect the projector to the PC first, then start the PC.
- □ Enabling your notebook PC’s signal output to the projector.
  - A combination of function keys will enable/disable the external display. Usually, the combination of the “Fn” key along with one of the 12 function keys turns the external display on or off.
- □ No image (blue or black background, no display).
- □ Still no image even though you press the AUTO ADJUST button.
- □ Still no image even though you carry out [RESET] in the projector’s menu.
- □ Signal cable’s plug is fully inserted into the input connector
  - (__________________________________________)
- □ A message appears on the screen.
  - The source connected to the projector is active and available.
- □ Still no image even though you adjust the brightness and/or the contrast.
- □ Input source’s resolution and frequency are supported by the projector.
- □ Image is too dark.
- □ Remains unchanged even though you adjust the brightness and/or the contrast.
- □ Image is distorted.
- □ Image appears to be trapezoidal (unchanged even though you carry out the [KEYSTONE] adjustment).
- □ Parts of the image are lost.
- □ Still unchanged even though you press the AUTO ADJUST button.
- □ Still unchanged even though you carry out [RESET] in the projector’s menu.
- □ Image is shifted in the vertical or horizontal direction.
- □ Horizontal and vertical positions are correctly adjusted on a computer signal.
- □ Input source’s resolution and frequency are supported by the projector.
- □ Some pixels are lost.
- □ Image is flickering.
- □ Still unchanged even though you press the AUTO ADJUST button.
- □ Still unchanged even though you carry out [RESET] in the projector’s menu.
- □ Image shows flickering or color drift on a computer signal.
- □ Still unchanged even though you change [FAN MODE] from [HIGH ALTITUDE] to [AUTO].
- □ Image appears blurry or out of focus.
- □ Still unchanged even though you checked the signal’s resolution on PC and changed it to projector’s native resolution.
- □ Still unchanged even though you adjusted the focus.
- □ No sound.
- □ Audio cable is correctly connected to the audio input of the projector.
- □ Still unchanged even though you adjusted the volume level.
- □ AUDIO OUT is connected to your audio equipment (only models with the AUDIO OUT connector).

**Other**
- □ Remote control does not work.
- □ No obstacles between the sensor of the projector and the remote control.
- □ Projector is placed near a fluorescent light that can disturb the infrared remote controls.
- □ Batteries are new and are not reversed in installation.
- □ Buttons on the projector cabinet do not work (only models with the [CONTROL PANEL LOCK] function)
  - [CONTROL PANEL LOCK] is not turned on or is disabled in the menu.
- □ Still unchanged even though you press and hold the EXIT button for a minimum of 10 seconds.
In the space below please describe your problem in detail.

### Information on application and environment where your projector is used

**Projector**
- Model number: 
- Serial No.: 
- Date of purchase: 
- Lamp operating time (hours): 
- Eco Mode:  
  - OFF
  - ON
- Information on input signal:
  - Horizontal synch frequency: [ ] kHz
  - Vertical synch frequency: [ ] Hz
  - Synch polarity: 
    - H (+) (-)
    - V (+) (-)
- Synch type:  
  - Separate
  - Composite
  - Sync on Green
- STATUS Indicator: 
  - Steady light:  
    - Orange
    - Green
  - Flashing light: [ ] cycles
- Remote control model number: 

**Installation environment**
- Screen size: [ ] inch
- Screen type: 
  - White matte
  - Beads
  - Polarization
  - Wide angle
  - High contrast
- Throw distance: [ ] feet/inch/m
- Orientation:  
  - Ceiling mount
  - Desktop
- Power outlet connection: 
  - Connected directly to wall outlet
  - Connected to power cord extender or other (the number of connected equipment: [ ])
  - Connected to a power cord reel or other (the number of connected equipment: [ ])

**Computer**
- Manufacturer: 
- Model number: 
- Notebook PC [ ] / Desktop [ ]
- Native resolution: 
- Refresh rate: 
- Video adapter: 
- Other: 

**Video equipment**
- VCR, DVD player, Video camera, Video game or other
- Manufacturer: 
- Model number: 

**Signal cable**
- NEC standard or other manufacturer's cable?
  - Model number: 
  - Length: [ ] inch/m
- Distribution amplifier
  - Model number: 
- Switcher
  - Model number: 
- Adapter
  - Model number: 

**Diagram:**
- Projector
- PC
- DVD player
**8 TravelCare Guide**

*TravelCare - a service for international travelers*

This product is eligible for “TravelCare”, NEC’s unique international warranty and repair service. For more information on TravelCare service, visit our website (in English only).
